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Preface

How to Use This Guide

Purpose of This
Guide

The 4800 MALDI TOF/TOF™ Analyzer Hardware Guide provides 
reference information related to the 4800 MALDI TOF/TOF™ 
Analyzer. It describes the system, theory of operation, and how to 
prepare, maintain, and troubleshoot the system.

Audience This guide is intended for novice and experienced 4800 MALDI 
TOF/TOF™ Analyzer users who are using the system for high-
throughput proteomics and other research.

Assumptions This guide assumes that your 4800 MALDI TOF/TOF™ Analyzer has 
been installed by an Applied Biosystems/MDS SCIEX technical 
representative and that the vacuum pressures are adequate (that is, 
below the maximum threshold set in the hardware configuration). 

This guide uses conventions and terminology that assume a working 
knowledge of the Windows® operating system, the Internet, and 
Internet-based browsers.

Text Conventions This guide uses the following conventions: 

• Bold indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

• Italic text indicates new or important words and is also used for 
emphasis. For example:
Before analyzing, always prepare fresh matrix.

• A right arrow bracket (>) separates successive commands you 
select from a drop-down or shortcut menu. For example:
Select File > Open > Spot Set.
Right-click the sample row, then select View Filter > View All 
Runs.
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User Attention
Words

Two user attention words appear in Applied Biosystems/MDS SCIEX 
user documentation. Each word implies a particular level of 
observation or action as described below:

Note: Provides information that may be of interest or help but is not 
critical to the use of the product.

IMPORTANT! Provides information that is necessary for proper 
instrument operation, accurate chemistry kit use, or safe use of a 
chemical.

Examples of the user attention words appear below:

Note: The size of the column affects the run time.

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection to the database, you 
need a valid Oracle® Database user ID and password.

IMPORTANT! You must create a separate Sample Entry Spreadsheet 
for each 96-well plate.

Safety Alert
Words

Safety alert words also appear in user documentation. For more 
information, see “Safety Alert Words” on page xii. 

How to Obtain More Information

Related
Documentation

The following related documents are shipped with the system:

• 4800 MALDI TOF/TOF™ Analyzer Getting Started Guide – 
Provides brief, step-by-step procedures for preparing and 
analyzing a sample. It is designed to help you quickly learn to 
use the 4800 MALDI TOF/TOF™ Analyzer.

• 4800 MALDI TOF/TOF™ Analyzer Quick Reference Cards – 
Provide abbreviated but key task-related information. 

• 4000 Series Explorer™ Software Online Help – Provides 
in-depth information on the software and provides detailed 
procedures and supporting information for 4800 instrument 
common tasks. Help is available from the Help menu or by 
pressing F1.
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• 4000 Series Explorer™ Database Tools Online Help – Provides 
procedures for performing database archiving, restoring, 
backing up, and recovering. Help is available from the Help 
menu or by pressing F1 in the 4000 Series Database Tools.

• Data Explorer® Software Online Help – Describes Data 
Explorer® software, and provides procedures for command 
tasks. Help is available from the Data Explorer software Help 
menu or by pressing F1.

• DeNovo Explorer™ Software Online Help – Describes the 
denovo sequencing and database search software included with 
the 4800 instrument, and provides procedures for common tasks. 
Help is available from the Help menu or by pressing F1.

• Peak Explorer™ Software Online Help – Describes the 
LC/MALDI visualization and analysis software included with 
the 4800 instrument, and provides procedures for common tasks. 
Help is available from the Help menu or by pressing F1.

Portable document format (PDF) versions of this guide and the 
4800 MALDI TOF/TOF™ Analyzer Getting Started Guide are also 
available on the 4000 Series Explorer™ software installation CD.

Note: For additional documentation, see “How to Obtain Support” 
on page x.

Database Access
and Instrument

Control API

For software developers or system administrators who need 
programmatic database access and instrument control, API 
(application programming interface) and SDK (software 
development kits) are available on the instrument software CD that is 
shipped with your instrument. 

The following data access and instrument control tools are available:

• 4000 Series Database Access API – A set of stored functions, 
stored procedures, and views that provide a method for locally 
or remotely retrieving 4000 Series data easily and quickly using 
SQL queries. Installed on the Instrument.

• 4000 Series Database Access API SDK – A set of sample 
programs and utilities (such as DumpT2D) that demonstrate the 
use of the Data Access API to facilitate customer development 
of similar custom programs for their needs. The following data 
transfer tools are available.
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• 4000 Series Instrument Control API – A socket-based 
interface to the 4000 Series Instruments that provides a 
programmatic means of remotely controlling and retrieving data 
from the 4000 Series Instrument. Installed on the instrument. 

• 4000 Series Instrument Control API SDK – A set of libraries 
for generating the XML fed to the server API and for parsing the 
XML output from the server API. In addition, sample clients for 
the Server API and the SDKs are provided. There are SDKs for 
Java and for C++ and examples for using the Server API in VB, 
VC++, and Java. 

Send Us Your
Comments

Applied Biosystems/MDS SCIEX welcomes your comments and suggestions 
for improving its user documents. You can e-mail your comments to:

techpubs@sciex.com

How to Obtain Support
To contact Applied Biosystems/MDS SCIEX Technical Support from 
North America by telephone, call 1.800.899.5858.

For the latest services and support information for all locations, go to 
http://www.appliedbiosystems.com, then click the link for 
Support.

At the Support page, you can:

• Search through frequently asked questions (FAQs)
• Submit a question directly to Technical Support
• Order Applied Biosystems/MDS SCIEX user documents, MSDSs, 

certificates of analysis, and other related documents
• Download PDF documents
• Obtain information about customer training
• Download software updates and patches

In addition, the Support page provides access to worldwide telephone 
and fax numbers to contact Applied Biosystems/MDS SCIEX Technical 
Support and Sales facilities.

mailto:techpubs@appliedbiosystems.com
http://www.appliedbiosystems.com
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Safety and EMC Compliance 
Information

This section includes the following topics: 

Safety Conventions Used in This Document . . . . . . . . . . . . . . . . . .xii
Symbols on Instruments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xiv
Safety Labels on Instruments   .. . . . . . . . . . . . . . . . . . . . . . . . . . . .xvi
General Instrument Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xvii
Chemical Safety  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xix
Chemical Waste Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xxi
Electrical Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xxii
Physical Hazard Safety. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxiii
Biological Hazard Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxiii
Laser Safety. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xxiv
Bar Code Scanner Laser Safety. . . . . . . . . . . . . . . . . . . . . . . . . . . xxv
Workstation Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xxvi
Safety and Electromagnetic Compatibility (EMC) Standards. . .xxvii
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Safety Conventions Used in This Document

Safety Alert
Words

Four safety alert words appear in Applied Biosystems/MDS SCIEX 
user documentation at points in the document where a user needs to 
be aware of relevant hazards. Each alert word–IMPORTANT, 
CAUTION, WARNING, DANGER–implies a particular level of 
observation or action, as defined below:

Definitions

IMPORTANT! – Provides information that is necessary for proper 
instrument operation, accurate chemistry kit use, or safe use of a 
chemical.

 – Indicates a potentially hazardous situation that, 
if not avoided, may result in minor or moderate injury. It may also be 
used to alert against unsafe practices.

 – Indicates a potentially hazardous situation that, 
if not avoided, could result in death or serious injury.

 – Indicates an imminently hazardous situation 
that, if not avoided, will result in death or serious injury. This signal 
word is to be limited to the most extreme situations.

Except for IMPORTANTs, each safety alert word in an Applied
Biosystems/MDS SCIEX document appears with an open triangle 
figure that contains a hazard symbol. These hazard symbols are
identical to the hazard icons that are affixed to Applied Biosystems/
MDS SCIEX instruments (see “Safety Symbols” on page xv).
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Examples

The following are some specific examples of the use of safety alert 
words:

IMPORTANT! You must create a separate a Sample Entry 
Spreadsheet for each 96-well plate.

The lamp is extremely hot. Do not touch the lamp 
until it has cooled to room temperature.

CHEMICAL HAZARD. Formamide. Exposure 
causes eye, skin, and respiratory tract irritation. It is a possible 
developmental and birth defect hazard. Read the MSDS, and follow 
the handling instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

ELECTRICAL HAZARD. Failure to ground the 
instrument properly can lead to an electrical shock. Ground the 
instrument according to the provided instructions.
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Symbols on Instruments

Electrical
Symbols

The following table describes the electrical symbols that may be 
displayed on Applied Biosystems/MDS SCIEX instruments.

Symbol Description

Indicates the On position of the main power switch.

Indicates the Off position of the main power switch.

Indicates the On/Off position of a push-push main power switch.

Indicates a standby switch.

Indicates a terminal that may be connected to the signal ground reference 
of another instrument. This is not a protected ground terminal.

Indicates a protective grounding terminal that must be connected to earth 
ground before any other electrical connections are made to the 
instrument.

Indicates a terminal that can receive or supply alternating current or 
voltage.

Indicates a terminal that can receive or supply alternating or direct current 
or voltage.
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Safety Symbols The following table describes the safety symbols that may be 
displayed on Applied Biosystems/MDS SCIEX instruments. Each
symbol may appear by itself or in combination with text that explains 
the relevant hazard (see “Safety Labels on Instruments” on page xvi). 
These safety symbols may also appear next to DANGERS,  
WARNINGS, and CAUTIONS that occur in the text of this and 
other product-support documents.

Symbol Description

Indicates that you should consult the manual for further information and to 
proceed with appropriate caution.

Indicates the presence of an electrical shock hazard and to proceed with 
appropriate caution.

Indicates the presence of a hot surface or other high-temperature hazard 
and to proceed with appropriate caution. 

Indicates the presence of a laser inside the instrument and to proceed with 
appropriate caution.

Indicates the presence of moving parts and to proceed with appropriate 
caution.
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Safety Labels on Instruments
The following CAUTION, WARNING, and DANGER statements 
may be displayed on Applied Biosystems?MDS SCIEX instruments in 
combination with the safety symbols described in the preceding section. 

English Francais

CAUTION Hazardous chemicals. Read the 
Material Safety Data Sheets (MSDSs) 
before handling.

ATTENTION Produits chimiques 
dangeureux. Lire les fiches techniques de 
sûreté de matériels avant la manipulation 
des produits.

CAUTION Hazardous waste. Read the 
waste profile (if any) in the site preparation 
guide for this instrument before handling or 
disposal.

ATTENTION Déchets dangereux. Lire les 
renseignements sur les déchets avant de 
les manipuler ou de les éliminer.

CAUTION Hazardous waste. Refer to 
MSDS(s) and local regulations for handling 
and disposal.

ATTENTION Déchets dangereux. Lire les 
fiches techniques de sûreté de matériels et 
la régulation locale associées à la 
manipulation et l'élimination des déchets.

WARNING Hot lamp. AVERTISSEMENT Lampe brûlante.

WARNING Hot. Replace lamp with an 
Applied Biosystems/MDS SCIEX lamp.

AVERTISSEMENT Composants brûlants. 
Remplacer la lampe par une lampe Applied 
Biosystems/MDS SCIEX.

CAUTION Hot surface. ATTENTION Surface brûlante.

DANGER High voltage. DANGER Haute tension.

WARNING To reduce the chance of 
electrical shock, do not remove covers that 
require tool access. No user-serviceable parts 
are inside. Refer servicing to Applied Biosystems
/MDS SCIEX qualified service personnel.

AVERTISSEMENT Pour éviter les risques 
d'électrocution, ne pas retirer les capots 
dont l'ouverture nécessite l'utilisation 
d'outils. L’instrument ne contient aucune 
pièce réparable par l ’utilisateur. Toute 
intervention doit être effectuée par le 
personnel de service qualifié de Applied 
Biosystems/MDS SCIEX.

DANGER Class 3B visible and/or invisible 
laser radiation present when open and 
interlock defeated. Avoid direct exposure to 
laser beam.

DANGER de rayonnement laser de Classe 
3B présent évident et/ou invisible en cas 
d’ouverture et d’une neutralisation des 
dispositifs de sécurité. Eviter toute 
exposition directe avec le faisceau.
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General Instrument Safety

PHYSICAL INJURY HAZARD. Use this 
product only as specified in this document. Using this instrument in a 
manner not specified by Applied Biosystems/MDS SCIEX may result 
in personal injury or damage to the instrument.

Moving and
Lifting the

Instrument

PHYSICAL INJURY HAZARD. The 
instrument is to be moved and positioned only by the personnel or 
vendor specified in the applicable site preparation guide. If you 
decide to lift or move the instrument after it has been installed, do not 
attempt to lift or move the instrument without the assistance of 
others, the use of appropriate moving equipment, and proper lifting 
techniques. Improper lifting can cause painful and permanent back 
injury. Depending on the weight, moving or lifting an instrument may 
require two or more persons.

Moving and
Lifting Stand-

Alone Computers
and Monitors

Do not attempt to lift or move the computer or the 
monitor without the assistance of others. Depending on the weight of 
the computer and/or the monitor, moving them may require two or 
more people.

DANGER Class 3B visible and/or invisible 
laser radiation when open. Avoid direct 
exposure to laser beam.

DANGER de rayonnement laser de Classe 
3B présent évident et/ou invisible en cas 
d’ouverture. Eviter toute exposition directe 
avec le faisceau.

DANGER Class 2 (II) lasers can cause 
damage to eyes. Avoid looking into a Class 
II laser beam or pointing a Class II laser 
beam into another person’s eyes.

DANGER Les lasers de Classe 2 (II) 
peuvent provoquer de graves dommages 
aux yeux. Eviter de regarder directement le 
rayon du laser ou de pointer ce rayon sur 
l’oeil d'une autre personne.

CAUTION Moving parts. ATTENTION Parties mobiles.

English Francais
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Things to consider before lifting the computer and/or the 
monitor:

• Make sure that you have a secure, comfortable grip on the 
computer or the monitor when lifting.

• Make sure that the path from where the object is to where it is 
being moved is clear of obstructions.

• Do not lift an object and twist your torso at the same time.
• Keep your spine in a good neutral position while lifting with 

your legs.
• Participants should coordinate lift and move intentions with 

each other before actually lifting and carrying.
• Instead of lifting the object from the packing box, carefully tilt 

the box on its side and hold it stationary while someone slides 
the contents out of the box.

Operating the
Instrument

Ensure that anyone who operates the instrument has:

• Received instructions in both general safety practices for 
laboratories and specific safety practices for the instrument.

• Read and understood all applicable Material Safety Data Sheets 
(MSDSs).

PHYSICAL INJURY HAZARD. Use this 
instrument as specified by Applied Biosystems/MDS SCIEX. Using 
this instrument in a manner not specified by Applied Biosystems/MDS 
SCIEX may result in personal injury or damage to the instrument.
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Chemical Safety

Chemical Hazard
Warning

CHEMICAL HAZARD. Before handling any 
chemicals, refer to the Material Safety Data Sheet (MSDS) provided 
by the manufacturer, and observe all relevant precautions.

CHEMICAL HAZARD. All chemicals in the 
instrument, including liquid in the lines, are potentially hazardous. 
Always determine what chemicals have been used in the instrument 
before changing reagents or instrument components. Wear 
appropriate eyewear, protective clothing, and gloves when working 
on the instrument.

CHEMICAL HAZARD. Four-liter reagent and 
waste bottles can crack and leak. Each 4-liter bottle should be 
secured in a low-density polyethylene safety container with the cover 
fastened and the handles locked in the upright position. Wear 
appropriate eyewear, clothing, and gloves when handling reagent and 
waste bottles.

CHEMICAL STORAGE HAZARD. Never 
collect or store waste in a glass container because of the risk of 
breaking or shattering. Reagent and waste bottles can crack and leak. 
Each waste bottle should be secured in a low-density polyethylene 
safety container with the cover fastened and the handles locked in the 
upright position. Wear appropriate eyewear, clothing, and gloves 
when handling reagent and waste bottles.

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets 
(MSDSs) with shipments of hazardous chemicals to new customers. 
They also provide MSDSs with the first shipment of a hazardous 
chemical to a customer after an MSDS has been updated. MSDSs 
provide the safety information you need to store, handle, transport, 
and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous 
chemical, be sure to replace the appropriate MSDS in your files.
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Obtaining
MSDSs

You can obtain from Applied Biosystems/MDS SCIEX the MSDS for 
any chemical supplied by Applied Biosystems/MDS SCIEX. This 
service is free and available 24 hours a day. 
To obtain MSDSs:

1. Go to https://docs.appliedbiosystems.com/msdssearch.html

2. In the Search field, type in the chemical name, part number, or 
other information that appears in the MSDS of interest. Select 
the language of your choice, then click Search.

3. Find the document of interest, right-click the document title, 
then select any of the following:

• Open – To view the document
• Print Target – To print the document
• Save Target As – To download a PDF version of the 

document to a destination that you choose

4. To have a copy of a document sent by fax or e-mail, select Fax 
or Email to the left of the document title in the Search Results 
page, then click RETRIEVE DOCUMENTS at the end of the 
document list.

5. After you enter the required information, click View/Deliver 
Selected Documents Now.

Chemical Safety
Guidelines

To minimize the hazards of chemicals:
• Read and understand the MSDSs provided by the chemical 

manufacturer before you store, handle, or work with any 
chemicals or hazardous materials. See “About MSDSs” on 
page xix.

• Minimize contact with chemicals. When handling chemicals, 
wear appropriate personal protective equipment such as safety 
glasses, gloves, and protective clothing. For additional safety 
guidelines, consult the MSDS.

• Minimize the inhalation of chemicals. Do not leave chemical 
containers open. Use only with adequate ventilation (for 
example, a fume hood). For additional safety guidelines, consult 
the MSDS. 

• Check regularly for chemical leaks or spills. If a leak or spill 
occurs, follow the cleanup procedures recommended in the 
MSDS.

• Comply with all local, state/provincial, and/or national laws and 
regulations related to chemical storage, handling, and disposal.
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Chemical Waste Safety

Chemical Waste
Hazard

HAZARDOUS WASTE. Refer to Material 
Safety Data Sheets and local regulations for handling and 
disposal.

CHEMICAL WASTE HAZARD. Wastes 
produced by Applied Biosystems/MDS SCIEX instruments are 
potentially hazardous and can cause injury, illness, or death.

CHEMICAL STORAGE HAZARD. Never 
collect or store waste in a glass container because of the risk of 
breaking or shattering. Reagent and waste bottles can crack and leak. 
Each waste bottle should be secured in a low-density polyethylene 
safety container with the cover fastened and the handles locked in the 
upright position. Wear appropriate eyewear, clothing, and gloves 
when handling reagent and waste bottles.

Chemical Waste
Safety Guidelines

To minimize the hazards of chemical waste:

• Read and understand the Material Safety Data Sheets (MSDSs) 
provided by the manufacturers of the chemicals in the waste 
container before you store, handle, or dispose of chemical waste.

• Provide primary and secondary waste containers. (A primary 
waste container holds the immediate waste. A secondary 
container contains spills or leaks from the primary container. 
Both containers must be compatible with the waste material and 
meet federal, state, and local requirements for container 
storage.) 

• Minimize contact with chemicals. Wear appropriate personal 
protective equipment when handling chemicals (for example, 
safety glasses, gloves, or protective clothing). For additional 
safety guidelines, consult the MSDS.

• Handle chemical wastes in a fume hood.
• After you empty a chemical waste container, seal it with the cap 

provided.
• Dispose of the contents of a waste container in accordance with 

good laboratory practices and local, state/provincial, and/or 
national environmental and health regulations.
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Waste Disposal If potentially hazardous waste is generated when you operate the 
instrument, you must:

• Characterize (by analysis if necessary) the waste generated by 
the particular applications, reagents, and substrates used in your 
laboratory.

• Ensure the health and safety of all personnel in your laboratory.
• Ensure that the instrument waste is stored, transferred, 

transported, and disposed of according to all local, 
state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require 
special handling, and disposal limitations may apply.

Electrical Safety

ELECTRICAL SHOCK HAZARD. Severe 
electrical shock can result from operating the 4800 MALDI 
TOF/TOF™ Analyzer without its instrument panels in place. Do not 
remove instrument panels. High-voltage contacts are exposed when 
instrument panels are removed from the instrument.

Power ELECTRICAL HAZARD. Grounding circuit 
continuity is vital for the safe operation of equipment. Never operate 
equipment with the grounding conductor disconnected.

ELECTRICAL HAZARD. Use properly 
configured and approved line cords for the voltage supply in your 
facility.

ELECTRICAL HAZARD. Plug the system into 
a properly grounded receptacle with adequate current capacity.

Overvoltage
Rating

The 4800 MALDI TOF/TOF™ Analyzer has an installation 
(overvoltage) category of II, and is classified as portable equipment.
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Physical Hazard Safety

Compressed
Gases

PHYSICAL HAZARD. Nonflammable 
compressed gas (such as nitrogen and other gases used as 
collision gas). Contents are under pressure. Receive proper training 
on the handling of compressed gases before use. Exposure to rapidly 
expanding gas may cause frostbite. High concentrations of vapors in 
the immediate area can displace oxygen and cause asphyxiation. Use 
only in areas with adequate ventilation. Read the MSDS, and follow 
the handling instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

EXPLOSION HAZARD. Pressurized gas 
cylinders are potentially explosive and can cause severe injury if not 
handled properly. Attach the gas cylinder firmly to the wall or gas 
cylinder cart with approved brackets or chains. Always cap the gas 
cylinder when it is not in use.

Biological Hazard Safety

General
Biohazard

BIOHAZARD. Biological samples such as 
tissues, body fluids, and blood of humans and other animals have the 
potential to transmit infectious diseases. Follow all applicable local, 
state/provincial, and/or national regulations. Wear appropriate 
protective eyewear, clothing, and gloves. Read and follow the 
guidelines in the following publications:

• U.S. Department of Health and Human Services guidelines 
published in Biosafety in Microbiological and Biomedical 
Laboratories (stock no. 017-040-00547-4; 
http://bmbl.od.nih.gov)

• Occupational Safety and Health Standards, Toxic and Hazardous 
Substances (29 CFR §1910.1030; http://www.access.gpo.gov/ 
nara/cfr/waisidx_01/ 29cfr1910a_01.html).

Additional information about biohazard guidelines is available at: 
http://www.cdc.gov
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Laser Safety

Laser
Classification

The 4800 MALDI TOF/TOF™ Analyzer uses a diode-pumped, solid-
state laser. Under normal operating conditions, the instrument is 
categorized as a Class 1 laser. When safety interlocks are disabled 
during certain servicing procedures, the laser can cause permanent 
eye damage, and, therefore, is classified under those conditions as a 
Class 3B laser.

The 4800 MALDI TOF/TOF™ Analyzer has been tested to and 
complies with the “Radiation Control for Health and Safety Act of 
1968 Performance Standard CFR 1040.10 and 1040.11”

The 4800 MALDI TOF/TOF™ Analyzer has been tested to and 
complies with standard EN60825-1, “Radiation Safety of Laser 
Products, Equipment Classification, Requirements, and User’s 
Guide.”

Laser Safety
Requirements

To ensure safe laser operation:

• The system must be installed and maintained by an 
Applied Biosystems/MDS SCIEX Technical Representative.

• All instrument panels must be in place on the instrument while 
the instrument is operating. When all panels are installed, there 
is no detectable radiation present. If any panel is removed when 
the laser is operating (during service with safety interlocks 
disabled), you may be exposed to laser emissions in excess of 
the Class 1 rating.

• Do not remove safety labels or disable safety interlocks.
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Additional Laser
Safety

Information

Refer to the user documentation provided with the laser for additional 
information on government and industry safety regulations.

LASER HAZARD. Lasers can burn the retina 
causing permanent blind spots. Never look directly into the laser 
beam. Remove jewelry and other items that can reflect the beam into 
your eyes. Do not remove the instrument panels. Wear proper eye 
protection and post a laser warning sign at the entrance to the 
laboratory if the top or front panels are removed for service.

LASER BURN HAZARD. An overheated laser 
can cause severe burns if it comes in contact with the skin. DO NOT 
operate the laser when it cannot be cooled by its cooling fan. Always 
wear appropriate laser safety goggles.

Bar Code Scanner Laser Safety

Laser
Classification

The optional bar code scanner is categorized as a Class 2 (II) laser.

Laser Safety
Requirements

Class 2 (II) lasers are low-power, visible-light lasers that can 
damage the eyes. Never look directly into the laser beam. The 
scanner is designed to prevent human access to harmful levels of 
laser light during normal operation, user maintenance, or during 
prescribed service operations.

LASER HAZARD. Class 2 (II) lasers can cause 
damage to eyes. Avoid looking into a Class 2 (II) laser beam or 
pointing a Class 2 (II) laser beam into another person’s eyes.
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Workstation Safety
Correct ergonomic configuration of your workstation can reduce or 
prevent effects such as fatigue, pain, and strain. Minimize or 
eliminate these effects by configuring your workstation to promote 
neutral or relaxed working positions.

MUSCULOSKELETAL AND REPETITIVE 
MOTION HAZARD. These hazards are caused by potential risk 
factors that include but are not limited to repetitive motion, awkward 
posture, forceful exertion, holding static unhealthy positions, contact 
pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:

• Use equipment that comfortably supports you in neutral 
working positions and allows adequate accessibility to the 
keyboard, monitor, and mouse.

• Position the keyboard, mouse, and monitor to promote relaxed 
body and head postures.

Biohazardous Material Disposal
• BIOHAZARDOUS MATERIAL Do not dispose 

of system components or subassemblies, including computer 
parts, in municipal waste. Dispose of replaced components and 
instruments according to established waste electrical equipment 
procedures.
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Safety and Electromagnetic Compatibility (EMC) 
Standards

This section provides information on:

• U.S. and Canadian Safety Standards
• Federal Communications Commission Compliance
• European Safety and EMC Standards

U.S. and Canadian
Safety

Standards

This instrument has been tested to and complies with standard 
UL 61010A-1, “Safety Requirements for Electrical Equipment for 
Laboratory Use, Part 1: General Requirements.”

This instrument has been tested to and complies with standard 
CSA 61010.1, “Safety Requirements for Electrical Equipment for 
Measurement, Control, and Laboratory Use, Part 1: General 
Requirements.”

This instrument has been tested and complies with the FDA CDRH 
21 CFR 1040.1 and 1040.11 requirements for laser safety.

Federal
Communications

Commission
Compliance

This equipment has been tested and found to comply with the limits 
for a Class A digital device, pursuant to Part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with 
the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is 
likely to cause harmful interference in which case the user will be 
required to correct the interference at their own expense. Changes or 
modifications not expressly approved by the manufacturer could void 
your authority to operate the equipment.

European Safety
and EMC
Standards

Safety

This instrument meets European requirements for safety (Low 
Voltage Directive 73/23/EEC). This instrument has been tested to and 
complies with standards EN 61010-1, “Safety Requirements for 
Electrical Equipment for Measurement, Control and Laboratory Use, 
Part 1: General Requirements,”and EN 60825-1, “Safety of Laser 
Products.”
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EMC

This instrument meets European requirements for emission and 
immunity (EMC Directive 89/336/EEC). This instrument has been 
tested to and complies with standard EN 61326 (Group 1, Class A), 
“Electrical Equipment for Measurement, Control and Laboratory Use 
– EMC Requirements.”
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4800 MALDI TOF/TOF™ Analyzer Overview

Introduction The 4800 MALDI TOF/TOF™ Analyzer is a floor-standing mass 
spectrometer (Figure 1-1) that delivers high resolution and accurate 
mass determination for the MS analysis of biomolecules including 
protein digests, intact proteins, lipids, and carbohydrates. The system 
also enables the precise selection of individual precursor masses for 
further fragmentation enabling definitive identification and 
characterization for these biological molecules by MS/MS.

Figure 1-1 4800 MALDI TOF/TOF™ Analyzer 
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Features The 4800 MALDI TOF/TOF™ Analyzer includes the following 
features:

• Modular vertical design
• Tandem TOF analyzers
• Linear (optional), reflector, or MS/MS acquisition
• Variable ion path length to accommodate:

– MS Linear mode
– MS Reflector mode
– MS/MS mode

• Automated single-plate sample-loading system 
• Optional handheld bar code scanner for bar-coded plates
• Video camera for sample viewing within software interface
• Nd:YAG 200-Hz laser 
• Positive and negative ion detection
• Two variable two-stage ion acceleration regions
• Ion-focusing lens technology for increased sensitivity 
• Automated matrix ion deflection
• High-resolution precursor selection
• High-energy, collision-induced dissociation (CID) cell
• Metastable ion suppression
• High-performance, two-stage reflector
• High-speed 200-Hz digitizer
• Intuitive Microsoft® Windows® XP-based software

For more information, see Appendix A, “Specifications.”
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4800 MALDI TOF/TOF™ Analyzer Technology 

Overview The 4800 MALDI TOF/TOF™ Analyzer takes advantage of the 
following technologies:

• Mass spectrometry
• MALDI
• Time-of-flight ion detection
• Time-of-flight/time-of-flight ion detection
• Time-delay ion extraction

Mass
Spectrometry

Mass spectrometry measures the masses of molecules by measuring 
their mass-to-charge (m/z) ratios. Mass is a molecular attribute that 
can help identify or confirm the identity of a molecule.

Molecular weight measurements by mass spectrometry are based on 
the production, separation, and detection of molecular ions. A typical 
mass spectrometer includes:

• An ion source – Ionizes sample and generates gas phase ions.
• A mass analyzer – Separates ions according to individual 

mass-to-charge ratios.
• A detector – Detects and amplifies ion signals. 
• A data system – Converts detection of ions into a readable or 

graphic display.
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Matrix-Assisted
Laser Desorption

Ionization
(MALDI)

In matrix-assisted laser desorption ionization (MALDI), sample is 
embedded in a low-molecular-weight, UV-absorbing matrix that 
enhances intact desorption and ionization of the sample (Figure 1-2). 
The matrix is present in vast excess of sample and, therefore, isolates 
individual sample molecules.

When the laser pulses, sample molecules are ionized by gas phase 
proton transfer from the matrix. The laser pulse produces:

• Matrix neutrals (M)
• Matrix ions, (M+H)+ and (M-H)−

• Sample neutrals (A)

The matrix ions then collide with the sample neutrals, producing 
sample ions, (A+H)+ and (A-H)−.

(M+H)+ + A → M + (A+H)+ 

(M-H)− + A → (A-H)− + M 

Figure 1-2 illustrates the ionization of sample.

Figure 1-2 Matrix-assisted laser desorption ionization (MALDI)
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+ +
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Energy transfer 
from matrix to 

sample



DRAFT
October 26, 2004 4:05 pm, 4800HWGuide_Ch1_051304.fm

Chapter 1 Introducing the 4800 MALDI TOF/TOF™ Analyzer

1-6 4800 MALDI TOF/TOF™ Analyzer Hardware Guide

Time-of-Flight Time-of-flight (TOF) mass spectrometry works on the principle that 
when ions are accelerated with the same potential from a fixed point 
and at a fixed initial time and are allowed to drift, the ions separate 
according to their mass-to-charge ratios (m/z). Lighter ions drift more 
quickly to the detector. Heavier ions drift more slowly (Figure 1-3). 

Figure 1-3 Time-of-flight (TOF) analysis

The time required for ions to reach the detector at the opposite end of 
the flight tube (drift time) is measured. The number of ions reaching 
the detector at any given time is also measured, and is referred to as 
ion intensity (abundance) or signal intensity.

Drift time is proportional to the square root of the mass as defined by 
the following equation:

Approximate ion mass is determined using the previous equation. 
However, a calibration procedure using a reference standard of 
known mass can be used to establish a more accurate relationship 
between flight time and the mass-to-charge ratio of an ion.
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where:

t drift time=
s = drift distance
m = mass
KE = kinetic energy
z = number of charges on ion
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Time-of-Flight/
Time-of-Flight

Time-of-flight/time-of-flight (TOF-TOF), or tandem TOF mass 
spectrometry (MS), consists of two successive TOF accelerations. In 
tandem mass spectrometry:

• The first acceleration selects, isolates, and fragments (usually by 
collision with a neutral gas) a precursor ion of interest. 

• The second acceleration reaccelerates the precursor ion and 
fragments, then measures the masses and intensities of the 
fragment ions. 

When applied to peptides, this technique is more definitive than other 
MS methods for protein identification and a principal means of 
protein characterization.

Time-Delay
Extraction

Limitations of Continuous Extraction

In traditional MALDI (continuous extraction), ions have a broad 
kinetic energy distribution that is largely due to the initial velocities 
imparted to ions during the desorption/ionization process. These 
initial velocities of desorbed analyte ions are nearly independent of 
the mass of the analyte, but the initial kinetic energies are 
proportional to the mass. 

In addition, when desorption occurs in a strong electrical field, 
energy is lost by collisions with the neutral plume, and further mass-
dependent energy dispersion results. This leads to peak broadening 
(poor resolution).

According to the theory of “time-lag energy focusing” as originally 
developed by Wiley and McLarena, the dependence of ion flight time 
on initial velocity can be corrected, to the first order, by delaying the 
extraction of ions from the source. If higher-order terms are 
insignificant, then the mass resolution should be determined by the 
ratio of the total flight time to the uncertainty in the time 
measurement. The observed mass resolution should increase in 
proportion to the effective length of the ion flight path. 

a. W. C. Wiley and I. H. McLaren, Rev. Sci. Instrum., 1953, 26, 1150–1157, 
W. C. Wiley, U.S. Patent 2,685,035.
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Time-Delay Extraction 

Because of the time-delay technology used by the 4800 MALDI 
TOF/TOF™ Analyzer, ions form in a field-free region. The ions are 
then extracted or accelerated by applying a high-voltage pulse after a 
predetermined delay time (Figure 1-4) then a potential gradient is 
applied by a variable voltage grid. The combination of a time delay 
with a voltage gradient minimizes the effect of the kinetic energy 
spread. 

Figure 1-4 Comparison of Delayed Extraction® and continuous 
extraction systems

Velocity Focusing

When ions are released from the sample surface, their positions in the 
ion source correlate with their initial velocity. When the extraction or 
accelerating voltage pulse is applied after a delay time and a potential 
gradient is applied, initially slower ions acquire slightly higher energy 
from the accelerating field than initially faster ions. 

By careful tuning of both the delay time and the potential gradient, 
slow and fast ions of the same mass arrive at the detector at the same 
time (Figure 1-5 on page 1-9). This is referred to as velocity 
focusing.Velocity focusing enhances both resolution and mass 
accuracy.

Note: The 4000 Series Explorer™ software automatically determines 
the optimal delay time and the variable voltage based on the 
acquisition method parameters and the acquisition type (MS-Linear, 
MS-Reflector, or MS/MS).

Figure 1-5 shows how Delayed Extraction enables velocity focusing.

Accelerating
voltage

Grid
voltage

laser pulse

time

U

Continuous Extraction

Accelerating
voltage

Grid
voltage

laser pulse

time

U

time
delay

Delayed Extraction

PB100772

Delayed Extraction® System Continuous Extraction System



DRAFT
October 26, 2004 4:05 pm, 4800HWGuide_Ch1_051304.fm

4800 MALDI TOF/TOF™ Analyzer Technology

4800 MALDI TOF/TOF™ Analyzer Hardware Guide 1-9

Figure 1-5 Time-delay extraction enables velocity focusing

No applied electric field. Ions of same mass spread out based on initial velocity.

Accelerating voltage applied after delay time combined with potential gradient (variable voltage). 

+

+

DetectorSample plate

DetectorSample plate

Slow ions accelerated more than fast ions.

Slow ions catch up with fast ions at detector. 

+

+

+

DetectorSample plate

0 V

20 kV

20 kV

Initially slow ions start to catch up with initially fast ions. 

DetectorSample plate

20 kV

+

Variable 
voltage

Variable 
voltage

Variable 
voltage

Variable 
voltage

+

+

+

 

+

+
+

Ions of same mass, 
different velocities



DRAFT
October 26, 2004 4:05 pm, 4800HWGuide_Ch1_051304.fm

Chapter 1 Introducing the 4800 MALDI TOF/TOF™ Analyzer

1-10 4800 MALDI TOF/TOF™ Analyzer Hardware Guide

4800 MALDI TOF/TOF™ Analyzer Workflow
Figure 1-6 illustrates the basic steps to acquire, process, and interpret 
data using the 4800 MALDI TOF/TOF™ Analyzer.

Figure 1-6 4800 MALDI TOF/TOF™ Analyzer work flow 
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Load Sample Plate
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Submit job(s) to batch 
queue

Start batch queue

Start acquisition

View and analyze results in Spectrum viewer,
Spot Set Manager, and Output window

Create spot set job(s)

INTERACTIVE MODE BATCH MODE

Analyze results using Data Explorer® Software, 
Peak Explorer™ Software, Peaks To MASCOT® Tool, 

DeNovo Explorer™ Software, and MS BLAST searching 
(Pro BLAST software or EMBL website)

Identify proteins using GPS Explorer™ Software, 
and MASCOT® database searching

Save spectrum

Load sample plate
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4800 MALDI TOF/TOF™ Analyzer Hardware 
This section describes the following components of the 4800 MALDI 
TOF/TOF™ Analyzer:

• Mass spectrometer
• Vacuum system
• Digitizer
• Computer components
• Optional handheld bar code scanner

Mass Spectrometer

The parts of the 4800 MALDI TOF/TOF™ Analyzer are described 
below. Figure 1-8 on page 1-13 shows the relative positions of key 
parts.

Camera A camera displays, in the software interface, a real-time image of the 
region of the sample plate in the path of the laser beam, the laser 
beam position (indicated by a crosshair), and the extraction aperture.

Laser, Attenuator,
and Mirrors

An Nd:YAG laser operates at 355 nm to ionize samples. The laser 
firing rate is 200 Hz.

The laser attenuator varies the intensity of the laser beam reaching 
the sample. A system of mirrors redirects the laser beam on to the 
sample plate.

Sample Loading
Chamber

The sample loading chamber receives the sample plate from outside 
the instrument and provides a region of low vacuum before 
introducing the sample plate into the first source chamber. 

The sample loading chamber (Figure 1-7 on page 1-12), has one pad 
for loading a plate into Source 1 and another for ejecting a plate from 
Source 1. You can mount a plate on the load pad in the sample 
loading chamber and add it to the 4000 Series Explorer™ software 
while another plate is loaded in Source 1. When you finish acquiring 
from the first plate, the instrument ejects the first plate, then, if 
applicable, automatically loads the second plate from the load pad in 
the sample loading chamber.
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Figure 1-7 Sample loading chamber

Eject PadMount Pad
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Figure 1-8 4800 MALDI TOF/TOF™ Analyzer mass spectrometer
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Source 1 Region The Source 1 region is a high-voltage region that accelerates ions, 
then focuses and steers the ion beam. 

After the laser strikes the sample, the sample stage and sample plate 
are supplied with an acceleration voltage (0 to 25,000 V) at a 
predetermined delay time. This accelerates the ions. A variable 
voltage and ground are used to form a potential gradient to 
velocity-focus the ions and subsequently fine-tune the spectrum. 

The Source 1 ion optics:

• Focus the ion beam within the flight tube. 
• Steer the ion beam by correcting the x and y trajectories of the 

beam.

The Source 1 region heater maintains the region at approximately 
50 °C to reduce the matrix build-up and minimize cleanings.

Flight Tubes These are field-free regions in which ions drift at a velocity inversely 
proportional to the square root of their mass-to-charge ratio. 

Source 2 Region The Source 2 region is a high-voltage region that

• Continues to focus and steer the ion beam
• In MS/MS mode, isolates and reaccelerates a precursor ion and 

its fragments

The Source 2 ion optics:

• Focus the ion beam within the flight tube. 
• Steer the ion beam by correcting the x and y trajectories of the 

beam.
• Isolate the precursor ion of interest (MS/MS mode) through use 

of a Timed Ion Selector (TIS), which allows only ions of a 
specific mass to pass through to the detector. (In MS-Linear and 
MS-Reflector modes, the Timed Ion Selector can be used as a 
low-mass gate to eliminate saturation effects due to matrix ions.) 
To optimize the TIS performance, tune the TIS Offset Position. 
See the 4000 Series Explorer™ Software Online Help, 
Automatically Tuning the 4700 or 4800 Instrument.

Note: You specify the precursor ion of interest by specifying a 
Precursor Mass in the acquisition method.
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• Reduce the energy of the ions before they enter the collision cell 
using a deceleration stack. This controls the subsequent 
fragmentation in MS/MS mode. 

The Source 2 chamber also includes:

• Collision cell – A field-free region that provides 
collision-induced dissociation (CID) to fragment the precursor 
ions in MS/MS mode. Precursor ions collide with the gas 
(typically air) that is introduced into the cell, causing some of 
them to fragment. 

Note: You can specify the gas type and gas pressure.

• Acceleration voltage – In MS/MS mode only, reaccelerates the 
ions after leaving the collision cell. The fragment ions (formed 
in the collision cell) are accelerated to a faster velocity than the 
precursor ions. 

• Variable voltage and ground – In MS/MS mode only, forms a 
potential gradient to velocity-focus the ions, and subsequently to 
fine-tune the spectrum. 

Post Source 2
Region

The Post Source 2 region includes the X and Y Mirror deflectors and 
the metastable suppressor to suppress the precursor ions and deflect 
the metastable fragment ions formed after the second source (MS/MS 
mode only). The fragment ions formed in the collision cell and a 
fraction of the precursor ions reach the detector. (The precursor peaks 
may be used for calibration of the fragment spectra.) 

Mirror Region The Mirror region includes:

• Linear detector (optional) – A dual microchannel plate (MCP) 
detector that detects ions that travel down the flight tube. The 
linear detector measures ion abundance over time and sends a 
signal to the digitizer for conversion. It is used only in 
MS-Linear mode (not in MS-Reflector or MS/MS modes).

• Reflector mirror – Used only in MS-Reflector and MS/MS 
modes, this two-stage electrostatic mirror (Figure 1-9) consists 
of a series of plates, which reflect ions back toward the reflector 
detector. The mirror improves mass accuracy and resolution by:
– Filtering out neutral molecules
– Velocity-focusing the ions by correcting the time dispersion 

due to differences in initial kinetic energy that result in 
slightly different rates of movement (velocity)



DRAFT
October 26, 2004 4:05 pm, 4800HWGuide_Ch1_051304.fm

Chapter 1 Introducing the 4800 MALDI TOF/TOF™ Analyzer

1-16 4800 MALDI TOF/TOF™ Analyzer Hardware Guide

– Increasing separation (resolution) by providing a longer flight 
path

Ions of the same mass, but with slightly differing initial kinetic 
energy, enter the mirror at slightly different times. The faster 
moving ions penetrate deeper into the second stage of the mirror 
before being reflected back toward the reflector detector. 
Because these faster moving ions follow a longer flight path, 
they arrive at the reflector detector at the same time as ions of 
the same mass, but lower velocity.

Figure 1-9 Representation of how a two-stage mirror helps 
velocity-focus ions

• Reflector detector – A dual microchannel plate (MCP) detector 
that detects ions that are reflected by the mirror. The reflector 
detector measures ion abundance over time and sends a signal to 
the digitizer for conversion. It is used in MS-Reflector or 
MS/MS modes only. It is not used in MS-Linear mode.

Ions of same mass
but different velocities

Reflector Detector
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Vacuum System 

The 4800 MALDI TOF/TOF™ Analyzer has a pumping system and 
sealed enclosures that create and maintain a high-vacuum 
environment for time-of-flight analysis. This environment:

• Allows unobstructed ion drift
• Provides conditions needed to maintain the high potential 

differences between system components

Vacuum Regions The 4800 MALDI TOF/TOF™ Analyzer includes two regions of 
vacuum:

• Sample loading chamber
• Tower region (includes Source 1, Source 2, and Reflector areas)

Vacuum Pumps Three vacuum pumps create the vacuum environment:

• Roughing Pump – A low-vacuum pump that:
– Creates a vacuum in the sample loading chamber prior to 

sample introduction into the first source chamber.
– Creates a lower-than-atmospheric-pressure condition before 

the turbo pumps start.
– Provides backing pressure to the turbo pumps.
– Provides purging for the collision gas delivery system.

• CID Turbo Pump – Enhances a high-vacuum condition in the 
collision cell.

• System Turbo Pump – Creates a high-vacuum condition in the 
entire system.

During plate loading, vacuum is maintained in the system by the 
sample loading chamber door. After plate loading, vacuum is 
maintained in the system by a gate valve between the sample loading 
chamber and Source 1.

When a CID gas is supplied to the collision cell, a differential 
pumping baffle helps maintain vacuum in the system.
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Vacuum Gauges The 4800 MALDI TOF/TOF™ Analyzer includes four vacuum 
gauges:

• System BA (Bayard-Alpert) Vacuum Gauge – Monitors 
pressure in the entire system. 

• CID BA Vacuum Gauge – Monitors pressure in the collision 
cell region of the second source chamber.

• Load TC (Thermocouple) Vacuum Gauge – Monitors 
pressure in the sample loading chamber.

• Foreline TC Vacuum Gauge – Monitors base roughing 
pressure, backing pressure of turbo pumps, and CID expansion 
pressure.

Readings from the vacuum gauges are displayed in the 4000 Series 
Explorer™ software System Status bar (see Figure 2-1 on page 2-5).

Digitizer

An analog-to-digital converter converts the analog signal from the 
mass spectrometer to a digital signal that can be transmitted to the 
computer.

Computer Components

Do not enable screen savers on the 4800 MALDI 
TOF/TOF™ Analyzer computer. Because screen savers use computer 
memory and processor time, they can decrease system performance 
or cause other system problems. 

The computer that operates the 4000 Series software and controls the 
mass spectrometer includes the following computer hardware 
components:

• Minimum computer configuration of a dual Pentium® 4 Xeon™ 
2.4-GHz CPU, two 120-GB hard disk drives, and 1-GB RAM 
(random access memory)

• CD/DVD combination drive (rewritable)
• Integrated Ethernet card (10/100 Base - Tx)
• Additional Ethernet card
• 20-inch color flat-panel monitor
• Dell® keyboard
• Dell optical mouse
• Logitech® Control pad
• Optional computer desk
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Software Software components include: 

• Microsoft® Windows® XP
• Applied Biosystems/MDS SCIEX 4000 Series Explorer™ software 
• Data Explorer® software (Post-processing software) 
• Peak Explorer™ software (Post-processing software) 
• Peaks to MASCOT® tool (Database Filtering tool) 
• 4000 Series Database tools (Data archiving, restoring, backing 

up, and retrieving tools) 
• DeNovo Explorer™ software (Database searching tool) 
• Microsoft Office Professional Edition 2003
• Oracle® Database version 9.2 (Standard Edition)

Optional available software includes:

• 4000 Series Explorer™ Remote Access Client software – Allows 
acquisition of data by and access to data from a remote 
computer.

• GPS Explorer™ software and GPS Explorer™ Remote Access 
Client – In conjunction with 4000 Series Explorer™ software, 
automates proteomic applications.

• Pro BLAST software – Applied Biosystems/MDS SCIEX 
proprietary database searching tool.

Remote Access
Client Software

If you install the optional 4000 Series Explorer™ Remote Access 
Client software on a computer that you provide, the computer must 
meet the following minimum requirements:

• Single processor, 850 Mhz
• 256 MB RAM
• 20 GB of free disk space
• Windows XP Professional with Service Pack 1 or later, or 

Windows 2000 Professional with Service Pack 3 or later
• Regional Options set to English (United States)
• Internet Explorer 6.0 with Service Pack 1 or later
• Microsoft® Office 2000
• 100 Mb/s Ethernet interface
• LAN connection to a 4800 MALDI TOF/TOF™ Analyzer that 

has 4000 Series Explorer™ software version 3.X series installed
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• Either of the following configurations:
– Oracle® software not installed 
– Oracle® software version 9.2 (or later) installed

Note: When simultaneously connecting computers with 4000 Series 
Explorer™ Software – Remote Access Client to a 4800 MALDI 
TOF/TOF™ Analyzer, connect no more than four.

Optional Handheld Bar Code Scanner 

The optional bar code scanner allows you to scan MALDI plate bar 
codes in two ways:

• With the scanner mounted in the holder
• By hand

LASER HAZARD. Class 2 (II) lasers can cause 
damage to eyes. Avoid looking into a Class 2 (II) laser beam or 
pointing a Class 2 (II) laser beam into another person’s eyes.

Note: For optimal operation, the scanner must be approximately 
25 cm (10 in.) from the plate. The laser beam must be at a slight 
angle to and illuminate the entire length of the bar code.

For more information, see the 4800 MALDI TOF/TOF™ Analyzer 
Getting Started Guide, the Handheld Bar Code Scanner Installation 
Guide and the QuickScan® 6000/6000plus AutoSense Stand 
Instructions, and “Using the Handheld Bar Code Scanner” on 
page F-3 of this guide.
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2Preparing the 
4800 MALDI TOF/TOF™ Analyzer2
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Starting and Exiting the 4000 Series Explorer™ 
Software

Starting the
Software

To start the 4000 Series Explorer™ software:

1. Log on to the 4800 MALDI TOF/TOF™ Analyzer computer 
using your User Name and Password. (See your system 
administrator for your User Name and Password.)

2. Start the software by double-clicking  on the Microsoft® 
Windows® XP desktop. 

The 4000 Series Explorer™software opens in Interactive mode. 
You can switch between Interactive mode and Batch mode by 
clicking  on the toolbar.

Note: If the system has been shut down, the hardware 
automatically starts to initialize when you start the software. 
Initialization may take several minutes to complete. Before 
using the instrument, allow the vacuum pressures to stabilize.

Exiting the
Software

Do not exit the 4000 Series Explorer™ software or 
power off the 4800 MALDI TOF/TOF™ Analyzer unless you need to 
perform maintenance or move the system (see “Reconnecting the 
Hardware” on page 5-10). 
After you exit the software, you cannot control the analyzer. Exiting 
the software also powers off high voltages, which can require up to 
three hours of warm up when you restart the software. 
Powering off the system shuts down the vacuum pumps and causes 
the system to vent. 
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Accessing Database Software and Tools
The 4000 Series Explorer™ software includes several database 
software programs and tools. Most of the programs can be accessed 
from a menu (Table 2-1).

Table 2-1 Database software and tools

Tool Function Access

Peak Explorer™ 
Software

Post-processing of spectral data Right-click the spot set row(s) of 
interest.

Data Explorer™ 
Software

Post-processing of spectral data • In the 4000 Series Explorer™ 
software, click Tools > Launch Data 
Explorer.

• Click the icon on the 4000 Series 
Explorer™ software toolbar.

• Click the icon on desktop.
• Right-click the spot set row(s) of 

interest.

Peaks to MASCOT 
Software

Peak filtering prior to MASCOT 
database searching

• In the 4000 Series Explorer™ 
software, click Tools > Launch 
Peaks to Mascot.

• Click the icon on the 4000 Series 
Explorer™ software toolbar.

DeNovo Explorer™ 
Software

Spectral database searching • On the desktop taskbar, click Start > 
Applied Biosystems > DeNovo 
Explorer.

• Right-click the spot set row(s) of 
interest

Database Tools • Archive, purge, and restore 
spot set data

• Back up, recover, and migrate 
the database

On the desktop taskbar, click Start > 
Applied Biosystems > 4000 Series 
Database Tools.
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Checking Pressures and High Voltages

Checking
Pressures

Before using the mass spectrometer to acquire data, check the 
pressure readings on the Status bar at the bottom of the 4000 Series 
Explorer™ software (Figure 2-1 on page 2-5). Check that:

• The vacuum gauge panes (Source 1, Source 2, TCLoad, 
TCForeline) are green. Green indicates that the pressure 
readings are adequate (below the maximum set in the hardware 
configuration). 

• The actual pressure readings are adequate for optimal data 
quality (Table 2-2).

If pressures are not adequate, allow the system to reach adequate 
vacuum. Make sure the CID system is off if you are not using it.

Do not run the 4800 MALDI TOF/TOF™ 
Analyzer under inadequate vacuum conditions. Doing so results in 
inaccurate data.

Checking High
Voltages

To acquire the best data, high voltages should be powered on and 
allowed to stabilize for 30 minutes before using the instrument.

With an acquisition method open, power on high voltages by clicking 
 in the toolbar. You can verify that high voltages are on by 

checking the Status bar at the bottom of the 4000 Series Explorer™ 
software.

Note: An acquisition method must be open to power on high 
voltages.

Table 2-2 Chamber pressure for optimal data quality

Chamber Adequate Pressure (Torr)

Source 1 Less than 5 × 10−7

Source 2 Less than 5 × 10−7 (if not using CID gas)

Less than 5 × 10−6 (if using CID gas)
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Checking System Status

Overview Three locations display information about the status of the mass 
spectrometer:

• Status bar
• Hardware Monitor 
• CID System viewer

Status Bar The Status bar (Figure 2-1) is at the bottom of the 4000 Series 
Explorer™ software window.

Figure 2-1 Status bar

The status bar displays:

• Instrument status (On, Off, Starting, Busy, Initializing, 
Deinitializing, Error, or Recovering)

• High-Voltage status (Ramping, On, Off, Interlock, or Error)
• Laser status (Turning On, On, Stabilizing, Turning Off, Off)
• Acquisition status (Starting, On, Stopping, Off, or Error)
• CID System status (Turning On, On, Turning Off, Off, Purging, 

Purged, or Charging)
• Pressure readings of Source 1, Source 2, and foreline vacuum 

gauges (TCLoad, TCForeline). See “Checking Pressures” on 
page 2-4.

• Heater status (Ramping, On, Off, Error)

Note: Heater status does not affect data quality.

For more information, see 4000 Series Explorer™ Online Help, 
Status Bar Parameters.
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Each panel in the status bar is color coded (Table 2-3).

Hardware
Monitor

Applied Biosystems/MDS SCIEX Technical Support uses the Hardware 
Monitor when troubleshooting the system. Select Instrument>
Hardware Monitor to display settings and readings for many hardware 
components, including the key vacuum system components. 

CID System
Viewer

To display the CID System viewer (Figure 2-2), select View > CID 
System Viewer or click the  icon.

Figure 2-2 CID System viewer

Table 2-3 Status bar color code

Color Description

 Green Displayed during normal operation (for example, when displaying On or normal 
pressure readings).

Blue Displayed when a component is changing status (initializing, ramping, starting, 
stabilizing). 

Gray Displayed when a component is turned off.

Yellow Displayed when a fault condition occurs (for example, if a pressure reading exceeds 
the maximum pressure set in the Hardware Configuration - Vacuum Tab)

Pink Displayed if a pressure reading exceeds the maximum pressure set in the Hardware 
Configuration - Vacuum Tab for more than 30 seconds. Additionally, high voltages 
cannot be powered on. This protects the instrument from damage.
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The CID System viewer displays the following settings and statuses:
• Gas Type – The type of gas currently used in the CID system 

(Heavy Weight, Medium Weight, Light Weight, Atmosphere), as 
set in the spot set job.

• Gas Pressure – The currently selected pressure of the CID gas 
(Medium or High; no CID gas is Low), as set in the spot set job. 

• Recharge Pressure Threshold – The pressure limit at which the 
CID system is automatically refilled, as set in the Hardware 
configuration (Figure 2-6 on page 2-15).

• Source 2 Pressure – The current gas pressure in the second 
source chamber.

• CID Status – The current status of the CID System (Off, On, 
Turning On, Turning Off, Charging, or Purging). To purge or 
turn off the CID, select the appropriate option in the Instrument 
menu.

Setting Laser Intensity Adjustments
You adjust laser intensity using the fine and coarse laser control 
buttons in the 4000 Series Explorer™ software Manual Control 
window and on the Control Pad (Figure F-1 on page F-2). 

Note: The Manual Control window has both fine and coarse laser 
control buttons. The Control Pad has only fine laser control buttons.

The laser control buttons decrease and increase laser intensity when 
you are in Interactive mode and using Manual control. You cannot 
manually adjust the laser intensity from the Remote Access Client 
software or during an automatic control acquisition. For more 
information, see the 4000 Series Explorer™ Online Help, Manually 
Adjusting Laser Intensity.

To set the adjustment increments of the fine and coarse laser control 
buttons:

1. Select Tools > Preferences.

2. In the Preferences dialog box, select the Laser tab.

3. Type or select adjustment units in the Fine and Coarse text 
boxes, then click Apply. Default values are 10 and 100, 
respectively.
The adjustment units you enter are the units of laser intensity 
that are increased or decreased each time the laser control 
buttons are clicked or pressed.



DRAFT
October 26, 2004 4:05 pm, 4800HWGuide_Ch2.fm

Chapter 2 Preparing the 4800 MALDI TOF/TOF™ Analyzer

2-8 4800 MALDI TOF/TOF™ Analyzer Hardware Guide

Setting Bar Code Preferences

If you use the handheld bar code scanner with the 4800 MALDI 
TOF/TOF™ Analyzer, you must configure the software to enable the 
bar code scanner.

Note: The handheld bar code scanner works only with 4000 Series 
Explorer™ Software Version 3.0 or higher and with 4700 Explorer™ 
Software Version 2.0 or later.

To set the bar code scanner preferences:

1. Select Tools > Preferences .

2. In the Preferences dialog box, select the Bar Code tab.

3. Select Enable Scanner. The tab expands (Figure 2-3).

Figure 2-3 Expanded Bar Code tab parameters

4. Select COM1 in the Port drop-down list.

5. Scan a bar code. The code is displayed in the Bar code field and 
the scanner is enabled. 

IMPORTANT! If the code is not displayed in the Bar code field, 
select another port, then rescan.

6. Click OK.
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Configuring the Hardware
You can configure the:

• Vacuum system
• High Voltage
• Laser
• Light
• CID System
• CID Gases

IMPORTANT! You cannot configure hardware using the 4000 Series 
Explorer™ Remote Access Client software.

Vacuum
Configuration

To check the vacuum configuration:

1. In the 4000 Series Explorer™ software, select Instrument > 
Hardware Configuration.

2. Select the Vacuum 4800 tab (Figure 2-4).
.

Figure 2-4 Vacuum configuration parameters

3. Specify the values as needed (Table 2-3):
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4. Click OK to apply the changes and exit the hardware 
configuration.

Table 2-4 Vacuum configuration parameters

Parameter Description

Max Operating Pressure (torr) 

Pressure above which the high-voltage power supplies are automatically powered off to prevent 
damage to the instrument.

If the chamber pressure is above the Max Operating Pressure, an error message is displayed, and the 
corresponding pane in the Status Bar turns yellow, then pink if the over-pressure persists for more 
than 30 seconds. The high voltages cannot be turned on, and the software writes an error in the 
Windows® 2000 Event log.

Source 1 Chamber (BA1)  Valid range is 10–5 to 10–9 torr. Default is 9 × 10–6 torr.

Source 2 Chamber (BA2) Valid range is 10–4 to 10–5 torr. Default is 5 × 10–5 torr.

Load/Eject Cycle

Sample Loading Chamber Pressure 
Threshold (torr) for plate transfer

Pressure the sample loading chamber must reach before the 
sample plate moves in or out of the Source Chamber. High 
values allow faster plate loading. Conversely, a low value is 
closer to the Source Chamber Recovery Pressure Threshold 
value (below), decreasing the pump down needed and 
allowing high voltages to be turned on sooner. Therefore low 
values allow a smaller Source Chamber Recovery Time value 
(below).

Source Chamber Recovery Pressure 
Threshold (torr) 

After the sample plate is loaded or ejected, pressure the 
source chamber must reach before the high voltages can be 
turned on.

Source Chamber Recovery Time 
(sec)

 After the sample plate is loaded or ejected, the time that the 
software “waits” for the Source 1 Chamber to reach the Max 
Operating Pressure. 

Valid range is 0 to 300 seconds. Default is 120 seconds.

If the wait time is exceeded, an error message is displayed 
that gives you the option of an additional wait time or ejecting 
the plate. 
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High-Voltage,
Laser, and Light

Configurations

To check the high-voltage, laser, and light source configurations:

1. In the 4000 Series Explorer™ software, select Instrument > 
Hardware Configuration.

2. Select the High Voltage/Laser/Light tab (Figure 2-5).

Figure 2-5 High voltage/laser/light tab parameters
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3. Specify the High Voltage Idle Set-Up Power-Off and Idle Time 
(min) parameters.

IMPORTANT! After restarting the high-voltage power supplies, 
allow the high-voltage power supplies to warm up for at least 
30 minutes before acquiring data. 

• When you select Automatic Power-Off when Idle, specify 
an Idle Time (the number of minutes of instrument 
inactivity after which the high-voltage power supplies are 
automatically powered off). The default is 60 minutes. 

• When you deselect Automatic Power-Off when Idle, the 
high voltage remains on until overridden by any of the 
following actions: 
– You select Instrument > Turn off High Voltage.
– Source 1 or Source 2 pressure exceeds the Maximum 
Operating Pressure.
– You click Load or Eject.
– The interlock is broken.

4. Specify a Laser Idle time (the number of minutes of laser 
inactivity after which the laser is automatically powered off).The 
default is 30 minutes.

Automatic Power-Off when Idle is always enabled. Shutting off 
the laser extends its lifetime. 

5. Select the Light Source: 
• Tangential to Plate – The Video Viewer window displays 

the sample spot as white crystals on a black background. 
Light illuminating the sample is at an angle to the plate 
(Figure 1-8 on page 1-13).

• Orthogonal to Plate – The Video Viewer window displays 
the sample spot as black crystals on a white background. 
Light illuminating the sample is directly above the plate. 
Use this option for stainless steel plates (Figure 1-8 on 
page 1-13).

• Both – The video viewer displays the sample spot as white 
crystals on a black background. Both lights (tangential and 
orthogonal) illuminate the sample. Use to achieve a 3 D 
effect, for example, when viewing 3-HPA matrix.
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6. Specify the Light Source Idle Setup and Idle Time (min) 
parameters.

• When you select Automatic Power-Off when Idle, you can 
specify an Idle Time (the number of minutes of inactivity 
after which the light source power supply automatically 
turns off). The default is 60 minutes. Powering off the light 
source extends the lifetime of the tangential light source. 
The light source powers on again when you perform any 
one of the following tasks: 
– Start an acquisition
– Load, eject, mount, unmount, or move a sample plate
– Turn high voltages on or off
– Specify any hardware configuration parameter
– Reinitialize the system
– Adjust the light source or laser intensity
– Charge the CID cell or turn CID on or off

• When you deselect Automatic Power-Off when Idle, the 
light source remains on.

7. Click OK to apply the changes and exit the hardware 
configuration.

Local Instrument
Configuration

To check the local instrument configuration:

1. In the 4000 Series Explorer™ software, select Instrument > 
Hardware Configuration.

2. Select the Local Instrument tab.

3. Review the following read-only fields:
• Instrument type – Displays your instrument type.
• Serial Number – Displays the serial number for the 

connected instrument. The serial number is printed on most 
printouts from the software.

• Laboratory Name – Displays your laboratory name as 
entered by the Applied Biosystems/MDS SCIEX 
representative during installation. 

• Instrument Name – Displays your instrument name as 
entered by the Applied Biosystems/MDS SCIEX 
representative during installation. The Instrument Name is 
printed on most printouts from the software.

4. Click OK to exit the hardware configuration.
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Geometry
Configuration

The Geometry tab displays parameters and settings that should be 
changed only by an Applied Biosystems/MDS SCIEX technical 
representative. It is password protected. The date of the Last Source 
Model Calibration, which is done only by an Applied Biosystems/MDS 
SCIEX technical representative, is also displayed.

Do not change the Geometry Hardware 
Configuration. Changing these settings can cause your system to 
malfunction. 

CID System
Configuration

To check the CID system configuration:

1. In the 4000 Series Explorer™ software, select Instrument > 
Hardware Configuration.

2. Select the CID System tab.

3. Specify the Fault Conditions Consecutive Charges Limit. This 
feature prevents the CID from continually recharging if a leak is 
present.

Consecutive Charges Limit is the maximum number of 
consecutive collision gas charges allowed of the CID system in 
an effort to exceed a recharge threshold pressure. Valid range is 
1 to 20. The default is 20. 

If the limit is exceeded, recharging ceases, the CID valve closes, 
the system goes into a fault state and will not operate until the 
problem is resolved.

4. Specify the Gas Inlet 1 Attached Gas Weight. Select: 
• Heavy for gases such as xenon
• Medium for gases such as air, nitrogen, and argon
• Light for gases such as helium and neon

5. Click OK to apply the changes and exit the hardware 
configuration.
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CID Gases
Configuration

To check the CID gases configuration:

1. In the 4000 Series Explorer™ software, select Instrument > 
Hardware Configuration.

2. Select the CID Gases tab (Figure 2-6).

Figure 2-6 CID Gases tab
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3. Specify the threshold and fast charge values (Figures 2-6):
Note: After lowering a recharge threshold value, purge the CID.

• Recharge Pressure Threshold – The Source 2 chamber 
pressure below which the CID system automatically 
recharges with the selected gas. The active threshold value 
is the value corresponding to both the:
– Selected gas type (Heavy, Medium, Light) in the 
Hardware Configuration CID System tab
– Selected gas pressure (Medium, High) in the Spot Set 
Manager-Job tab. 
The current gas type and pressure are display in the CID 
System Viewer. Optimize gas pressure for each gas by 
adjusting the value until you see the desired fragmentation.

• Fast Charge – The number of charges applied the first time 
you fill the collision cell, for example, when changing from 
one gas to another.

Table 2-5 indicates the valid ranges and default values.

4. Click OK to apply the changes and exit the hardware 
configuration.

Table 2-5 CID Gases parameters

Parameter

Weight Gas

Heavy
Such as xenon

Medium or Air
Such as nitrogen or argon

Light
Such as helium and neon

Medium Recharge Threshold

Valid range 5 × 10–7 to 1 × 10–5 torr 5 × 10–7 to 1 × 10–5 torr 5 × 10–7 to 1 × 10–5 torr

Default 1.25 × 10–6 torr 1.25 × 10–6 torr 1.25 × 10–6 torr

High Recharge Threshold

Valid range 5 × 10–7 to 1 × 10–5 torr 5 × 10–7 to 1 × 10–5 torr 5 × 10–7 to 1 × 10–5 torr

Default 2.5 × 10–6 torr 2.5 × 10–6 torr 2.5 × 10–6 torr

Fast Charge

Valid range 1 to 10 1 to 10 1 to 10

Default 7 7 7
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Overview
In MALDI-TOF applications, the sample preparation technique 
directly affects the quality of the data you obtain. To prepare samples 
for analysis:

Select the spotting technique and 

Dilute the sample

Dry the spots

Clean up the sample (optional)

Examine the crystals

Spot the ample and matrix on the insert 
(Dried-droplet or Thin-layer technique)

select and prepare matrix accordingly

Select an insert

Load the insert in the holder

Load the plate in the instrument
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Selecting a Spotting Technique
The two techniques presented for sample spotting are dried droplet 
and thin layer. The dried-droplet technique is a simple technique 
suitable for most applications. The thin-layer technique is used for 
increased sensitivity, that is, when analyzing peptides with a final 
concentration <0.1 pmol/mL and CHCA matrix.You can also use the 
dried-droplet technique to analyze samples with a final concentration 
<0.1 pmol/mL by decreasing the CHCA matrix concentration and 
adding ammonium salts (see Zhu, X, and Papayannopoulos, I, 2003).

Dried Droplet The dried-droplet technique is recommended for most applications. 
With this technique, you can for mix sample and matrix by one of the 
methods described in Table 3-1. 

IMPORTANT! When using CHCA, follow the corresponding matrix 
preparation in Table 3-3 on page 3-10. 

Table 3-1 Dried-Droplet Technique Mixing Methods

Mixing Method Description Conditions for Using

No mixing. 
Overlaying the 
sample and matrix 
solutions

Spot the sample, allow the 
sample spot to dry, then spot 
matrix. 

• For most applications with CHCA matrix
• When you want to preserve the sample

If the matrix is highly soluble in 
the sample, spot the matrix 
first, then the sample.

• When you work with DHB matrix

Mixing on sample 
plate

Mix the sample solution and 
matrix solution directly on the 
sample plate. The sample 
solution is typically diluted 1:2 
with matrix solution.

• When you work with dilute samples and 
can spot equal volumes of sample 
solution and matrix solution to create a 
1:2 dilution 

• When you prepare only a few samples
• When you are concerned about sample 

adsorbing to the plastic tubes

Premixing in a 
tube

Premix the sample solution and 
matrix solution in a 
microcentrifuge tube before 
applying to the sample plate. 
The sample solution is typically 
diluted 1:10 with matrix 
solution.

• When you have concentrated samples 
with a high salt concentration and need to 
make dilutions

• When you prepare many samples
• When you are analyzing nonpolar samples 

and matrix prepared in high 
concentrations of organic solvent that 
evaporates rapidly
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Thin-layer The thin-layer technique requires a polished blank sample plate or 
insert (no etched positions). The matrix solution and sample solution 
are spotted and dried separately.

IMPORTANT! When using the thin-layer technique for high-
throughput applications, acquire data in interactive mode using 
Automatic Acquisition Control. In the acquisition method, specify 
the following:

• In the Spectrum tab, set the Shots/sub-spectrum low 
(typically less than 20). 

• In the Automatic Control tab, Sample Stage Mode, select 
Move before every sub-spectrum (pass or fail).

Selecting the Matrix

Overview Below are general guidelines for selecting a matrix for your 
application. However, when examining a sample mixture, you may 
need to prepare the mixture more than once, each time with a 
different matrix.

Proteomics
Applications

For proteomics applications, you can use any of the following 
matrices.

Application Recommended Matrix

Proteomics applications for peptides and 
proteins <10,000 Da. 

Most commonly used matrix because it is easy 
to prepare and set up and provides good 
sensitivity.

α-cyano-4-hydroxycinnamic acid (CHCA)

Peptides and proteins >10,000 Da Sinapinic acid (3,5-dimethoxy-4-hydroxy 
cinnamic acid)

Peptides and proteins <10,000 Da 2,5-dihydroxybenzoic acid (DHB) (gentisic acid)

• Peptides and proteins >10,000 Da
• Glycosylated proteins

2,5-dihydroxybenzoic acid and 
5-methoxysalicylic acid (sDHB)
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Non-Proteomics
Applications

For non-proteomics applications, you can use any of the following 
matrices.

Synthetic
Polymers

When analyzing synthetic polymers, choose a matrix according to the 
type of synthetic polymer sample you are analyzing:

•Aromatic (for example, polystyrene) – Use 25 mg/mL 
dithranol and 1 mg/mL silver trifluoroacetate (Ag TFA) 
dissolved in tetrahydrofuran (THF)

•Polar – Use 10 mg/mL DHB dissolved in deionized water
•Non-polar – Use 10 mg/mL indole acrylic acid (IAA) or DHB 

dissolved in THF, dimethylformamide (DMF), or acetone

Application Recommended Matrix

• Small oligonucleotides (<3,500 Da)
• Acidic carbohydrates
• Acidic glycopeptides
• Acid-sensitive compounds

2,4,6-trihydroxyacetophenone (THAP) 

Large oligonucleotides (>3,500 Da) 3-hydroxypicolinic acid (3-HPA) in ammonium 
citrate

• Neutral or basic carbohydrates
• Glycolipids (negative ions), 
• Polar and non-polar synthetic polymers
• Small molecules

2,5-dihydroxybenzoic acid (DHB)
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Preparing the Matrix
CHEMICAL HAZARD. Refer to the Material 

Safety Data Sheet (MSDS) provided by the chemical manufacturer 
before handling solvents or matrices.

Required
Materials

• Balance
• 1.5 mL microcentrifuge tubes
• Micropipettor and disposable tips
• Centrifuge
• Vortex mixer
• Matrix
• Solvents (see the requirements for the specific matrix)

• Deionized water

Guidelines Careful preparation of sample and matrix, and proper spotting, are 
key to obtaining optimal results. Follow the guidelines below:

• For sample and matrix handling, use high-quality plastic pipette 
tips, vials, tubes, and trays. Lower-quality consumables are more 
likely to lead to extraneous peaks caused by plasticizers and 
other potential contaminants. (Lower-quality consumables also 
may cause high peptide loss due to adsorption of the peptides to 
the plastic.) If you detect extraneous peaks, try prewashing the 
consumables with the same solvent used in your sample or 
matrix.

• Use a fresh tip each time you pipette a different substance.
• Using a solvent with an organic concentration greater than 50% 

can cause spreading when spotting sample and matrix on the 
plate. If sample spreading occurs, decrease the organic 
concentration in the solvent to less than 50%.

• Use double-deionized water such as Milli-Q® grade 18 mΩ 
water, which is appropriate for any application. HPLC-grade 
water can vary in salt concentration and may produce adduct 
ions in mass spectra. High salt concentrations can interfere with 
some applications, particularly oligonucleotide analysis. 

• Some matrices degrade on exposure to light or humidity. For 
stability information and storage conditions, refer to the 
manufacturer’s instructions.



DRAFT
October 26, 2004 4:05 pm, 4800HWGuide_Ch3.fm

Preparing the Matrix

4800 MALDI TOF/TOF™ Analyzer Hardware Guide 3-7

• After spotting, example the crystal structure. Appendix C, 
“Matrices,” contains additional information on matrix structure, 
appearance, and matrix solutions. For additional information on 
other matrices and their applications, refer to the Bibliography at 
the end of this guide.

• Matrices other than a-cyano-4-hydroxycinnamic acid (CHCA) 
may have unevenly distributed crystallization. Acquire data on 
these spots in Interactive mode using the Video Viewer to 
manually select the area of the spot you want to acquire. For 
information, see the 4000 Series Explorer™ Online Help, 
Acquiring Data from the Video Viewer.

IMPORTANT! When using the thin-layer technique for high-
throughput applications, acquire data in interactive mode using 
Automatic Acquisition Control. In the acquisition method, specify 
the following:

• In the Spectrum tab, set the Shots/sub-spectrum low 
(typically less than 20). 

• In the Automatic Control tab, Sample Stage Mode, select 
Move before every sub-spectrum (pass or fail).
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General
Preparation

Procedure

To prepare a specific matrix, follow the procedure below, using the 
solvents, concentrations, and modifications indicated in the 
preparation information for the matrix (refer to the tables listed in 
Table 3-2). 

Table 3-2 Preparation requirements for specific matrices

Matrix Modifications to the General 
Preparation Procedures

Recommended 
Expiration After 

Preparationa

CHCA (a-cyano-4-hydroxycinnamic 
acid)

Table 3-3 on page 3-10 
(dried droplet)

Table 3-4 on page 3-13 
(thin layer)

One week

Sinapinic acid (3,5-dimethoxy-4-
hydroxy cinnamic acid)

Table 3-5 on page 3-14 One day

DHB (2,5-dihydroxybenzoic acid or 
Gentisic acid)

Table 3-6 on page 3-16 
(peptides and proteins <10,000 Da)

Table 3-7 on page 3-17 
(neutral carbohydrates)

Table 3-8 on page 3-18
(small molecules)

One week

sDHB (2,5-dihydroxybenzoic acid 
and 5-methoxysalicylic acid)

Table 3-9 on page 3-19 One week

THAP (2,4,6-
trihydroxyacetophenone)

Table 3-10 on page 3-20 One week

3-HPA (3-hydroxypicolinic acid) Table 3-11 on page 3-22 One week

Synthetic polymer matrices Table 3-12 on page 3-23 One weekb

a. Follow the manufacturer’s instructions for storage conditions. 
b. Store THF and acetone solutions in tightly sealed vials.
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To prepare matrix:

1. Label a 1.5-mL microcentrifuge tube with the name of the 
matrix, the final concentration, the date prepared, and expiration 
date. To determine the expiration date, see Table 3-2.

2. Zero the balance with the labeled tube.

3. Weigh out the matrix into the tube. 

Note: You do not need to weigh out the exact amount of matrix. 
You can record the weight of the matrix and adjust the volume of 
solvent to achieve the desired final concentration.

4. Add a volume of appropriate solvent to achieve the needed 
concentration for your matrix. To determine the appropriate 
solvent and the proper concentration for your matrix, see the 
specific matrix information. The solvent should also be miscible 
with the sample.

5. Cap the tube and vortex thoroughly for approximately 1 minute 
or until dissolved. You can shake the tube by hand if you do not 
have a vortex mixer.

6. If your matrix requires an additive:

a. Zero the balance with another microcentrifuge tube and 
weigh out the additive into the tube. To determine the 
additive required for your matrix, see the individual matrix 
information.

b. Add a volume of appropriate solvent to achieve the needed 
concentration for the additive. To determine the appropriate 
solvent and the proper concentration for your additive, see 
the individual matrix information.

c. Cap the tube and vortex thoroughly for approximately 
1 minute or until dissolved. 

d. Add the additive solution to the matrix solution.

7. Centrifuge the tube for 30 seconds at 2,000 to 5,000 rpm. 
Alternatively, allow the solution to settle for about 10 minutes. 
You may see a precipitate at the bottom of the tube. 
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Preparing CHCA Matrix for the Dried-Droplet Spotting Technique

The dried-droplet spotting technique is used for most high-
throughput analyses of peptides and proteins <10,000 Da.

Note: When analyzing samples with concentrations of 0.1 pmol/µL 
or lower, the CHCA matrix sodium and potassium adducts interfere 
with MS analysis and spectral interpretation. To reduce the 
interference from these matrix adducts, add ammonium monobasic 
phosphate or ammonium dibasic citrate when preparing CHCA 
matrix (see Zhu, X, and Papayannopoulos, I, 2003).

CHEMICAL HAZARD. Read the MSDS 
before handling any chemical mentioned below, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, 
and gloves. Alpha-cyano-4-hydroxycinnamic acid (CHCA) may 
cause eye, skin, and respiratory tract irritation. Acetonitrile (ACN) is 
a flammable liquid and vapor. Exposure may cause eye and 
respiratory tract irritation and blood system damage. Trifluoroacetic 
acid (TFA) causes eye, skin, and respiratory tract burns. It is harmful 
if inhaled. Ethanol is a flammable liquid and vapor. Exposure causes 
eye, skin, and respiratory tract irritation and may cause central 
nervous system depression and liver damage.

Table 3-3 CHCA matrix information for the dried-droplet spotting technique

Attribute/Procedure Description

Matrix Preparation

Matrix stability Prepare weekly.

Matrix solvent • 0.1% TFA in deionized water
• 0.1% TFA in acetonitrile

Matrix concentration 5 mg/mL; 2 mg/mL for samples with a concentration of ≤1 fmol/µL

Matrix additive (samples with 
concentrations of 0.1 pmol/µL 
or lower)

ammonium monobasic phosphate or ammonium dibasic citrate 
(see Zhu, X, and Papayannopoulos, I, 2003)
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General preparation 
modificationsa

IMPORTANT: If the dry matrix has a mustard-yellow color instead 
of bright yellow, it may contain impurities. To recrystallize (purify), 
dissolve the CHCA matrix in warm ethanol. Filter and add about 
two volumes of deionized water. Let stand overnight in an 
explosion proof-refrigerator. Filter, then wash the precipitate with 
cold water. This procedure is not optimized for yield.

Follow the procedure in “General Preparation Procedure” on 
page 3-8. In step 4, prepare the matrix solvent by combining 0.1% 
TFA in water with 0.1% TFA in acetonitrile. The ratio of water to 
acetonitrile depends on how you plan to mix the sample and matrix 
solutions:

• When premixing the sample solution in matrix solution, 
typically at a 1:10 dilution (sample solution to total volume) – 
Use a 1:1 ratio of water to acetonitrile. Combine one part 0.1% 
TFA in water with one part 0.1% TFA in acetonitrile, and, if using 
matrix additive, add the matrix additive (skip step 6 of the 
“General Preparation Procedure” on page 3-8). Add solvent 
solution to the CHCA matrix. For example, for a final 
concentration of 5 mg/mL, combine 500 µL 0.1% TFA in water, 
500 µL 0.1% TFA in acetonitrile, and matrix additive (if 
appropriate), then add the mix to 5 mg solid matrix. 

• When overlaying or mixing on the plate, typically at a 1:2 
dilution (sample solution to total volume) – Use a 4:6 ratio of 
water to acetonitrile. Combine four parts 0.1% TFA in water with 
six parts 0.1% TFA in acetonitrile. Add solvent solution to the 
CHCA matrix for a final concentration of 5 mg/mL. For example, 
combine 400 µL 0.1% TFA in water and 600 µL 0.1% TFA in 
acetonitrile, then add the mix to 5 mg solid matrix. 

Note: A higher concentration of TFA (up to 3%) may improve 
sample solubility.

Spotting

Spotting technique Dried-droplet

Plate drying method Air-dry the sample plate after spotting sample and matrix, or use 
gentle air flow to speed drying.

Matrix crystals Rounded (see Figure 3-1 on page 3-42)

Final sample concentration 0.1 to 5 pmol/µL

a. Shevchenko, A., M. Wilm, O. Vorm, M. Mann, Anal. Chem., 1996, 68, 850–858.

Table 3-3 CHCA matrix information for the dried-droplet spotting technique (continued)

Attribute/Procedure Description
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Preparing CHCA Matrix for the Thin-Layer Spotting Technique

The thin-layer spotting technique is used when you need increased 
sensitivity, for example, when sample concentration is 0.1 pmol/µL 
or lower. Peptides must be <~3,000 Da.

CHEMICAL HAZARD. Read the MSDS 
before handling any chemical mentioned below, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, 
and gloves. Alpha-cyano-4-hydroxycinnamic acid (CHCA) may 
cause eye, skin, and respiratory tract irritation. Acetone is a 
flammable liquid and vapor. Exposure may cause eye, skin, and upper 
respiratory tract irritation. Prolonged or repeated contact may dry the 
skin. Exposure may cause central nervous system depression. Keep 
away from heat, sparks, and flame. Isopropanol is a flammable 
liquid and vapor. Exposure may cause eye, skin, and upper 
respiratory tract irritation. Prolonged or repeated contact may dry 
skin and cause irritation. Exposure may cause central nervous system 
effects such as drowsiness, dizziness, and headache. Ethanol is a 
flammable liquid and vapor. Exposure causes eye, skin, and 
respiratory tract irritation and may cause central nervous system 
depression and liver damage. 
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Table 3-4 CHCA matrix information for the thin-layer spotting technique 

Attribute/Procedure Description

Matrix Preparation

Matrix stability Prepare weekly.

Matrix solvent • Pure nitrocellulose (for example, Bio-Rad Laboratories Trans-Blot® 
162-0146)

• Acetone
• Isopropanol

Matrix concentration 20 mg/mL

Matrix additive None

General preparation 
modificationsa

a. Other special sample preparation techniques are described in Shevchenko, A., M. Wilm, O. Vorm, M. 
Mann, Anal. Chem., 1996, 68, 850–858.

IMPORTANT: If the dry matrix has a mustard-yellow color instead of 
bright yellow, it may contain impurities. To recrystallize (purify), dissolve 
the CHCA matrix in warm ethanol. Filter and add about two volumes of 
deionized water. Let stand in an explosion-proof refrigerator overnight. 
Filter, then wash the precipitate with cold water. This procedure is not 
optimized for yield.

Follow the procedure in “General Preparation Procedure” on page 3-8. 
To prepare the solvent solution used in step 4, first prepare 20 mg/mL 
nitrocellulose in acetone solution. To dissolve nitrocellulose in acetone, 
vortex for 15 minutes. Next, combine one part nitrocellulose solution 
with one part isopropanol. Add the solvent solution to the CHCA matrix 
for a final concentration of 20 mg/mL.

Spotting

Spotting technique Thin-layer

Plate drying method Air-dry the sample plate after spotting matrix solution. After spotting 
sample solution, dry the sample plate with gentle air flow, such as a 
heat gun set at low heat and air-flow settings.

Matrix crystals Rounded (see Figure 3-1 on page 3-42)

Final sample concentration Up to 0.1 pmol/µL 
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Sinapinic Acid Matrix

Use sinapinic acid matrix for peptides and proteins >10,000 Da. See 
Table 3-5 on page 3-14.

CHEMICAL HAZARD. Read the MSDS 
before handling any chemical mentioned below, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, 
and gloves. Sinapinic acid may cause eye, skin, and respiratory tract 
irritation. Acetonitrile (ACN) is a flammable liquid and vapor. It 
may cause eye, skin, and respiratory tract irritation, central nervous 
system depression, and heart, liver, and kidney damage. 
Trifluoroacetic acid (TFA) causes eye, skin, and respiratory tract 
burns. It is harmful if inhaled. 

.

Table 3-5 Sinapinic acid matrix information

Attribute/Procedure Description

Matrix Preparation

Matrix stability Prepare daily.

Matrix solvent • 0.1% TFA in deionized water
• 0.1% TFA in acetonitrile

Matrix concentration 5 mg/mL 

Matrix additive None



DRAFT
October 26, 2004 4:05 pm, 4800HWGuide_Ch3.fm

Preparing the Matrix

4800 MALDI TOF/TOF™ Analyzer Hardware Guide 3-15

General preparation 
modifications

Follow the procedure in “General Preparation Procedure” on page 3-8. 
In step 4, combine 0.1% TFA in water with 0.1% TFA in acetonitrile for 
the matrix solvent. The ratio of water to acetonitrile depends on how 
you plan to mix the sample solution and matrix solution:

• If you plan to premix the sample solution in matrix solution in a 1:10 
dilution, combine seven parts 0.1% TFA in water with three parts 
0.1% TFA in acetonitrile. Add solvent solution to the sinapinic 
matrix for a final concentration of 5 mg/mL. For example, add 
700 µL 0.1% TFA in water and 300 µL 0.1% TFA in acetonitrile to 
5 mg solid matrix. 

Note: If sample is contaminated with buffer, salt, or detergent, 
combine 500 µL 0.1% TFA in water and 500 µL 0.1% TFA in 
acetonitrile. 

• If you plan to mix the sample solution in matrix solution on the plate 
in a 1:2 dilution, combine one part 0.1% TFA in water with one part 
0.1% TFA in acetonitrile. Add solvent solution to the sinapinic 
matrix for a final concentration of 5 mg/mL. For example, add 
500 µL 0.1% TFA in water and 500 µL 0.1% TFA in acetonitrile to 
5 mg solid matrix.

Note: A higher concentration of TFA (up to 3%) may improve sample 
solubility.

Spotting

Spotting technique Dried-droplet

Plate drying method Air-dry sample plate after spotting sample and matrix, or use gentle air 
flow to speed drying.

Matrix crystals Uniform rhomboid shape (see Figure 3-1 on page 3-42)

Final sample concentration 0.1 to 5 pmol/µL 

Table 3-5 Sinapinic acid matrix information (continued)

Attribute/Procedure Description
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DHB Matrix
Use DHB matrix for:

•Peptides and proteins <10,000 Da 
•Neutral carbohydrates
•Small molecules

DHB for Peptides
and Proteins

<10,000 Da

CHEMICAL HAZARD. Read the MSDS 
before handling any chemical mentioned below, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, 
and gloves. Methanol is a flammable liquid and vapor. Exposure 
causes eye and skin irritation, and may cause central nervous system 
depression and nerve damage. Ethanol is a flammable liquid and 
vapor. Exposure causes eye, skin, and respiratory tract irritation and 
may cause central nervous system depression and liver damage. 

Table 3-6 DHB matrix information for peptides and proteins <10,000 Da

Attribute/Procedure Description

Matrix Preparation

Matrix stability Prepare weekly.

Matrix solvent 10% methanol or ethanol in deionized water 

Matrix concentration 5 mg/mL 

Matrix additive None

General preparation 
modifications

Follow the procedure in “General Preparation Procedure” on page 3-8. 
No modifications are necessary.

Spotting

Spotting technique Dried-droplet

Plate drying method After spotting sample and matrix, dry down quickly under vacuum for 
even response.

IMPORTANT: If you allow to air-dry, you see an uneven response 
during analysis, especially during automated acquisitions.

Matrix crystals Needle-like crystals arranged in a ring if air dried (see Figures 3-3). No 
obvious crystals if vacuum-dried or if solvent is a fast-drying organic.

Final sample concentration 0.1 to 1 pmol/µL 
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DHB for Neutral
Carbohydrates CHEMICAL HAZARD. Read the MSDS 

before handling any chemical mentioned below, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, 
and gloves.

Table 3-7 DHB matrix information for neutral carbohydrates

Attribute/Procedure Description

Matrix Preparation

Matrix stability Prepare weekly.

Matrix solvent Deionized water

Matrix concentration 10 mg/mL 

Matrix additive None

General preparation 
modifications

Follow the procedure in “General Preparation Procedure” on page 3-8. 
No modifications are necessary.

Spotting

Spotting technique Dried-droplet

Plate drying method After spotting sample and matrix, dry down quickly under vacuum for 
even response.

IMPORTANT: If you air-dry, you see an uneven response during 
analysis, especially during automated acquisitions.

Matrix crystals Milky amorphous appearance for promoting cationization (see 
Figure 3-3 on page 3-43)

Note: Crystals are difficult to see when the sample plate is 
vacuum-dried.

Final sample concentration 10 pmol/µL 



DRAFT
October 26, 2004 4:05 pm, 4800HWGuide_Ch3.fm

Chapter 3 Preparing and Spotting Sample and Matrix

3-18 4800 MALDI TOF/TOF™ Analyzer Hardware Guide

DHB for Small
Molecules CHEMICAL HAZARD. Read the MSDS 

before handling any chemical mentioned below, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, 
and gloves. Methanol is a flammable liquid and vapor. Exposure 
causes eye and skin irritation, and may cause central nervous system 
depression and nerve damage. Acetone is a flammable liquid and 
vapor. Exposure may cause eye, skin, and upper respiratory tract 
irritation. Prolonged or repeated contact may dry the skin. Exposure 
may cause central nervous system depression. Keep away from heat, 
sparks, and flame. 

Table 3-8 DHB matrix information for small molecules

Attribute/Procedure Description

Matrix Preparation

Matrix stability Prepare weekly.

Matrix solvent Any solvent in which molecules are soluble (deionized water to 100% 
methanol or acetone).

Matrix concentration 10 mg/mL 

Matrix additive None

General preparation 
modifications

Follow the procedure in “General Preparation Procedure” on page 3-8. 
No modifications are necessary.

Spotting

Spotting technique Dried-droplet

Plate drying method After spotting sample and matrix, dry down quickly under vacuum for 
even response.

IMPORTANT: If you air-dry, you see an uneven response during 
analysis, especially during automated acquisitions.

Matrix crystals Needle-like crystals arranged in a ring if air-dried (see Figure 3-3 on 
page 3-43). No obvious crystals if vacuum-dried or if solvent is a fast-
drying organic.

Final sample concentration Highly sample dependent. Ideally a minimum of 0.1 to 10 pmol/µL 
(15.5 pg/µL to 1.55 ng/µL).

With lower concentrations, sample signal may be difficult to distinguish 
from matrix signal.
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sDHB Matrix
Use sDHB matrix for:

• Peptides and proteins >10,000 Da 
• Glycosylated proteins

CHEMICAL HAZARD. Read the MSDS 
before handling any chemical mentioned below, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, 
and gloves. Acetonitrile (ACN) is a flammable liquid and vapor. 
Exposure may cause eye and respiratory tract irritation and blood 
system damage. Trifluoroacetic acid (TFA) causes eye, skin, and 
respiratory tract burns. It is harmful if inhaled.

Table 3-9 sDHB matrix information

Attribute/Procedure Description

Matrix Preparation

Matrix stability Prepare weekly.

Matrix solvent A solution of 80% 0.1% TFA in deionized water and 20% acetonitrile 

Matrix concentration 10 mg/mL 

Matrix additive 5-methoxysalicylic acid, dissolved in a solution of 50% deionized water 
and 50% acetonitrile, at a concentration of 10 mg/mL 

General preparation 
modifications

Follow the procedure in “General Preparation Procedure” on page 3-8. 
In step 6, combine one part additive solution (5-methoxysalicylic acid) 
with nine parts matrix solution (DHB). 

Spotting

Spotting technique Dried-droplet

Plate drying method After spotting sample and matrix, dry down quickly under vacuum for 
even response.

IMPORTANT: If you air-dry, you see an uneven response during 
analysis, especially during automated acquisitions.

Matrix crystals Needle-like crystals arranged in a ring if air-dried (see Figure 3-3 on 
page 3-43). No obvious crystals if vacuum-dried or if solvent is a fast-
drying organic.

Final sample concentration 0.1 pmol to 10 pmol/µL
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THAP Matrix

Use THAP matrix for:

•Small oligonucleotides <3,500 Da
•Acidic carbohydrates
•Acidic glycopeptides
• Acid sensitive compounds

THAP matrix provides a more even response than 3-HPA matrix. See 
Table 3-10 on page 3-20.

CHEMICAL HAZARD. Read the MSDS 
before handling any chemical mentioned below, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, 
and gloves. 
Acetonitrile (ACN) is a flammable liquid and vapor. Exposure may 
cause eye and respiratory tract irritation and blood system damage. 

Table 3-10 THAP matrix information

Attribute/Procedure Description

Matrix Preparation

Matrix stability Prepare weekly.

Matrix solvent 50% acetonitrile in deionized water

IMPORTANT: Use double-deionized water such as Milli-Q grade 
18 mΩ water. HPLC-grade water can vary in salt concentration. A 
high salt concentration may interfere with oligonucleotide analysis.

Matrix concentration • Small oligonucleotides – 10 mg/mL
• Acidic carbohydrates – 2 mg/mL

Matrix additive 50 mg/mL diammonium citrate in deionized water

General preparation 
modificationsa

Follow the procedure in “General Preparation Procedure” on page 3-8. 
In step 6, for:

• Small oligonucleotides – Combine 1 part additive solution 
(diammonium citrate) with 8 parts matrix solution (THAP). 

• Acidic carbohydrates and glycopeptides – Combine 1 part 
additive solution (diammonium citrate) with 20 parts matrix solution 
(THAP). 
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Spotting

Spotting technique Dried-droplet

Plate drying method • Small oligonucleotides – Air-dry sample plate after spotting 
sample and matrix, or use gentle air flow to speed drying.

• Acidic carbohydrates and glycopeptides – Dry sample plate 
under vacuum after spotting sample and matrix. After drying, allow 
a few minutes for the sample to absorb ambient humidity (turns 
faint white).

IMPORTANT: If you air-dry, you see an uneven response during 
analysis, especially during automated acquisitions.

Matrix crystals Larger than sinapinic acid crystals, overlapping shingles, nonuniform 
shape (see Figure 3-2 on page 3-43)

Final sample concentration 1 to 10 pmol/µL 

a. Other special sample preparation techniques are described in Papac, D.I., A. Wong, A.J.S. Jones, Anal. 
Chem., 1996, 68, 3215–3223.

Table 3-10 THAP matrix information (continued)

Attribute/Procedure Description
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3-HPA Matrix

Use 3-HPA matrix for large oligonucleotides >3,500 Da.

CHEMICAL HAZARD. Read the MSDS 
before handling any chemical mentioned below, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, 
and gloves. 3-Hydroxypicolinic acid (3-HPA) may cause eye, skin, 
and respiratory tract irritation. Acetonitrile (ACN) is a flammable 
liquid and vapor. Exposure may cause eye and respiratory tract 
irritation and blood system damage. 

Table 3-11 3-HPA matrix information

Attribute/Procedure Description

Matrix Preparation

Matrix stability Prepare weekly.

Matrix solvent 50% acetonitrile in deionized water

Note: HPLC-grade water can vary in salt concentration. Do not use 
for oligonucleotide analysis.

Matrix concentration 50 mg/mL 

Matrix additive 50 mg/mL diammonium citrate in deionized water

General preparation 
modifications

Follow the procedure in “General Preparation Procedure” on page 3-8. 
In step 6, combine one part additive solution (diammonium citrate) with 
eight parts matrix solution (3-HPA). 

Spotting

Spotting technique Dried-droplet

Plate drying method Air dry sample plate after spotting sample and matrix, or use gentle air 
flow to speed drying.

Matrix crystals Needle-like crystals inside a ring (see Figure 3-2 on page 3-43)

Final sample concentration 1 to 10 pmol/µL 
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Matrices for Synthetic Polymers 

CHEMICAL HAZARD. Read the MSDS 
before handling any chemical mentioned below, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, 
and gloves. Tetrahydrofuran is a flammable liquid and vapor and 
may form explosive peroxides. It may be harmful if swallowed. 
Exposure may cause eye and respiratory tract irritation and central 
nervous system depression. N,N-Dimethylformamide (DMF) is 
harmful if inhaled. It is a flammable liquid and vapor. Exposure may 
cause eye, skin, and respiratory tract irritation and liver damage. 
Acetone is a flammable liquid and vapor. Exposure may cause eye, 
skin, and upper respiratory tract irritation. Prolonged or repeated 
contact may dry the skin. Exposure may cause central nervous system 
depression. Keep away from heat, sparks, and flame.

C

Table 3-12 Matrix information for synthetic polymer samples

Attribute/Procedure Description

Matrix Preparation

Matrix stability Prepare weekly. Store THF and acetone solutions in tightly sealed vials.

Matrix solvent Sample and matrix dependent. Choose solvents in which both the 
synthetic polymer sample and matrix are soluble.

Matrix concentration ~0.1 M (10–1 M)

Matrix additive None

General preparation 
modifications

Follow the procedure in “General Preparation Procedure” on page 3-8. 
No modifications are necessary.

Sample/matrix mixing Mix the sample solution in matrix solution in a 1:2 dilution. For 
example, combine 1 µL sample solution and 1 µL matrix solution. For 
more information, see “Spotting Sample and Matrix Using the 
Dried-Droplet Spotting Technique” on page 3-39.
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Spotting

Spotting technique Dried-droplet

You can spot polymer samples on sample plates in two ways:

• Thin-layer polymer method – Yields even response, but provides 
adequate sample response for only 10 laser shots. Spot 0.3 µL 
sample/matrix solution in one sample position.

• Thick-layer polymer method – Yields less even response, but 
provides adequate sample response for 50 to 100 laser shots. Spot 
2 to 3 µL sample/matrix solution in one sample position by placing 
the pipette tip in the sample position and slowly expelling while 
keeping the tip in contact with the sample plate.

Note: In general, do not touch the pipette tip to the sample plate 
surface. However, when you use THF as the solvent in the thick-layer 
method, you must touch the tip to the sample plate to slowly expel the 
sample onto the sample plate.

For more information, see “Spotting Sample and Matrix Using the 
Dried-Droplet Spotting Technique” on page 3-39.

IMPORTANT: Analyze polymer samples within 1 hour of spotting on 
the sample plate. Many synthetic polymer/matrix mixtures are not 
stable after they are spotted.

Plate drying method Apply vacuum drying for nonvolatile solvents (water, DMF). Acetone 
and THF dry instantaneously.

Matrix crystals No crystals visible. If sample position looks glassy or shiny, the sample 
concentration may be too high.

Note: Areas in which you see hot and cold spots during acquisition 
are much smaller with polar compounds than with nonpolar 
compounds.

Final sample concentration ~0.1 mM (10–4 M)

Table 3-12 Matrix information for synthetic polymer samples (continued)

Attribute/Procedure Description
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Cleaning the Sample
IMPORTANT! For sample and matrix handling, use high-quality 
plastic pipette tips, vials, tubes, and trays. Lower-quality 
consumables are likely to lead to extraneous peaks caused by 
plasticizers and other potential contaminants. (Lower-quality 
consumables also may cause high peptide loss due to adsorption of 
the peptides to the plastic.) If you detect extraneous peaks, try 
prewashing the consumables with the same solvent used in your 
sample or matrix.

When to Clean
Samples

Sample cleanup is needed if samples:

• Are prepared in phosphate buffers. 
• Have ammonium salts or derivatives of organic amines 

(ammonium bicarbonate, TRIS HCl) in concentrations greater 
than 50 mM.

• Contain salt, for example, from cation- or anion-exchange 
purification.

• Are contaminated with detergent.
Clean the sample just before diluting and spotting the sample plate.

Symptoms of
Contamination

Cleaning the sample is recommended whenever there is:

• Poor crystallization on the sample plate.
• A large tail on the high-mass side of peaks, which may be 

unresolved salt or buffer adducts.
• Poor sensitivity with a sample concentration that should yield a 

strong signal. To detect this condition, mix the sample with a 
standard that you know yields a strong signal. If the standard 
does not exhibit the expected signal, a contaminant in the 
sample is affecting sensitivity.
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Selecting a
Cleaning

Technique

Use the following techniques to clean samples:

• Washing – Use this technique when you know the solubility of 
the contaminant. You can wash a dried sample directly on the 
sample plate.

• Drop dialysis (floating membrane) – Use this technique on 
polar compounds when you know the contaminants are of low 
molecular weight. This technique works well for DNA and polar 
proteins such as glycoproteins.

• Cation exchange – Use this technique for nonpolar proteins or 
DNA when you know the sample contains only a salt 
contaminant. This technique is faster than dialysis but does not 
remove contaminants other than salt.

• ZipTips® – Use this technique for peptides, proteins, and 
oligonucleotides when you know the sample contains salt, 
buffer, and/or glycerol contaminants. This technique is faster, 
easier, and more effective than dialysis for removing 
contaminants. 
Millipore ZipTips can be used for a wide range of applications 
and are compatible with digestion procedures. You can expect 
50 to 70% recovery using the following procedure.

Note: ZipTips can also be used for sample concentration and 
fractionation of complex mixtures.
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Washing

Required
Materials

Select a washing solvent in which the contaminant is more soluble 
than the matrix and the sample. For example:

CHEMICAL HAZARD. Isopropanol is a 
flammable liquid and vapor. Exposure may cause eye, skin, and upper 
respiratory tract irritation. Prolonged or repeated contact may dry 
skin and cause irritation. Exposure may cause central nervous system 
effects such as drowsiness, dizziness, and headache. Read the MSDS, 
and follow the handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves. Trifluoroacetic acid (TFA) causes 
eye, skin, and respiratory tract burns. It is harmful if inhaled.

Procedure To wash samples:

1. Apply sample and matrix to the sample plate and allow to dry.

2. Add 1 to 3 µL of washing solvent to the dry sample/matrix. 

3. Wait 10 seconds, then remove the liquid. 

IMPORTANT! Try not to touch the sample plate with the pipette 
tip. If you do touch the spot, do not analyze the area you 
touched.

4. Repeat step 2 and step 3 one more time.

5. Allow the sample plate to dry before analyzing.

Note: If above washes do not improve results, you can repeat 
the wash procedure.

If the contaminant is … Then use …

A polar compound, such as a salt or 
buffer

Cold water (to prevent sample 
dissolving) with 0.1% TFA

A nonionic detergent such as octyl 
glucoside

5% isopropanol in water
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Drop Dialysis (Floating Membrane)

Required
Materials

• A membrane with a pore size of 0.025 µm or smaller that does 
not adhere to your sample

• Double-deionized water such as Milli-Q® grade 18 mΩ water
• Forceps
• Acetonitrile

Procedure To perform drop dialysis:

1. Fill a small container (for example, a pipette tip box) with about 
an inch of deionized water.

2. Place the container on a stable surface.

3. Use forceps to place the membrane in the water with the 
appropriate side up (refer to manufacturer’s information). If you 
use your fingers to place the membrane, you can contaminate 
the membrane with oil and salt.

4. Place about 10 parts of sample (for example, 10 µL) in the 
center of the membrane.

5. Place 1 part of pure acetonitrile (for example, 1 µL) on top of 
the sample spot to increase surface area. Do not exceed a 10% 
concentration of organic. It may dissolve the membrane.

CHEMICAL HAZARD. Acetonitrile 
(ACN) is a flammable liquid and vapor. Exposure may cause eye 
and respiratory tract irritation and blood system damage. Read 
the MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

6. Cover the container to prevent drying and allow it to dialyze for 
30 minutes.

7. Note the size of the sample/organic spot, then let it continue to 
dialyze for 30 minutes.

8. Observe the size of the sample/organic spot again. If the size of 
the spot is larger than the previous time you checked it, allow the 
sample to sit for 15 more minutes. 
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9. Repeat step 8 until the size of the spot remains constant. 

Note: Sample also passes through the membrane during 
dialysis, particularly low-mass samples. Dialyze small 
molecules for a shorter time than larger molecules. In general, 
do not dialyze for more than 2 hours.

10. When the size of the sample spot stabilizes, dialysis is complete. 
Remove the sample and place it in a microcentrifuge tube.

Note: The size of the sample drop can increase by a factor of 10 
when salt concentration is high.



DRAFT
October 26, 2004 4:05 pm, 4800HWGuide_Ch3.fm

Chapter 3 Preparing and Spotting Sample and Matrix

3-30 4800 MALDI TOF/TOF™ Analyzer Hardware Guide

Cation Exchange

Required
Materials

• Cation-exchange beads, 200-mesh. Cation-exchange beads in 
the ammonium form work best for MALDI applications.

• 1 M ammonium acetate
• Acetone
• Hexane
• Buchner funnel

Preparation of
Beads in

Ammonium Form

To prepare cation-exchange beads in the ammonium form:

1. Place the beads in twice the bead volume of 1 M ammonium 
acetate and leave beads in ammonium acetate overnight.

IMPORTANT! Ammonium acetate. Read the MSDS, and 
follow the handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves.

2. Remove the beads, then wash with water, acetone, and finally 
hexane through a Buchner funnel under vacuum.

CHEMICAL HAZARD. Read the MSDS 
before handling any chemical mentioned below, and follow the 
handling instructions. Wear appropriate protective eyewear, 
clothing, and gloves. Acetone is a flammable liquid and vapor. 
Exposure may cause eye, skin, and upper respiratory tract 
irritation. Prolonged or repeated contact may dry the skin. 
Exposure may cause central nervous system depression. Keep 
away from heat, sparks, and flame. Hexane is a flammable 
liquid and vapor. Exposure causes eye, skin, and respiratory 
tract irritation. Exposure may cause central nervous system 
depression. It is harmful or fatal if swallowed as it can enter the 
lungs and cause damage. Keep away from heat, sparks, and 
flame. 

After washing, you can store the beads indefinitely for reuse as 
needed.
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Procedure To perform cation exchange:

1. Place about 0.1 mg (a small spatula-tip-full) of cation-exchange 
beads on a piece of laboratory film.

2. Add 5 to 10 µL of sample for 200-mesh cation-exchange beads. 
If sample quantity is limited, you can make up the difference 
with deionized water.

3. Add 5 to 10 µL of matrix on top of the sample, as matrix may 
also contain salt.

4. Mix by withdrawing and expelling about 20 times with a pipette.

Note: The volume of sample decreases as the beads absorb 
water.

5. Allow the beads to settle for 30 seconds.

6. Remove the supernatant with a clean pipette tip, then spot on the 
sample plate.
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ZipTips® 

Required
Materials

• Micro-adsorptive C18 pipette ZipTips
• Acetonitrile (ACN)
• TFA

CHEMICAL HAZARD. Read the MSDS 
before handling any chemical mentioned below, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, 
and gloves. Acetonitrile (ACN) is a flammable liquid and vapor. 
Exposure may cause eye and respiratory tract irritation and blood 
system damage. Trifluoroacetic acid (TFA) causes eye, skin, and 
respiratory tract burns. It is harmful if inhaled. 

Procedure To clean samples with ZipTips:

1. Wash a C18 ZipTip in the following order with:

a. 10 µL of ACN

b. 10 µL of 50:50 ACN:0.1%TFA

c. 10 µL of 0.1% TFA

d. Repeat wash of 10 µL of 0.1% TFA

To wash, draw a few microliters of a wash solution up into the 
ZipTip and expel to waste. Repeat with the remaining wash 
solution.

2. Draw a few microliters of the sample up and down in the 
ZipTip several times. 

3. Discard the liquid. The sample is bound to the C18 surface in the 
ZipTip.

4. Wash the ZipTip again with 10 µL of 0.1% TFA by drawing up 
into the ZipTip and expelling to waste.

5. Repeat step 4 two times.

6. To elute the sample, draw up into the ZipTip 2 to 3 µL of organic 
solvent or matrix containing approximately 50% ACN. A 50% 
organic concentration should give 50 to 70% sample recovery. 
You can vary the organic concentration to optimize recovery.
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7. If spotting a plate, expel the eluate (sample) directly onto the 
plate as described in “Spotting Sample and Matrix Using the 
Dried-Droplet Spotting Technique” on page 3-39

If storing the sample or mixing it with matrix, expel the eluate 
(sample) into a microcentrifuge tube.

Diluting the Sample

Before Diluting Samples

Refer to “Cleaning the Sample” on page 3-25, to determine if your 
samples should be cleaned before preparing. 

IMPORTANT! Prepare sample just before spotting the sample plate. 

IMPORTANT! For sample and matrix handling, use high-quality 
plastic pipette tips, vials, tubes, and trays. Lower-quality 
consumables are likely to lead to extraneous peaks caused by 
plasticizers and other potential contaminants. (Lower-quality 
consumables also may cause high peptide loss due to adsorption of 
the peptides to the plastic.) If you detect extraneous peaks, try 
prewashing the consumables with the same solvent used in your 
sample or matrix.

Diluting Samples for Dried-Droplet Spotting 

Prepare a sample solution by diluting the sample in an appropriate 
liquid to an appropriate initial concentration. You will be further 
diluting to the final sample concentration when you mix the sample 
solution with matrix solution. 

If you are unsure of the starting concentration of sample, make a 
serial dilution to prepare various dilutions of the same sample.

Dilution Liquid CHEMICAL HAZARD. Read the MSDS 
before handling any chemical mentioned below, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, 
and gloves. Acetonitrile (ACN) is a flammable liquid and vapor. 
Exposure may cause eye and respiratory tract irritation and blood 
system damage. Trifluoroacetic acid (TFA) causes eye, skin, and 
respiratory tract burns. It is harmful if inhaled.
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To determine the appropriate dilution liquid, first dilute the sample 
with deionized water, then add acetonitrile. Add 0.1% TFA to 
increase solubility, if needed. A higher concentration of TFA may 
enhance sample ionization and improve sensitivity in samples 
prepared in buffers. 

Many samples adhere strongly to plastic tubes and pipette tips. You 
can minimize sample loss by preparing samples in 30% acetonitrile 
with 5 to 10% TFA.

IMPORTANT! Do not dilute sample with phosphate-buffered saline 
(PBS) or other buffer solutions. A high salt concentration can 
interfere with sample ionization and may cause increased sodium and 
potassium adduct peaks.

IMPORTANT! Using a dilution liquid with an organic concentration 
greater than 50% can cause spreading when spotting sample and 
matrix on the plate. If sample spreading occurs, decrease the organic 
concentration in the dilution liquid to less than 50%.

Diluting Samples for Thin-Layer Spotting 

Prepare a sample solution by diluting the sample in deionized water 
to a concentration of <0.1 pmol/µL. 

IMPORTANT! Do not dilute a sample in an organic solvent. Organic 
solvents dissolve the matrix applied to the sample plate.

Preparing Internal Standards

If you require mass accuracy greater than the accuracy provided by 
external calibration, use an internal standard. 

Add two standards of known molecular weight to the sample 
solution. Use standards that:

• Closely bracket the molecular weight of your unknown
• Can be easily distinguished from the unknown

As a starting point, use an internal standard concentration in the same 
range as your sample concentration. Because an internal standard can 
affect the intensity of the sample signal, prepare sample with several 
different internal standard concentrations.
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Selecting an Insert
The 4800 MALDI TOF/TOF™ Analyzer accepts stainless steel 
8 × 12 cm (3 × 5 in) holders that are fitted with inserts. 

The reusable holder and single-use insert design provides an 
inexpensive sample plate format that eliminates sample carryover 
and provides a convenient format for archiving sample plates for 
additional analysis.

Before spotting the insert, always use dry, 
compressed gas to blow off any fibers that may be on the insert. Take 
precautions during spotting to reduce the exposure of the insert to 
fibers. Fibers on the insert can be transferred to the ion optics 
components during sample acquisition and severely inhibit 
sensitivity. 

Table 3-13 summarizes the available inserts and corresponding plate 
types and spot set templates to enter in the 4000 Series 
Explorer™software. For part numbers, see Appendix B, “Spare 
Parts.”

Table 3-13 Insert types and their corresponding plate types and spot set templates

Insert Name Description

4000 Series Explorer™ Software

Plate Type Name Spot Set Template 
Name

Opti-TOF™ 96-well 
insert, 123 × 81 mm

Etched with 96 sample 
spots and 13 CAL 
spots

96 Opti-TOF 
123 × 81mm Rev A

96 Opti-TOF 
123 × 81 mm Rev A

Opti-TOF™ 384-well 
insert, 123 × 81 mm

Etched with 
384 sample spots and 
13 CAL spots

384 Opti-TOF 
123 × 81mm Rev A

384 Opti-TOF 
123 × 81 mm Rev A

Opti-TOF™ Cal Mix 5 
Calibration insert, 
123 × 81 mm

Spotted with 
384 spots of Cal Mix 5, 
etched with 8 CAL 
spots

Blank 3 × 5 Cal Mix 5 Calibration 
384 Opti-TOF 
123 × 81 mm Rev A
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Adapting 4700
Inserts or Plates

You can use the 4700 Proteomics Analyzer inserts or 2 × 2 in plates 
with a specially designed holder (see Appendix B). Use Blank 
3 × 5 in as the Plate Type name and create your own spot set template 
(see the 4000 Series Explorer™ Software Online Help, “Creating Spot 
Set Templates”).

IMPORTANT! Before reusing a 2 × 2 in plate, ensure that the plate 
was cleaned using the MALDI Plate Cleaning Kit for Stainless Steel 
or Gold Plates to restore the hydrophobicity. Hydrophobicity 
minimizes sample spreading and pooling of samples. Follow the 
instructions provided with the kit.

Opti-TOF™ Mass 
Standards 
Calibration insert, 
123 × 81 mm

Spotted with 
384 spots of five 
different Cal Mixes, 
etched with 8 CAL 
spots

Blank 3 × 5 Mass Standards 
Calibration 384 Opti-
TOF 123 × 81 mm 
Rev A

Opti-TOF™ 
LC/MALDI insert, 
123 × 81 mm

Blank insert with 
8 etched CAL spots
for LC-MALDI and for 
use with the thin-layer 
spotting technique

Blank 3 × 5 LC 384 PROBOT 
(use as is with 
corresponding default 
Probot template.)

LC 384 2 
Chromatogram 
Examples 
(use as an example to 
follow when creating 
your own template)

Table 3-13 Insert types and their corresponding plate types and spot set templates

Insert Name Description

4000 Series Explorer™ Software

Plate Type Name Spot Set Template 
Name
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Spotting Samples and Matrix

Guidelines

Handling Inserts
and Sample

Plates

To help reduce contamination of your analysis:

• Start with a clean insert. If you use the 4700 2 × 2 in. plate, 
clean the plate using the MALDI Plate Cleaning Kit.

• Use powder-free gloves.
• Handle the insert and sample plate by the edges.

Before and after spotting an insert, always use dry, 
compressed gas to blow off any fibers that may be on the insert. Take 
precautions during spotting to reduce the exposure of the insert to 
fibers. Fibers can be transferred to the ion optics components during 
sample acquisition and severely inhibit sensitivity. 

IMPORTANT! For sample and matrix handling, use high-quality 
plastic pipette tips, vials, tubes, and trays. Lower-quality 
consumables are likely to lead to extraneous peaks caused by 
plasticizers and other potential contaminants. (Lower-quality 
consumables also may cause high peptide loss due to adsorption of 
the peptides to the plastic.) If you detect extraneous peaks, try 
prewashing the consumables with the same solvent used in your 
sample or matrix.
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Spotting
Guidelines

• Use finely tapered pipette tips to dispense sample and matrix on 
the sample plate. Tips with blunt ends do not easily dispense the 
small volumes used for spotting.

• Spot the insert, allow the spots to dry, then place the insert in the 
holder.

• For optimum mass accuracy when spotting blanks inserts, do not 
spot the outer edges of the insert. Be sure the sample spots are 
no closer to the edge than the etched calibration spots.

• When spotting matrix, use the supernatant, not the precipitate.
• Do not touch the tip of the pipette to the surface of the sample 

well or the sample spot. Touching can cause uneven 
crystallization.

Note: If you spot synthetic polymer samples and use the thick-
layer polymer method, you need to touch the pipette tip to the 
insert. For more information, see “Selecting a Spotting 
Technique” on page 3-3.

• Try to spot the sample in the center of the sample position. For 
Automatic data collection, the plate is aligned so that the laser 
beam strikes the center of the sample position. If the sample is 
not in the center of the well, some laser shots may not strike the 
sample, and data quality may be reduced. You can position the 
sample with respect to the laser shot in Manual control, using 
the control pad.

• To ensure good crystallization, if you use a welled plate, fill the 
entire well, if possible, especially if acquiring in Automatic 
control. Surface tension and sample availability may determine 
whether or not you can fill the well completely.

• If the sample solution contains organic solvents, try to spot 
smaller volumes (0.5 µL or less). Some organic solvents such as 
methanol, acetone, and THF spread very easily on metal 
surfaces.

• Make sure the sample is evenly applied to the spot.
• To ensure good crystallization, mix sample solution and matrix 

solution before spotting, if possible. 
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Spotting Sample and Matrix Using the Dried-Droplet Spotting 
Technique

1. Using a clean pipette tip for each new sample, mix and/or spot 
the sample and matrix as described below:

Mixing Method Procedure

No mixing. Overlaying the 
sample and matrix solutions.

Note: If your sample is highly soluble in the matrix, spot the 
matrix first.

1. Spot 0.5 to 1 µL of sample solution on the plate. (Make sure 
the concentration is appropriate to yield the necessary final 
sample concentration, as listed in Table 3-3 on page 3-10.) 

2. Allow the sample spot to dry.

3. Spot the same volume of matrix solution on top of the dried 
sample spot. 

Mixing on the sample plate

IMPORTANT! When 
mixing directly on the plate, 
you may need to increase 
the concentration of organic 
in the matrix solution. With 
the 1:2 dilution used in this 
strategy, the typical 
concentration of organic 
may not be high enough to 
keep the matrix in solution.

1. Spot 0.5 to 1 µL of sample solution on the plate. (Make sure 
the concentration is appropriate to yield the necessary final 
sample concentration, as listed in Table 3-3 on page 3-10.) 

Note: Applying the sample solution before the matrix solution 
prevents the matrix from drying before it mixes with sample.

2. Spot the same volume of matrix solution. 

3. Use the pipette to mix by aspirating and dispensing the 
solution one to two times. (A homogeneous mixture is 
critical for good crystallization.)
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2. Dry the sample plate. When using CHCA, allow the sample 
plate to dry for at least 5 minutes. Preparations with high water 
or salt content may require longer to dry.

3. Visually examine the sample spots to make sure they are dry. 

IMPORTANT! If you load the sample plate into the 
4800 MALDI TOF/TOF™ Analyzer before the plate is dry, the 
pressure in the sample loading chamber rises, and an error 
message may be displayed.

4. Place a protective cover over the plate until you are ready to load 
the plate. Do not allow the cover to touch the surface of the 
plate.

Before loading the plate in the instrument, always 
use dry, compressed gas to blow off any fibers that may be on the 
plate. Fibers on the plate can be transferred to the ion optics 
components during sample acquisition and severely inhibits 
sensitivity. 

Premixing in tube 1. In a microcentrifuge tube, dilute the sample solution 1:10 
with matrix. 
For example, for peptides and proteins, mix 1 µL of sample 
solution (previously diluted to a concentration of 10 fmol/µL 
to 10 pmol/µL) and 9 µL of matrix solution in a 
microcentrifuge tube, for a final concentration of 1 fmol/µL 
to 1 pmol/µL. Mix gently.
For other compounds, make sure the initial concentration of 
sample solution yields the appropriate final sample 
concentration (see Table 3-3 on page 3-10) when mixed 
with matrix solution in a 1:10 dilution.

Note: If the sample concentration is too high, the sample 
signal may be suppressed. If the sample concentration is too 
low, sample signal may be absent.

2. Spot 0.5 to 2 µL of sample/matrix solution on the 
appropriate position. Volume depends on the well size of 
the sample plate you are using.

 Preparing sample with 
ZipTips®

Spot 0.5 to 2 µL of sample/matrix solution on the appropriate 
position.

Mixing Method Procedure
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Spotting Sample and Matrix Using the Thin-Layer Spotting 
Technique

IMPORTANT! When using the thin-layer spotting technique for high-
throughput applications, use one of the following methods to avoid 
burning through the sample:

• If acquiring using manual control, move the sample plate 
after every 5 to 10 laser shots. 

• If acquiring using automatic control, edit the acquisition 
method. In the Spectrum tab, set the Shots/sub-spectrum 
low (typically less than 20). In the Automatic Control tab, 
select Move before every sub-spectrum (pass or fail) for the 
Sample Stage Mode.

Spotting Matrix
and Sample

To spot matrix solution and sample solution using the thin-layer 
technique:

1. Dispense 0.5 µL of matrix solution prepared for thin-layer 
spotting technique on the sample plate to form a thin-layer. It 
dries in seconds. For information on preparing matrix solution 
for thin-layer spotting, see “Preparing CHCA Matrix for the 
Thin-Layer Spotting Technique” on page 3-12.

2. Spot 0.5 to 1 µL of the sample solution in each sample 
position onto the thin matrix layer applied in step 1. 

3. Dry the sample plate with gentle air flow, such as a heat gun set 
at low heat and air-flow settings.

4. After drying, spot 2 to 3 µL of double-distilled water on top of 
each dried sample to wash the sample. 

5. Wait 5 seconds, and blow off the water droplet with compressed 
air. 

6. Repeat step 4 and step 5 two more times.

7. Place a protective cover over the plate until you are ready to load 
the plate. Do not allow the cover to touch the surface of the 
plate.

Before loading the plate in the instrument, always 
use dry, compressed gas to blow off any fibers that may be on the 
plate. Fibers on the plate can be transferred to the ion optics 
components during sample acquisition and severely and adversely 
affect sensitivity. 



DRAFT
October 26, 2004 4:05 pm, 4800HWGuide_Ch3.fm

Chapter 3 Preparing and Spotting Sample and Matrix

3-42 4800 MALDI TOF/TOF™ Analyzer Hardware Guide

Examining Crystals on Sample Plates

Overview Proper crystallization is necessary to acquire high quality data. 
Ideally, you want small crystals that are evenly distributed in the 
sample well.

Clumped matrix crystals interfere with efficient 
data acquisition. Clumping can require varying laser intensity across 
a sample position and decrease mass resolution. In MS/MS mode, 
clumping may cause inaccurate timing of the Timed Ion Selector and 
yield poor precursor selection. 
You can view crystallization structure of sample and matrix:

• Under a microscope, at a magnification of 30✕. 
• In the Video Viewer in the 4000 Series Explorer™ software.

CHCA Matrix Figure 3-1 illustrates good patterns of crystallization for CHCA and 
sinapinic acid matrices.

Figure 3-1 Microscopic view of sample spots with CHCA and 
sinapinic acid matrices

With good crystallization, you see small, equally-sized crystals that 
are evenly distributed on the plate. Clumping is not desirable. 
Clumped crystals with CHCA or sinapinic acid may indicate one or 
more of the following:

• Matrix concentration is too high
• Organic concentration is too high
• Sample plate was dried too quickly
• Sample contains contaminants

PB100265

CHCA Sinapinic acid
Rounded Rhomboid-shaped



DRAFT
October 26, 2004 4:05 pm, 4800HWGuide_Ch3.fm

Examining Crystals on Sample Plates

4800 MALDI TOF/TOF™ Analyzer Hardware Guide 3-43

IMPORTANT! You can acquire data from a spot that does not have an 
ideal crystallization pattern. However, when a sample spot contains 
unevenly distributed crystallization, it may be difficult to acquire 
quality data. For best results, acquire data in Interactive mode, using 
the Video Viewer and manually selecting the area of the spot with the 
best crystallization pattern. For information, see the 4000 Series 
Explorer™ Online Help, Acquiring Data from the Video Viewer.

3HPA, THAP,
DHB, and sDHB

Matrices

Typical appearances of other matrices under magnification are shown 
in Figure 3-2 and Figure 3-3. 

When analyzing 3-HPA crystals, aim the laser at the base of the fan-
like crystals for best response. 

Figure 3-2 Microscopic view of sample spots with 3-HPA and 
THAP matrices

Figure 3-3 Microscopic view of sample spots with DHB or sDHB 
matrix

3 HPA THAP
PB100508PB100509

Needles in fan-like arrangement 
around outer edge of sample well

Overlapping shingles, 
nonuniform shape

PB100511

DHB dried under vacuum
milky amorphous

DHB or sDHB, air-dried,
irregular crystals in ring

Select 
this 
area
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Loading Sample Plates

 Before mounting a plate in the instrument, always 
use dry, compressed gas to blow off any fibers that may be on the 
insert or plate. Fibers on the plate can be transferred to the ion optics 
components during sample acquisition and severely inhibit affect 
sensitivity. 

Note: If you load the sample plate into the 4800 MALDI TOF/TOF™ 
Analyzer before the spots on the plate are dry, the pressure in the 
sample loading chamber rises, and an error may be displayed in the 
4000 Series Explorer™ software. Wait a few minutes for the chamber 
to reach vacuum before starting an acquisition.

To load a sample plate:

1. Open the sample loading chamber (Figure 3-4).

Figure 3-4 Sample loading chamber

2. If a sample plate is on the eject pad (left side), remove it.

3. Place the sample plate on the load pad (right side), with the 
notched corner of the plate at the front left, and the notched edge 
of the plate against the pins on the front of the load pad 
(Figure 3-5).

Load pad Eject pad
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Figure 3-5 Loading a sample plate

4. Close the sample loading chamber.

PHYSICAL INJURY HAZARD. Fingers 
can get caught in the plate loading mechanism. To avoid injury, 
do not click Load when the sample loading chamber is open.

5. Select the plate you want to load by doing one of the following:
• Scan the bar code on the bottom of the plate using the 

optional handheld bar code scanner.
• Select the spot set corresponding to the plate in the Select 

Spot Set dialog box, then click Select. 
• In the Select Spot Set dialog box, click Manual Bar Code. 

Then, enter the bar code number in the Manual Bar Code 
dialog box, then click OK.

The Load Sample Plate dialog box opens, displaying the plate 
and spot set information for the plate you selected.

Position 
plate 
against 
pins

Notched edge Pins
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6. Click Load in the Load Sample Plate dialog box. The following 
occur:

• A Load/Eject Cycle Status message box displays hardware 
status during the load sequence.

• The sample loading chamber is pumped down.
• High voltage is turned off. 
• If a sample plate is in the main source chamber, it is moved 

out of the source chamber into the sample loading chamber, 
and is placed on the eject pad.

• The new sample plate is loaded from the load pad into the 
main source chamber.

• The sample loading chamber is vented.

Note: You can use the Load Inventory function to prepare a second 
sample plate to be loaded without ejecting the plate in the main 
source chamber. You can then create and submit spot set jobs for both 
plates. Once all jobs for the first plate have been completed, the 
second plate is automatically loaded. 

For information on instrument tuning, the instrument process, and 
using the 4000 Series Explorer™ software, see the 4000 Series 
Explorer™ Software Online Help and the 4800 MALDI TOF/TOF™ 
Analyzer Getting Started Guide.
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Overview
This chapter describes potential problems and corrective actions for 
the 4800 MALDI TOF/TOF™ Analyzer, the bar code scanner, and 
the database. 

If you cannot solve a problem using the information in the following 
tables, contact Applied Biosystems/MDS SCIEX Technical Support (see 
“How to Obtain Support” on page x).

4800 MALDI TOF/TOF™ Analyzer Troubleshooting
The following table lists symptoms and their related causes and 
actions. 

Table 4-1 Hardware troubleshooting

Symptom Possible Cause Action

System does not power on 
when the main power switch is 
on.

The other main power switch is 
off. For the instrument to power 
on, both switches must be on.

Turn on the main power switch 
on the other side of the system. 

Cannot start 4000 Series 
Explorer™software due to a 
database connection error

The Computer Name was 
changed without the Oracle 
database being reconfigured

Reconfigure the Oracle 
database:

1. Restart the computer.

2. Select Start > Run.

3. In the Run dialog box, click 
Browse, then navigate to 
C:\WINNT\SYSTEM32\ 
ChangeWSName.cmd or 
.vbs.

4. Click Open.
When a screen flashes 
briefly on the computer 
screen, the reconfiguration 
is complete.

Cannot turn on high voltages An acquisition method is not 
open

Open an acquisition method.

Hardware error occurred Reinitialize the hardware.
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High whining sound when you 
power on the mass 
spectrometer

Normal startup operation of the 
turbo pump

No action. Normal occurrence. 
Before using the instrument, 
allow the vacuum pressures to 
stabilize.

In Automatic control, center of 
sample position is not aligned 
with laser spot, as observed in 
the Video Viewer window

Sample plate not aligned Align the sample plate. See the 
4000 Series Explorer™ Software 
Online Help.

The Video Viewer window is 
black.

The light source is set to 
Automatic Power-Off when Idle 
and the idle time has expired.

 See “High-Voltage, Laser, and 
Light Configurations”, step 6 on 
page 2-13.

Default settings have been lost. Reset the default settings:

• Right click on the Video 
Viewer

• Select Configure
• Select Defaults

Buttons on the Control Pad do 
not change laser intensity

The system is in Automatic 
control, and Fixed laser 
intensity is not selected 

Select an acquisition method 
that specifies Manual control 
or Automatic control with 
Fixed laser intensity 
(Instrument tab)

or

Verify that the acquisition 
method is the active acquisition 
method. In the Acquisition 
Method dialog box, select the 
Spectrum tab, then select 
Manual control or Automatic 
control with Fixed laser 
intensity. 

Cracking sound in mass 
spectrometer

Arcing caused by faulty 
electronic components, PCBs, 
or cables

Shut down the high voltages. 
Do not use the instrument or 
restart the computer or 
software. 

Contact Applied Biosystems/
MDS SCIEX Technical Support.

Table 4-1 Hardware troubleshooting (continued)

Symptom Possible Cause Action
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TC foreline vacuum pressure 
remains high after start up.

Roughing pump is off. If necessary, turn on the 
roughing pump.

TC foreline vacuum pressure 
fluctuates.

Roughing pump is 
malfunctioning.

Check the pump oil level (see 
Figure 5-2 on page 5-6). 

If necessary, contact Applied Biosystems
/MDS SCIEX Technical Support.

Instrument-ERROR is 
displayed- in the Status bar at 
the bottom of the 4000 Series 
Explorer™ software

Hardware error occurred Reinitialize the hardware. See 
“Reinitializing Hardware” on 
page 5-3.

Vacuum over pressure Vacuum leak Contact Applied Biosystems/ 
MDS SCIEX Technical Support.

Gauge fault Reinitialize the hardware. See 
“Reinitializing Hardware” on 
page 5-3.

Turbo pump pressure is out of 
range

If necessary, turn the roughing 
pump on. Wait for turbo 
pressure to come within range. 

If the turbo pressure remains out of
range, contact Applied Biosystems/
MDS SCIEX Technical Support.

BA gauge is off

System-wide problem with 
timed events

Time on the computer clock 
changed from International 
English to European format

Reset Regional Settings to 
English (United States). If 
necessary, reset the Time 
format to h:mm:ss tt. Exit and 
restart the 4000 Series 
Explorer™ software.

Time on the computer clock 
was updated while the software 
was running

IMPORTANT! When updating 
the computer Date/Time 
properties, be sure to exit the 
4000 Series Explorer™ software 
first.

Exit and restart the 4000 Series 
Explorer™ software. 

Table 4-1 Hardware troubleshooting (continued)

Symptom Possible Cause Action
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Light source stays on Automatic Power-Off is 
disabled

When Automatic Power-Off is 
disabled, you can not shut off 
the light source (see “High-
Voltage, Laser, and Light 
Configurations” on page 2-11).

Table 4-1 Hardware troubleshooting (continued)

Symptom Possible Cause Action
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Handheld Bar Code Scanner Troubleshooting
LASER HAZARD. Class 2 (II) lasers can cause 

damage to eyes. Avoid looking into a Class 2 (II) laser beam or 
pointing a Class 2 (II) laser beam into another person’s eyes.

Table 4-2  Bar Code Scanner troubleshooting

Symptom Possible Cause Action

Scanner does not work. Poor connection. Check the connections 
between the bar code 
scanner and the computer.

Com port not set Set the com port. Refer to 
“Setting Bar Code 
Preferences” on page 2-8.

Scanning is inconsistent. Bar code label on the
MALDI plate is dirty, 
scratched or damaged.

Check that barcoding is 
working properly by scanning 
the bar code on a source 
plate. If scanning is working 
properly, use a different 
MALDI plate, or type in the 
bar code instead of scanning.

If scanning is not working 
properly, contact Applied 
Biosystems/MDS SCIEX 
Technical Support.

The scanner holder height 
may need adjusting.

Adjust the height of the bar 
code scanner holder to 
between 20 and 25 cm (8 and 
10 in.) For information, see 
the Handheld Bar Code 
Scanner Installation Guide.

Scanner does not work when 
mounted in the holder.

Scanner is incorrectly 
inserted in the holder (trigger 
is not depressed).

Reinsert the scanner in the 
holder.

AutoSense® Stand Mode is 
disabled.

Reenable AutoSense Stand 
Mode. Refer to the 
QuickScan® 6000/6000plus 
AutoSense® Stand 
Instructions.
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Database Computer Troubleshooting
Table 4-3 Database computer troubleshooting

Symptom Possible Cause Action

Noticeably slower 
4800 instrument performance.

Database is too full. Purge unneeded spot sets.

If performance remains slow after
purging, contact Applied Biosystems/ 
MDS SCIEX Technical Support.

Computer files are fragmented. Have your system administrator 
defragment the hard drive.

When restoring an archived 
spot set that was created on 
one (source) 4800 instrument to 
another (target) 4800 
instrument, an error message 
appears similar to: "Error 
step 4.5: check Method - Failed 
- See rest_0000000300.log for 
details".

The database on the target 
4800 instrument does not 
contain the identical operating 
mode name that the archived 
spot set used when it was 
created on the source 4800 
instrument. 

For example, the source 
4800 instrument used an earlier 
4000 Series Explorer™ software 
version that included 
discontinued operating modes, 
or a custom operating mode 
was used on the source 4800 
instrument.

1. From the 4000 Series 
Explorer™ software on the 
source 4800 instrument, 
select File > Open > 
Operating Mode.

2. Record all operating modes 
listed in the Open Operating 
Mode dialog box.

3. Repeat steps 1 and 2 at the 
target 4800 instrument, 
noting any operating modes 
that are not listed in the 
Open Operating Mode 
dialog box on the target 
4800 instrument.

4. From the 4000 Series 
Explorer™ software on the 
source 4800 instrument, 
export only those operating 
modes that do not appear 
on the target 4800 
instrument. See the 
4000 Series Explorer™ 
Software Online Help, 
"Exporting XML Files".
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When restoring an archived 
spot set that was created on 
one (source) 4800 instrument to 
another (target) 4800 
instrument, an error message 
appears similar to: "Error 
step 4.5: check Method - Failed 
- See rest_0000000300.log for 
details".(continued)

5. From the 4000 Series 
Explorer™ software on the 
target 4800 instrument, 
import the missing operating 
modes. See the 4000 Series 
Explorer™ Online Help, 
"Importing XML Files".

6. Repeat the steps to restore 
the archived spot set.

Table 4-3 Database computer troubleshooting (continued)

Symptom Possible Cause Action
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Shutting Down and Starting Up

Do not exit the 4000 Series Explorer™ software or 
power off the 4800 MALDI TOF/TOF™ Analyzer unless you need to 
perform maintenance or move the system. 
After you exit the software, you cannot control the analyzer. Exiting 
the software also powers off high voltages, which can require up to 
three hours of warm up when you restart the software. 
Powering off shuts down the vacuum pumps and causes the system to 
vent. If you need to exit the software or power off the 4800 MALDI 
TOF/TOF™ Analyzer for maintenance or moving, see “Starting and 
Exiting the 4000 Series Explorer™ Software” on page 2-2.

Before You Begin During the start up procedure, you are prompted for a User Name and 
Password. See your system administrator for your User Name and 
Password.

Shutting Down To shut down the 4800 MALDI TOF/TOF™ Analyzer:

1. Make sure that high voltages are off, the Batch Queue is 
stopped, and the CID system is off.

2. Exit the 4000 Series Explorer™ software by selecting 
File > Exit. The 4000 Series Explorer™ software closes.

3. On the Windows® XP desktop, click Start > Shut Down. 

4. In the Shut Down windows dialog box, click Shut down, then 
click OK. 

5. After a message is displayed, power off the monitor and printer. 
Power off the main power switch, on the left side panel of the 
instrument, to the right of the power cord.
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Starting Up To start up the 4800 MALDI TOF/TOF™ Analyzer:

1. Power on the main power switch, on the left side panel of the 
instrument, to the right of the power cord. 

IMPORTANT! Both main power switches (one on the left side 
panel and one on the right side panel) must be in the ON 
position for the instrument to power on. You can power off the 
instrument using either switch.

The hardware starts to initialize. The roughing pump starts. 
After approximately 10 minutes, the turbo pumps start. You hear 
a subtle whine as the vacuum pumps spin up to speed. 

After venting, it can take up to 24 hours for the system to reach 
adequate vacuum.

2. Power on the computer monitor and printer. Log on using your 
User Name and Password.

3. Start the software by double-clicking  on the Windows® 
XP desktop. 

The software initializes and prepares the hardware for 
acquisition. 

Reinitializing
Hardware

The 4800 MALDI TOF/TOF™ Analyzer hardware automatically 
starts to initialize when you start the software. 

You need to reinitialize the hardware if a hardware error occurs, 
indicated in the software status bar (“Status Bar” on page 2-5) by 
Instrument-ERROR. 

To reinitialize the hardware, select Instrument > Reinitialize.

Note: You cannot reinitialize hardware from the Remote Access 
Client.

If reinitializing does not work, restart the computer. If restarting the 
computer does not work, contact Applied Biosystems/MDS SCIEX
Technical Support. See “How to Obtain Services and Support” on page xii.
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Maintaining the System

Planned Maintenance

Regular planned maintenance helps to keep your 4800 MALDI 
TOF/TOF™ Analyzer functioning properly. Perform the following 
procedures as indicated:

Maintenance Log The maintenance log (Appendix G) includes a log sheet for you to 
copy and use to track maintenance on your 4800 MALDI TOF/TOF™ 
Analyzer. 

Task When to Perform Procedure 
(page)

Drain oil from the roughing pump mist filter Every month 5-5

Check roughing pump oil level. If the oil 
level is low, contact Applied Biosystems/
MDS SCIEX Technical Support (see “How to 
Obtain Support” on page x).

Every month 5-5

Clean the large and small fan filters Every 3 months 5-2

Hardware maintenance performed by an 
Applied Biosystems/MDS SCIEX service 
representative.a 

Every 6 months NA

Archive and/or purge spot sets As needed to manage your data storage 
space. To ensure good system 
performance, archive and purge spot 
sets when less than 20% of the 
database space is free.

5-16

Back up database On a regular basis. If a backup has not 
been performed in a week, the 
4000 Series Explorer™ software 
displays a reminder.

5-20

a. Contact Applied Biosystems/MDS SCIEX for information on service contracts for planned maintenance.
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Hardware Maintenance Procedures

Roughing Pump The roughing pump (see “Vacuum Pumps” on page 1-17) is equipped 
with an oil mist filter to capture oil residues in the pump exhaust. The 
collected oil must be drained periodically.

Figure 5-1 Oil mist filter on the 4800 instrument rear panel

To drain the oil mist filter and check the pump oil level:

1. Shut down the system as described in “Shutting Down and 
Starting Up” on page 5-2.

2. If necessary, move the system so you have access to the rear 
panel (Figure 5-1).

3. Check the oil mist filter gauge (Figure 5-2).

4. If the gauge indicates the presence of oil, place a waste container 
under the stopcock. Open the stopcock to drain the accumulated 
oil. Close the stopcock. 

5. Carefully clean up any oil residues. Discard the cleaning 
materials and oil in accordance with federal, state, and local 
laws.

6. Remove the rear lower panel.

Lower rear panel

Gauge

Stopcock
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7. Check the roughing pump oil gauge (Figure 5-2). If the oil level 
is low, contact Applied Biosystems/MDS SCIEX Technical 
Support (see “How to Obtain Support” on page x). The oil level 
should be between the visible arrows that indicate the maximum 
and minimum acceptable levels.

8. Reinstall the rear lower panel.

9. Start up the instrument as described in “Shutting Down and 
Starting Up” on page 5-2.

Figure 5-2 Roughing pump oil gauges

Pump oil
gauge

Maximum
pump oil

level arrow

Minimum
pump oil

level arrow
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Fan Filters Clean the fan filters every 3 months. Dirty fan filters may inhibit 
adequately cooling, leading to temperature increases which can cause 
electronic failures.

To clean the fan filter:

1. Shut down the system as described in “Shutting Down and 
Starting Up” on page 5-2.

2. If necessary, move the system so you have access to the rear and 
right panels.

Figure 5-3 Fan locations

 3. For the one large fan on the right panel, remove the large fan filter 
cover, then remove the filter (see Figure 5-4).

The large fan is 
on the right panel

Small fans are on 
the rear panel.
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Figure 5-4 Removing the large fan filter cover and filter

1. For the two small fans on the upper rear panel, remove the small 
fan covers (hard plastic piece) and filters (Figure 5-5).

Figure 5-5 Removing the small fan filter cover and filter

GR2445

4800

Filter assembly

G
R

2
4

4
5

Right panelFan filterFan cover

��������
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2. Clean the filters under running water and allow to dry.

Note: If you prefer to replace a filter with a new filter, see 
Appendix B, “Spare Parts,” for the part number to order.

3. Reinstall the filters and filter covers. Position the large filter 
such that the air flow arrow points toward the inside of the 
instrument (see Figure 5-4 on page 5-8).

4. Start up the system as described in “Shutting Down and Starting 
Up” on page 5-2.
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Reconnecting the Hardware

Overview The 4800 MALDI TOF/TOF™ Analyzer is installed by an 
Applied Biosystems/MDS SCIEX service engineer. If you need to 
move the 4800 MALDI TOF/TOF™ Analyzer, the following sections 
describe how to reconnect the hardware. 

Figure 5-6 Connections on the left side of the instrument

Before disconnecting and moving the instrument, 
shut down the instrument as described in “Shutting Down and 
Starting Up” on page 5-2.

Ethernet cable connection to 
the computer

Instrument power
cord to 20 A

receptacle

CID gas connection

Main power On/Off 
switch

Instrument-to-computer 
cable connectionInstrument-to-computer

(cable connections A, B, C)

Instrument-to-computer
(cable connection D)
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Figure 5-7 Instrument connections on the computer

Instrument Power
Connection

Plug the 4800 MALDI TOF/TOF™ Analyzer power cord (on the left 
of the instrument) into a 20 A receptacle. This provides power for 
both the mass spectrometer and the internal computer.

Roughing Pump
Power

Connection

Plug the roughing pump power cord (on the rear of the instrument) 
into a 15 A receptacle.

Motion (Ethernet)

Communications
connection

Digitizer trigger,
Reflector detector,

Linear detector

Video camera

Flat panel monitor
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Connecting
Collision Gas

Connect the collision-induced dissociation (CID) gas to the GAS 
connectors on the left side of the mass spectrometer using the 
provided Teflon® tubing (1/8-inch O.D., 1/16-inch I.D.). Adjust the 
pressure gauge on the gas cylinder up to 5 PSIA.

PHYSICAL HAZARD. Nonflammable 
compressed gas (such as nitrogen and other gases used as 
collision gas). Contents are under pressure. Receive proper training 
on the handling of compressed gases before use. Exposure to rapidly 
expanding gas may cause frostbite. High concentrations of vapors in 
the immediate area can displace oxygen and cause asphyxiation. Use 
only in areas with adequate ventilation. Read the MSDS, and follow 
the handling instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

Do not set the gas pressure above 5 PSIA. Doing 
so can damage the CID system.

Connecting
Computer

Components

Monitor – Plug the monitor into a standard wall receptacle. The 
monitor cable connects to the VGA connector on the rear of the 
computer (Figures 5-9).

Figure 5-8 Monitor connector

Double
connector on

the rear on the
computer
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Figure 5-9 Computer component connections

Keyboard – Connect to the keyboard connector on the rear of the 
computer.

Remote Mouse – Connect the mouse receiver to one of the two USB 
connectors on the rear of the computer.

Control Pad – Connect the Control Pad (Figure F-1 on page F-2) 
cable to one of the two USB connectors on the rear of the computer.

Connecting a
Printer

Connect an optional printer to the PRINTER connector (25-pin 
D-connector) or a USB connector on the computer. 

Connecting to a
Network

Connect one end of the provided RJ-45 cable to the NETWORK 
connector on the rear panel of the computer. Connect the other end to 
your LAN connection. Avoid connecting to the motion connector (see 
Figure 5-7 on page 5-11).

Keyboard

Your LAN

Mouse/control pad

Monitor

Printer
25-pin D-connector
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Connecting
Exhaust to Hood

If you operate the 4800 MALDI TOF/TOF™ Analyzer in a clean 
room environment, you can vent the exhaust to a hood using PVC 
tubing (1/4-inch I.D., 3/8-inch O.D.). Connect the tubing to the 
exhaust connector on the oil mist filter on the rear panel of the 
4800 MALDI TOF/TOF™ Analyzer (Figure 5-10).

Figure 5-10 Exhaust connector at rear of the 4800 MALDI 
TOF/TOF™ Analyzer

Connecting the
Handheld Bar
Code Scanner

For information on connecting the optional handheld bar code 
scanner, see the Handheld Bar Code Scanner Installation Guide.

Exhaust 
connector
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4000 Series Explorer™ Database Maintenance
Data archive, restore, back up, and recovery tools let you:

• Archive and/or purge selected spot sets, including associated job 
and user information, sample information, raw spectral data, 
associated methods, results, and peak lists. To ensure good 
system performance, archive and purge spot sets when less than 
20% of the database space is free.

• Restore selected spot sets, including associated job and user 
information, sample information, raw spectral data, associated 
methods, results, and peak lists if you need to access previously 
archived spot set data or transfer the data to another system.

• Back up the entire database on a routine basis. The importance 
of your data, how often you use your system, and how much data 
is stored or processed determine how frequently you should 
back up your system. At a minimum, consider backing up once 
per week.

• Recover the entire database in the event of a catastrophic failure. 
Perform a recovery (from your latest backup) only if you 
experience an unrecoverable failure (typically, a disk failure). 
Contact Applied Biosystems/MDS SCIEX Technical Support for 
recovery procedures.

• Migrate the database. Migration updates the database to make it 
compatible with the latest instrument software. Perform a 
migration only after the installation of a new version of 
4000 Series Explorer™ software.

Note: The 4000 Series Explorer™ Database Tools are not available 
on computers running 4000 Series Explorer™Software – Remote 
Access Client.
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Archiving/Purging Spot Sets
For optimal system performance, archive and/or purge spot sets from 
the database to an archive destination folder. Spot sets include 
associated job and user information, sample information, raw spectral 
data, associated methods, results, and peak lists.

IMPORTANT! Archive and purge spot sets when less than 20% of the 
database space is free. To view the current percentage of database 
utilization, select Help > About 4000 Series Explorer from the 
4000 Series Explorer™ software.

Before You Begin • If necessary, see your system administer for the purge password.
• Check the file size of the spot set(s) and estimate the time 

needed, generally 20 minutes to 40 minutes per gigabyte of file 
size.

• Next, make sure there are no remote users connected. You 
cannot use the 4000 Series Database Restore tool if the 
4000 Series Explorer™ software is running. After all remote 
users disconnect, save any unsaved data, then exit the 
4000 Series Explorer™ software.

Archiving/purging
spot sets

To archive and/or purge spot sets:

1. On the desktop taskbar, click Start> All Programs > 
AB 4000 Series Explorer > 4000 Series Database Tools.

2. In the 4000 Series Database Tools dialog box, click Archive.

3. In the 4000 Series Database Archive Tool dialog box, click 
Browse (to the right of Folder, Project, or Spot Set) to open the 
4000 Series Database Project Tree dialog box. 

4. Expand the Project tree as required to access the folder, project, 
or spot set that you want to archive. (You can archive a folder 
that contains projects and associated spot sets, a project that 
contains spot sets, or an individual spot set.) 

5. Click to select the desired folder, project, or spot set to be 
archived, then click OK. The selected item appears in the 
Folder/Project/Spot Set Name field.
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6. Unless lack of disk space requires that you archive to a different 
location, accept the default archive location (C:\Program Files\
Applied Biosystems\4000 Series Explorer\archive) displayed in 
the Destination Root Archive Folder box. 

To select a different archive location:
• Click Browse (to the right of Destination Root Archive 

Folder).
• In the Browse For Folder dialog box, navigate to and select 

the folder to use as a destination for the archive.
• Click OK. The selected folder name appears in the 

Destination Root Archive Folder field.

Note: If you are archiving to the default location (or any other 
location on the 4800 computer), it is good practice to 
periodically check the amount of free hard disk space. If free 
disk space is 10% or less, contact Applied Biosystems/MDS SCIEX 
Technical Support for suggestions to make more disk space available. 

7. Set options for the archive by selecting check boxes in the 
Options section. Depending on your selections, you can archive 
and purge, archive without purging, or purge without archiving.

• Archive – Copies the selected spot set data from the 
database to the archive destination folder.

• Overwrite Files in File System – Overwrites files that 
exist in the archive destination folder with identically 
named files. This check box is available only if the Archive 
check box is selected.

• Purge – Deletes unneeded selected spot set data (see 
step 4) from the database. If the Archive check box is also 
selected, spot set data are also archived to the archive 
destination folder. If the Archive check box is not selected, 
spot set data are deleted and not archived.

8. Click Start. If you selected the Purge check box, type the purge 
password, then click OK. The selected spot set data are archived 
to the archive destination folder and/or purged. The Status and 
Progress fields show the state of the ongoing archive. 
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9. A message appears when the archive is finished. Click Yes if 
you want to read the log file that lists the results of the archive. 

The log file is automatically created and saved to the following 
location:

C:\Program Files\Applied Biosystems\4000 Series Explorer\
Archive\Log.

The destination folder structure matches the folder structure in 
the 4000 Series database. Each spot set and its associated data 
are saved in a folder with the same name as the spot set. The 
spot set information is in a .dmp file.
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Restoring Spot Sets
Restore selected spot sets from an existing archive folder to the 
database on any 4000 Series computer with the same or later version 
of the 4000 Series Explorer™ software. Spot sets include associated 
job and user information, sample information, raw spectral data, 
associated methods, results, and peak lists.

Before You Begin • You cannot restore a spot set if an identically named spot set 
already exists in the 4800 system (the restore for that spot set 
fails). If both spot sets must exist in the system, rename the 
existing spot set before performing the restore.

• Check the file size of the spot set(s) and estimate the time 
needed, generally 20 minutes to 40 minutes per gigabyte of file 
size.

• Make sure there are no remote users connected. You cannot use 
the 4000 Series Database Restore tool if the 4000 Series 
Explorer™ software is running. After all remote users 
disconnect, save any unsaved data, then exit the 4000 Series 
Explorer™ software.

Restoring Spot
Sets

1. On the desktop taskbar, click Start > All Programs > 
AB 4000 Series Explorer > 4000 Series Database Tools.

2. In the 4000 Series Database Tools dialog box, click Restore.

3. Click Browse to open the 4000 Series Database Archive Files 
dialog box.

4. Navigate to the folder that contains your previously archived 
data.

5. Perform one of the following:
• To restore all spot sets in a project or folder, select the 

desired project or folder in the file selection box, then click 
Open Project/Folder. The project or folder name appears 
in the Folder/Project/Spot Set Name field.

• To restore a spot set, navigate to, then select the desired 
.dmp file (containing all spot set data) in the file selection 
box. The file name appears in the File Name field. Click 
Open. The spot set name and path to the project/folder 
appears in the Folder/Project/Spot Set Name field.
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6. Click Start. The selected spot sets and associated data are 
restored to the database. The Status and Progress fields show the 
state of the ongoing restore operation. A DOS window may 
appear briefly during the restore operation.

7. A message appears when the restore is finished. Click Yes if you 
want to read the log file that lists the results of the restore.

The log file (for example: rest_000010004.log)is 
automatically generated by the restore operation and is saved to: 

C:\Program Files\Applied Biosystems\4000 Series Explorer\
Archive\Log.

If necessary, see “Database Computer Troubleshooting” on 
page 4-7 for more information.

Backing Up the Database
Regularly back up the 4800 database to protect data and ensure that 
you can recover from any catastrophic system failure. Your backup 
schedule depends on how you use the system. For more information, 
see Backup Guidelines below.

You can back up the database:

• Automatically, by setting an automated backup schedule 
(recommended, see page 5-22)

• Manually, by running a backup any time one is required (see 
page 5-25)

Backup
Guidelines

Developing and following an effective backup schedule for your 
system ensures that you have a recent copy of your data in the event 
of a hardware failure or user error. Your backup schedule depends on 
how you use the system. High-volume or high-throughput workflows 
with daily generation of new data require frequent backups. A good 
question to ask when determining your backup schedule is "how 
much data can I afford to lose?" Whatever your backup schedule, 
keep in mind that:

• For good laboratory practices, develop a standard protocol for 
backing up, and enforce it consistently. It is good practice to 
schedule automatic backups.
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• If you do not back up daily, take into account the importance of 
your data and system usage (how much data is stored or 
processed) to determine how frequently you should back up your 
system. At a minimum, consider backing up once per week.

• Back up to a network drive or reusable media. Depending on the 
size of your database, the designated location for the backup 
must have 20 to 100 GB of free space.

IMPORTANT! If you back up to reusable media, rotate through 
three sets of backup media, overwriting the oldest set with the 
next backup. With three sets of backups, you always have at least 
one good copy if you should lose data.

• To view the percentage of 4000 Series database utilization, 
select Help > About 4000 Series Explorer (from the 
4000 Series Explorer™ software).

• If the 4800 MALDI TOF/TOF™ Analyzer computer displays 
warnings that database utilization is over 80%, perform an 
immediate backup, then archive and purge spot sets. 

• The 4000 Series Explorer™ Backup Tool temporarily backs up 
the database files to a folder on your hard drive, then copies the 
files to a network device. The free space required on both the 
local hard drive and the network device must be adequate for the 
size of your backup files. Depending on the size of your 
database and the amount of generated spectra and peak data, the 
free space requirement can range from 10 to 40 GB. See 
“Estimating Free Space” below to estimate the required free 
space (on the temporary location on the local hard drive and on 
the network device) for a backup.

Estimating Free
Space

Option 1
If you have performed daily backups, a recent backup is likely to 
reflect the size of your next backup (assuming similar 
4800 instrument run conditions). Navigate to the remote backup 
destination and observe the size of the TSQBackup.dmp and 
TSQBackup.log files. The total size of these files should 
provide a close estimate for the space required for your next 
backup. For more information on backup files, see “Files in the 
Backup Destination” on page 5-28.



DRAFT
October 26, 2004 4:05 pm, 4800HWGuide_Ch5.fm

Chapter 5 Maintenance

5-22 4800 MALDI TOF/TOF™ Analyzer Hardware Guide

Option 2

a. Start the 4000 Series Explorer™ software.

b. Select Help > About 4000 Series Explorer.

c. On the line that lists Percent Database Utilization, locate 
the value (in MB) for Used: 

d. Multiply the Used: value by 5. The result provides a safe 
estimate of the space required for your backup.

Backing Up the
Database

Automatically

To back up the database automatically:

1. On the desktop taskbar, click Start > All Programs > 
AB 4000 Series Explorer >4000 Series Database Tools.

2. In the 4000 Series Database Tools dialog box, click Backup.

3. In the Local Backup Directory Used for Temporary Storage 
field, select the folder to be used for temporary storage of the 
backup.

The software automatically (and temporarily) backs up the 
database to your selected folder, copies the backup to the remote 
backup drive (see step 4), then purges the data in the selected 
folder. This process provides the fastest backup possible.

Note: Unless a lack of disk space prevents you from doing so, 
select the default D:\Backup folder.

4. In the Remote Backup Directory Used for Archived Backups 
field, select the destination drive for the backups. The drive:

• Must be a writable network or removable drive with a 20 to 
100 GB capacity.

• Cannot be a local hard drive, a CD-ROM drive, a RAM 
drive, or an unmounted drive.

5. In the Maximum Number of Archived Backups field, enter the 
number of backups that you want to archive. For example, if you 
select the default (4), your fourth backup overwrites your first 
(oldest) backup in the folder. For more information on the 
backup files, see “Files in the Backup Destination” on 
page 5-28.

6. Click Schedule Auto Backup. The Scheduled Tasks dialog box 
opens.

7. Double-click Add Scheduled Task then use the Scheduled Task 
wizard to schedule an automatic backup. 
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8. When the Task tab opens, click to position the cursor at the end 
of the last quotation mark in the Run field. Type -R in the Run 
field. Figure 5-11 on page 5-24 shows how the updated Run 
field should appear.

Table 5-1 Scheduled Task wizard

Wizard
Page Action

First Click Next to continue.

Second a. Click Browse to select the program you want to run. The Select 
Program to Schedule dialog box opens.

b. Navigate to the following program: C:\Program Files\Applied 
Biosystems\4000 Series Explorer\Bin\TSQBackup.exe.

c. Make sure TSQBackup.exe is selected, then click Open. 

Third Select how often (weekly, for example) or at which event (when you log on, 
for example) you want to schedule the automatic backup, then click Next.

Fourth If you selected Daily, Weekly, Monthly, or One Time Only in the previous 
step, select a Start Time and any other scheduling details, then click Next.

Fifth a. In the User name field, type the name of the person who is to 
perform backups on the database. (This person must have network 
permissions on the Remote Backup Directory).

Note: If the 4800 MALDI TOF/TOF™ Analyzer computer is 
part of a domain, you must also enter the domain name in the 
User name field. Use the following format: Domain\User

b. Enter the Windows logon password for the user, confirm the 
password, then click Next.

Sixth Select Open advanced properties for this task when I click Finish, then 
click Finish.
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Figure 5-11 Run field

9. Click OK. 

10. In the Set Account Information dialog box, re-enter, then 
confirm the password you entered above, then click OK. The 
TSQBackup task appears in the Scheduled Task dialog box. 

11. Close the Scheduled Task dialog box. Your backup is scheduled 
to run automatically.
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Backing Up the
Database
Manually

To back up the database manually:

1. On the desktop taskbar, click Start > All Programs > 
AB 4000 Series Explorer >4000 Series Database Tools.

2. In the 4000 Series Database Tools dialog box, click Backup.

3. In the Local Backup Directory Used for Temporary Storage 
field, select the folder to be used for temporary storage of the 
backup.

The software automatically (and temporarily) backs up the 
database to your selected folder, copies the backup to the remote 
backup drive (see step 4), then purges the data in the selected 
folder. This process provides the fastest backup possible.

Note: Unless a lack of disk space prevents you from doing so, 
select the default D:\Backup folder.

4. In the Remote Backup Directory Used for Archived Backups 
field, select the destination drive for the backup. The drive:

• Must be a writable network or removable drive with a 
minimum capacity of 20 GB.

• Cannot be a local hard drive, a CD-ROM drive, a RAM 
drive, or an unmounted drive.

5. In the Maximum Number of Archived Backups field, enter the 
number of backups that you want to archive. For example, if you 
select the default (4), your fourth backup overwriting your first 
(oldest) backup in the folder. For more information on the 
backup files, see “Files in the Backup Destination” on 
page 5-28.

6. Click Start Backup Now. The database is first (temporarily) 
backed up to the Local Backup Directory on drive D, then 
copied to your specified backup drive.

After a successful backup, the data in the Local Backup Directory is 
automatically purged. If you want to view the results of the backup, 
navigate to the TSQBackup.log file in My Computer, then 
double-click the file.
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Recovering the Database

If you experience a catastrophic database or disk failure, recover the 
database using the 4000 Series Explorer™ Database Recover Tool 
and your latest backup. If you have any questions about performing a 
database recovery, contact Applied Biosystems/MDS SCIEX Technical 
Support before starting the recovery.

Before You Begin IMPORTANT! Recovering the database destroys all data currently on 
your 4800 MALDI TOF/TOF™ Analyzer database and replaces it 
with the data from your last backup. 

• Identify the last backup – Make sure that you can clearly 
identify the last backup before starting the recovery. For more 
information, see “Files in the Backup Destination” on 
page 5-28.

• Estimate the time needed – Check the file size of the spot 
set(s) and estimate the time needed, generally 20 minutes to 
40 minutes per gigabyte of file size. Restoring an archived spot 
set that was created on one (source) 4800 instrument to another 
(target) 4800 instrument can take twice as long as restoring to 
the source instrument.

• Make sure there are no remote users connected – You cannot 
use the 4000 Series Database Recover tool if the 4000 Series 
Explorer™ software is running. After all remote users 
disconnect, save any unsaved data, then exit the 4000 Series 
Explorer™ software.

• If necessary, import/export operating mode – When restoring 
an archived spot set that was created on one (source) 
4800 instrument to another (target) 4800 instrument, the 
database on the target 4800 instrument must contain the 
identical operating mode name that the archived spot set used 
when it was created on the source 4800 instrument. To import 
the operating mode, if necessary, see Table 4-3 on page 4-7, 
second item, action steps 1 through 6.

Recovering the
Database

To recover the database:

1. On the desktop taskbar, click Start> All Programs > 
AB 4000 Series Explorer > 4000 Series Database Tools.

2. In the 4000 Series Database Tools dialog box, click Recover. A 
warning dialog box opens.
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3. Read the statement in the warning dialog box, then click Yes to 
continue. The 4000 Series Database Recover dialog box opens.

4. Click Browse, then navigate to the remote folder where your 
backup is located.

5. Select your most recent backup, then click OK. 

Note: Unless you have changed the default backup file name, 
your most recent backup is named TSQBackup_01.dmp.

6. In the Password field, enter the recover password. (If necessary, 
see your system administrator for the password)

7. Click Start. The recovery starts and a DOS window opens for 
the duration of the recovery. 

IMPORTANT! Do not manually close, click on, or interact with 
the DOS window.

When the recovery finishes, the DOS window closes and the 
Status field displays a successful recovery message.

8. Click Close to close the 4000 Series Explorer™ Database 
Recover dialog box.

9. Start the 4000 Series Explorer™ software and verify that your 
system is operational and your backup data is recovered.

Migrating the Database
Migration updates the database to make it compatible with the latest 
instrument software. Install the new version of 4000 Series 
Explorer™ software, then perform a migration.

1. On the desktop taskbar, click Start> All Programs > 
AB 4000 Series Explorer > 4000 Series Database Tools.

2. In the 4000 Series Database Tools dialog box, click Migrate.

3. Click Start Migration. Messages in the dialog box display the 
migration status.

4. When a prompt displays that the data migration is complete, 
click OK. 

5. Click Close to exit the Database Migration dialog box.
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Files in the Backup Destination
The following example presumes that you have selected "3" for 
Maximum Number of Archived Backups (in the 4000 Series 
Explorer™ Software Database Backup Tool dialog box).

After the First
Backup

When your first backup finishes, the following files exist in your 
specified (remote) backup destination:

• TSQBackup_01.dmp – The current backup. 
• TSQBackup_01.log – A log file that shows the results of the 

backup.

After the Second
Backup

When your second backup finishes, the following files exist in your 
specified (remote) backup destination:

• TSQBackup_01.dmp – The current backup. 
• TSQBackup_02.dmp – Copy of the first backup. 
• TSQBackup_01.log – A log file that shows the results of the 

current backup.
• TSQBackup_02.log – A log file that shows the results of the 

first backup.

After the Third
Backup

When your third and subsequent backups finish, the following files 
exist in your specified (remote) backup destination:

• TSQBackup_01.dmp – The current backup. 
• TSQBackup_02.dmp – Copy of the second-most current 

backup.
• TSQBackup_03.dmp – Copy of the third-most current backup.
• TSQBackup_01.log – A log file that shows the results of the 

current backup.
• TSQBackup_02.log – A log file that shows the results of the 

second-most current backup.
• TSQBackup_03.log – A log file that shows the results of the 

third-most current backup.
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ASpecifications A

This chapter covers:

Mass Spectrometer Specifications . . . . . . . . . . . . . . . . . . . . . . . . A-2
Miscellaneous Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-3
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Mass Spectrometer Specifications
Table A-1 Mass spectrometer specifications

Condition Specification

Throughput >400 samples per hour, depending on application

Ion detection Positive, negative

Sample plate 
loading

Automated single-plate sample-loading system

Sample 
acquisition

• Manual control using control pad, mouse, or 
keyboard

• Automatic control using Interactive or Batch mode

Ion acceleration Two acceleration regions. The first region has three 
stages; the second has two-stages.

Ion path length • MS Linear mode – 150 cm (59 in.)
• MS Reflector mode – 300 cm (118 in.)
• MS/MS mode – 240 cm (94 in.)

Reflector mirror Two-stage

Laser Nd:YAG, 355 nm wavelength, 3 to 7 ns pulse width, 
200 Hz firing rate

Digitizer Acqiris® DP211

• Samples/second – 2 gigasample/second
• Analog bandwidth – 500 MHz
• Available bin sizes (ns) – 0.5, 1, 2, 4, 10, 20
• Input bandwidth – 25 or 500 MHz
• Recording rate – 200 Hz

Vacuum system • Triple differential turbomolecular pumping for high 
vacuum

• Multi-vacuum gauge capability for independent 
monitoring of source and reflector chambers

Dimensions • Depth – 81 cm (32 in.
• Width – 109 cm (43 in.)
• Height – 239 cm (94 in.)

Weight 657 kg (1,448 pounds) including the roughing pump
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Miscellaneous Specifications

Table A-2 Miscellaneous specifications

Condition Specification

Environmental • Operating temperature: 20 to 25 °C (68 to 77 °F)
• Stable within 2 °C over 24 hours
• Relative humidity: 30 to 80%, noncondensing
• Altitude: ≤2,000 m (6,500 feet) above sea level
• For indoor use only
• Installation category (overvoltage category) of II; 

classified as portable equipment
• Pollution degree rating of 2; can be installed in an 

environment that has only nonconductive 
pollutants 

 Computer Minimum supplied configuration:

• Dual Pentium® 4 Xeon™, 2.4-GHz CPU, two 
120-GB hard disk drives, and 1-GB RAM (random 
access memory)

• 20-inch color flat-panel monitor
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BSpare Parts B

This appendix contains the following:

Spare Parts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  B-2
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The following items are available from Applied Biosystems/MDS SCIEX.

Item Name Description Part Number

MALDI Plate Cleaning Kit for 
Stainless Steel or Gold Plates

For cleaning the 51 × 51 mm (2 × 2 in.) 
plates

4342532

Plates and Plate Holders

Opti-TOF™ 96-well insert, 
123 × 81 mm

Etched with 96 sample spots and 
13 CAL spots, stainless steel, 5-pack

4352801

Opti-TOF™ 384-well insert, 
123 × 81 mm

Etched with 384 sample spots and 
13 CAL spots, stainless steel, 5-pack 

4352802

Opti-TOF™ Cal Mix 5 Calibration 
insert, 123 × 81 mm

Spotted with 384 spots of Cal Mix 5, 
etched with 13 CAL spots, stainless 
steel, 1 per pack

4358091

Opti-TOF™ Mass Standards 
Calibration insert, 123 × 81 mm

Spotted with 384 spots of five different 
Cal Mixes, etched with 13 CAL spots, 
stainless steel, 1 per pack

4358092

Applied Biosystems/MDS SCIEX 
4000 MALDI TOF/TOF Analyzer 
Calibration Inserts Kit

• Opti-TOF™ Cal Mix 5 Calibration 
Insert 123 x 81 mm (1 ea.)

• Opti-TOF™ Mass Standards 
Calibration Insert 123 x 81 mm 
(1 ea.)

4358098

Opti-TOF™ LC/MALDI insert, 
123 × 81 mm

Blank 123 × 81 mm (3 × 5 in.) insert 
with 8 etched CAL spots, stainless 
steel, 5-pack

4352797

Holder, Opti-TOF™, 4800 System 
123 × 81 mm

Stainless steel plate holder that 
accepts the 123 × 81 mm (3 × 5 in.) 
insert, 1 per pack

4350840

Holder, 4800 System, 2 × 2 in Stainless steel plate holder that 
accepts the 51 mm × 51 mm (2 × 2 in.) 
plate, 1 per pack

4352605

Holder, 4800 System, 44 ×  44 mm Stainless steel plate holder that 
accepts the 44 mm × 44 mm 
(1.7 × 1.7 in.) insert, 1 per pack

4351641

Holder, MALDI Spot, 4800 System Stainless steel plate holder that 
accepts the MALDI Spot insert, 1 per 
pack

To be added



DRAFT
October 26, 2004 4:05 pm, 4800HWGuide_App B.fm

4800 MALDI TOF/TOF™ Analyzer Hardware Guide B-3

Hardware

Filter, Plastic, Elite Small fan filter, 2-pack V330112

Filter, Intake Right Large fan filter 4350576

Pump, Roughing DS-102 Roughing pump 4346972

Gamepad, Logitech Dual Action Control pad 4352556

Item Name Description Part Number
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CMatrices C

This chapter covers:

Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  C-2
Matrix Mass Spectra . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  C-3
Other Matrix Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  C-7
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Overview
This appendix provides information for commonly used matrices. 
The information includes:

• Matrix mass spectra
• Chemical structures
• Applications
• Descriptions of physical appearance
• Suggested solution concentrations
• Characteristic matrix ions

Refer to Figure C-1 through Figure C-9 for characteristic peak 
patterns and masses. 

Refer to Table C-1 on page C-7 for other matrix information. 

For additional matrix information, refer to the Bibliography. 

CHEMICAL HAZARD. Read the MSDS 
before handling any chemical mentioned below, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, 
and gloves. Acetonitrile (ACN) is a flammable liquid and vapor. It 
may cause eye, skin, and respiratory tract irritation, central nervous 
system depression, and heart, liver, and kidney damage. 
Trifluoroacetic acid (TFA) causes severe burns to the eyes, skin, and 
respiratory tract. Methanol is a flammable liquid and vapor. 
Exposure causes eye and skin irritation, and may cause central 
nervous system depression and nerve damage. Ethanol is a 
flammable liquid and vapor. It may cause eye, skin, and upper 
respiratory tract irritation. Prolonged or repeated contact may dry 
skin. Exposure may cause central nervous system depression and 
liver damage.
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Matrix Mass Spectra

Figure C-1 Sinapinic acid matrix spectrum

Figure C-2 α-Cyano-4-hydroxycinnamic acid (CHCA) matrix 
spectrum
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Figure C-3 2,5-Dihydroxybenzoic acid (2,5-DHB) matrix 
spectrum

Figure C-4 Mixture of 2,5-dihydroxybenzoic acid and 
5-methoxysalicylic acid (sDHB) matrix spectrum

Figure C-5 2-(4-Hydroxy-phenylazo)-benzoic acid (HABA) matrix 
spectrum
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Figure C-6 3-Hydroxypicolinic acid (3-HPA) matrix spectrum

Figure C-7 Dithranol matrix spectrum

Figure C-8 2,4,6 Trihydroxyacetophenone (THAP) matrix 
spectrum
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Figure C-9 Trans-3-indoleacrylic acid (IAA) matrix spectrum
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Other Matrix Information

Table C-1 Matrix information 

Matrix Applications/Color Matrix Solution 
Concentration

Characteristic 
Matrix Ions 

(monoisotopic)

Sinapinic acid

(see mass spectrum 
on page -3)

MW 224.07 Da

Applications:

• Peptides
• Proteins

Color of crystals/ 
solution:

White

Note: Matrix powder 
may also contain 
orange crystals. Do not 
use crystals when 
preparing solutions.

• 10 mg/mL in 70:30 
water:acetonitrile 
(0.1% TFA final conc.)

• 10 mg/mL in 50:50 
water:acetonitrile 
(0.1% TFA final conc.) 
if sample 
contaminated

• 225.076
• 224.068
• 207.066
• 431.134

Alpha-cyano-

4-hydroxycinnamic 
acid (αCHCA)

(see mass spectrum 
on page C-3)

MW 189.04 Da

Applications:

• Peptides
• Proteins

Color of crystals/ 
solution:

Yellow

5 mg/mL in 50:50 
water:acetonitrile 
(0.1% TFA final conc.)

• 164.047

• 195.050

• 172.040

• 379.093

• 212.032

• 294.076

CH CHCOOH

OCH3
OH

CH3O PB100251

CH

OH
PB100252

C(CN)COOH
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2,5-dihydroxybenzoic 
acid (2,5-DHB)

(see mass spectrum 
on page -4)

MW 154.03 Da

Applications:

• Peptides (mixtures)
• Proteins
• Carbohydrates
• Glycolipids (negative 

ion mode)
• Polar synthetic 

polymers

Color of crystals/ 
solution:

White

Peptides/proteins:

5 mg/mL in 90% 
deionized water, 10% 
methanol or ethanol

Other compounds:

10 mg/mL in water

• 155.034
• 154.027
• 137.024
• 273.040

Applications:

Small molecules

Color of crystals/ 
solution:

White

10 mg/mL in solvent in 
which sample and matrix 
are soluble

Table C-1 Matrix information  (continued)

Matrix Applications/Color Matrix Solution 
Concentration

Characteristic 
Matrix Ions 

(monoisotopic)

COOH

OH

PB100253HO
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Mixture of 2,5-
dihydroxybenzoic 
acid and 
5-methoxysalicylic 
acid (sDHB)

(see mass spectrum 
on page -4)

MW 154.03 Da +

MW 168 Da

Mixture MW = 
322.03 Da

Applications:

Large proteins

Color of crystals/ 
solution: White

10 mg/mL in solvent in 
which sample and matrix 
are soluble

• 155.034
• 154.027
• 137.024
• 273.040
• 151.040
• 168.042
• 169.050

2-(4-hydroxy-phenyl
azo)-benzoic acid 
(HABA)

(see mass spectrum 
on page C-4)

MW 242.07 Da

Applications:

• Proteins
• Lipopolysaccharides
• Polar and nonpolar 

synthetic polymers
Color of crystals/ 
solution: Orange

• ~1.3 mg/mL in 
50:50 water:
acetonitrile or in 
40:40:20 water: 
acetonitrile:
methanol

• 10 mg/mL in ethanol 
or methanol

• 243.077
• 265.059

Table C-1 Matrix information  (continued)

Matrix Applications/Color Matrix Solution 
Concentration

Characteristic 
Matrix Ions 

(monoisotopic)

COOH

OH

PB100253HO

COOH

OH

CH3O
PB100775

COOH

PB100255

N

OH

N
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3-hydroxypicolinic 
acid (3-HPA)

(see mass spectrum 
on page -5)

MW 139.03 Da

Applications:

Oligonucleotides

Color of crystals/ 
solution: Light brown

Make 9:1 solution of 
matrix:diammonium 
citrate

Matrix – 50 mg/mL in 
50:50 water:acetonitrile

Diammonium citrate – 
50 mg/mL in water

• 96.045
• 140.035
• 279.062
• 235.072
• 234.064
• 233.056
• 191.082
• 189.066

Dithranol

(see mass spectrum 
on page -5)

MW 226.06 Da

Applications:

Nonpolar synthetic 
polymers

Color of crystals/ 
solution: Yellow

10 mg/mL in 
tetrahydrofuran

+ 

silver trifluoroacetate (to 
minimize Na+ and K+ 
adduct formation)

• 225.055
• 226.063
• 227.071
• 211.076

2,4,6 trihydroxy 
acetophenone (THAP)

(see mass spectrum 
on page -5)

MW 168.04 Da

Applications:

Small
Oligonucleotides

Color of crystals/ 
solution: White

Make 9:1 solution of 
matrix:diammonium 
citrate

Matrix – 10 mg/mL in 
50:50 water:acetonitrile

Diammonium citrate – 
50 mg/mL in water

169.050

Table C-1 Matrix information  (continued)

Matrix Applications/Color Matrix Solution 
Concentration

Characteristic 
Matrix Ions 

(monoisotopic)

COOH

PB100257

OH

N

PB100258

OH OHO

COCH3
OH

PB100261

HO

OH
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trans-3-indoleacrylic 
acid (IAA) 

(see mass spectrum 
on page -6)

MW 187.2

Applications:

Non-polar polymers

Color of crystals/ 
solution: White

10−1 M in solvent 
appropriate for sample

• 187.063
• 188.071
• 170.061
• 144.081
• 130.066
• 375.134
• 329.120
• 284.131

Picolinic acid Tang, K., N.I. Taranenko, S.L. Allman, C.H. Chen, L.Y. Chang, and K.B. 
Jacobson, “Picolinic Acid as a Matrix for Laser Mass Spectrometry of 
Nucleic Acids and Proteins,” Rapid Commun. Mass Spectrom., 1994, 8, 
673–677.

Nicotinic acid Ehring, H.M., M. Karas, F. Hillenkamp, Org. Mass Spectrom., 1992, 27, 
472–480.

Table C-1 Matrix information  (continued)

Matrix Applications/Color Matrix Solution 
Concentration

Characteristic 
Matrix Ions 

(monoisotopic)

N
H

HC C
H

PB100491

CO2H
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DCalibration Standard 
Information 0

This appendix contains the following:

Calibration Standards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . D-2
Theoretical Cleavages for Angiotensin I  . . . . . . . . . . . . . . . . . . . D-4
Theoretical Cleavages for Glu1-Fibrino-Peptide B  . . . . . . . . . . . D-6
Theoretical Cleavages for ACTH 2 Clip 18–39 . . . . . . . . . . . . . . D-8
Products of Beta-Galactosidase Digest  . . . . . . . . . . . . . . . . . . . D-11
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Calibration Standards

Common
Calibration
Standards

Table D-1 Common calibration standards 

Compound
Molecular Weight

Charge 
State

Protonated Molecular Ion 
[M+H]+

Monoisotopic Average Monoisotopic Average

Leucine Enkephalin 555.2693 555.63 +1 556.2771 556.64

des-Arg1 Bradykinin 903.4603 904.04 +1 904.4681 905.05

Bradykinin 1059.5614 1060.23 +1 1060.5692 1061.24

+2 — 531.1

Angiotensin I 1295.6775 1296.50 +1 1296.6853 1297.51

Substance P-amide 1346.7281 1347.65 +1 1347.7360 1348.66

Glu1 -Fibrino-peptide B 1569.6696 1570.60 +1 1570.6774 1571.61

Neurotensin 1671.9097 1672.95 +1 1672.9175 1673.96

Adrenocorticotropic 
hormone (ACTH), 
clip 1–17

2092.0789 2093.45 +1 2093.0867 2094.46

Bovine Trypsin 2162.0492 2163.34 +1 2163.0574 2164.34

Porcine Trypsin 2211.0968 2211.43 +1 2211.1046 2212.43

Adrenocorticotropic 
hormone (ACTH), 
clip 18–39

2464.1910 2465.71 +1 2465.1989 2466.72

Insulin B chain, 
oxidized

3493.6435 3495.95 +1 3494.6513 3496.96

Adrenocorticotropic 
hormone (ACTH), 
clip 7–38

3656.9216 3659.18 +1 3657.9294 3660.19
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Reference Mass
Lists

To view reference mass lists for common calibration standards in the 
4000 Series Explorer™ software:

1. Select Tools > Edit Calibration Reference Masses. 

2. In the Edit Calibration Reference Masses dialog box, click  to 
open the Select Calibration Reference Mass List dialog box. 

3. Select All Objects for the Project.

4. Click the Master Reference Mass List to open it. 

5. If desired, create and save your own reference mass lists.

Insulin, bovine — 5733.58 +1 5730.6087 5734.59

+2 2865.8083 2867.80

Thioredoxin 
(E. coli, oxidized)

— 11673.47 +1 — 11674.48

+2 — 5837.74

Cytochrome C 
(horse heart)

— 12360.5 +1 — 12361.5

+2 — 6181.25

Myoglobin (horse heart) — 16951.55 +1 — 16952.56

+2 — 8476.78

Trypsinogen — 23980 +1 — 23981

Carbonic anhydrase — 29023 +1 — 29024

Enolase (Baker’s yeast) — 46671 +1 — 46672

+2 — 23336

Bovine serum albumin 
(BSA)

— 66430 +1 — 66431

+2 — 33216

Table D-1 Common calibration standards  (continued)

Compound
Molecular Weight

Charge 
State

Protonated Molecular Ion 
[M+H]+

Monoisotopic Average Monoisotopic Average
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Theoretical Cleavages for Angiotensin I
Table D-2 and Table D-3 list monoisotopic masses (Da) for the 
theoretical cleavages of angiotensin I as calculated for the positive 
ion mode. Monoisotopic mass (M+H)+ for the sequence 
DRVYIHPFHL is 1296.685 Da.l

Table D-2 N-terminal ions of angiotensin

Monoisotopic Mass (Da) for Ion Type
Fragment

a b da db

88.040 116.035 — — D

244.141 272.136 — — DR

343.209 371.204 329.194 — DRV

506.273 534.268 — — DRVY

619.357 647.352 591.325 605.341 DRVYI

756.416a 784.411a — — DRVYIH

853.468 881.463 — — DRVYIHP

1000.537 1028.532 — — DRVYIHPF

1137.596 1165.591 — — DRVYIHPFH

a. These peaks are typically the most intense in the spectrum.
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Table D-3 C-terminal ions of angiotensin I 

Monoisotopic Mass (Da) 
for Ion Type

Fragment

y

132.103 L

269.161 HL

416.230 FHL

513.283a

a.These peaks are typically the most intense in the spectrum.

PFHL

650.341 HPFHL

763.426 IHPFHL

926.489 YIHPFHL

1025.557 VYIHPFHL

1181.658a RVYIHPFHL
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Theoretical Cleavages for Glu1-Fibrino-Peptide B
Table D-4 and Table D-5 list monoisotopic masses (Da) for the 
theoretical cleavages of Glu1-Fibrino-peptide B as calculated for the 
positive ion mode. Monoisotopic mass (M+H)+ for the sequence 
EGVNDNEEGFFSAR is 1570.677 Da.

Table D-4 N-terminal ions of glu1-fibrino-Peptide B 

Monoisotopic Mass (Da) for Ion Type 
Fragment

a b

159.077 187.072 E

258.145 286.140 EG

372.188 400.183 EGV

487.215 515.210 EGVN

601.258 629.253 EGVND

730.301 758.296 EGVNDN

859.343 887.338 EGVNDNE

916.365 944.360 EGVNDNEE

1063.433 1091.428 EGVNDNEEG

1210.502 1238.497 EGVNDNEEGF

1297.534 1325.529 EGVNDNEEGFF

1368.571 1396.566 EGVNDNEEGFFS

— — EGVNDNEEGFFSA
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Table D-5 C-terminal ions of glu1-fibrino-Peptide B 

Monoisotopic Mass (Da) for Ion Type 
Fragment

y wa v

175.120a

a.These peaks are typically the most intense in the spectrum.

— — R

246.157 — 230.125 RA

333.189 298.152 301.162 RAS

480.257 — 388.194 RASF

627.325 — 535.263 RASFF

684.347a — — RASFFG

813.390 736.342 739.353 RASFFGE

942.432 865.384 868.395 RASFFGEE

1056.475a 994.427 997.438 RASFFGEEN

1171.502 1108.470 1111.481 RASFFGEEND

1285.545 1223.497 1226.508 RASFFGEENDN

1384.613 1351.555 1340.551 RASFFGEENDNV

1441.635a — — RASFFGEENDNVG
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Theoretical Cleavages for ACTH 2 Clip 18–39
Table D-6 and Table D-7 list monoisotopic masses (Da) for the 
theoretical cleavages of adrenocorticotropic hormone (ACTH) 2 
clip 18–39 as calculated for the positive ion mode. Monoisotopic 
mass (M+H)+ for the sequence RPVKVYPNGAEDESAEAFPLEF is 
2465.199 Da.

Table D-6 N-terminal ions of ACTH 2 Clip 18–39 

Monoisotopic Mass (Da) 
for Ion Type 

Fragment

a b d

226.167 254.162 — R

325.235 353.230 — RP

453.330 481.325 311.220 RPV

552.399 580.393 396.272 RPVK

715.462 743.457 538.383 RPVKV

812.515 840.510 — RPVKVY

926.558 954.553 — RPVKVYP

983.579 1011.574 883.552 RPVKVYPN

1054.616 1082.611 — RPVKVYPNG

1183.659 1211.654 — RPVKVYPNGA

1298.686 1326.681 1125.653 RPVKVYPNGAE

1427.728 1455.723 1254.696 RPVKVYPNGAED

1514.760 1542.755 1369.723 RPVKVYPNGAEDE

1585.797 1613.792 1498.765 RPVKVYPNGAEDE
S

1714.840 1742.835 — RPVKVYPNGAEDE
SA
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1785.877 1813.872 1656.835 RPVKVYPNGAEDE
SAE

1932.946 1960.940 — RPVKVYPNGAEDE
SAEA

2029.998 2057.993 — RPVKVYPNGAEDE
SAEAF

2143.082 2171.077 — RPVKVYPNGAEDE
SAEAFP

2272.125 2300.120 2101.035 RPVKVYPNGAEDE
SAEAFPL

— — 2214.120 RPVKVYPNGAEDE
SAEAFPLE

Table D-7 C-terminal ions of ACTH 2 Clip 18–39 

Monoisotopic Mass (Da) for 
Ion Type 

Fragment

y wa v

166.087 — — F

295.129 — — FE

408.213 — — FEL

505.266 — — FELP

652.335 — — FELPF

723.372 — — FELPFA

852.414 — — FELPFAE

Table D-6 N-terminal ions of ACTH 2 Clip 18–39  (continued)

Monoisotopic Mass (Da) 
for Ion Type 

Fragment

a b d
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923.451 — — FELPFAEA

1010.483 — — FELPFAEAS

1139.526 — — FELPFAEASE

1254.553 — — FELPFAEASED

1383.596 — — FELPFAEASEDE

1454.633 — — FELPFAEASEDEA

1511.654 — — FELPFAEASEDEA
G

1625.697 — — FELPFAEASEDEA
GN

1722.750 — — FELPFAEASEDEA
GNP

1885.813 — — FELPFAEASEDEA
GNPY

1984.882 — — FELPFAEASEDEA
GNPYV

2112.977 — — FELPFAEASEDEA
GNPYVK

2212.045 2178.987 2167.982 FELPFAEASEDEA
GNPYVKV

2309.098 2264.040 — FELPFAEASEDEA
GNPYVKVP

Table D-7 C-terminal ions of ACTH 2 Clip 18–39  (continued)

Monoisotopic Mass (Da) for 
Ion Type 

Fragment

y wa v
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Products of Beta-Galactosidase Digest
Table D-8 lists monoisotopic masses (Da) for the digest products of 
Beta-galactosidase as calculated for the positive ion mode. 

Table D-8 Beta-galactosidase peptide mass assignments

Fragment 
Number Peptide Fragment Residues 

(Start–End)

(M+H)+ 

Monoisotopic 
(Calculated)

T10 WVGYGQDSR 159–167 1067.4910

T77 GDFQFNISR 954–962 1083.5223

T64 IDPNAWVER 802–810 1099.5536

T76 ELNYGPHQWR 944–953 1299.6234

T11 LPSEFDLSAFLR 168–179 1394.7320

T3 DWENPGVTQLNR 16–27 1428.6872

T52 LSGQTIEVTSEYLFR 632–646 1742.8965

T72 VNWLGLGPQENYPDR 896–910 1757.8611

T14 WSDGSYLEDQDMWR 192–205 1787.7335

T48 YDENGNPWSAYGGDFGDTPNDR 579–600 2446.9812

T70 IDGSGQMAITVDVEVASDTPHPAR 859–882 2466.1935

T74 WDLPLSDMYTPYVFPSENGLR 919–939 2516.1808

T20 VTVSLWQGETQVASGTAPFGGEIIDER 257–283 2847.4165
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ESample Log Sheets 0

This appendix contains blank sample log sheets you can copy and use 
to track samples spotted on sample plates.
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Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log

Date Bar Code Plate Name Spot Set 

1 3 5 7 9 11 13 15 17 19 21 23

A (1–23)

A (2–24)

B (1–23)

B (2–24)

C (1–23)

C (2–24)

D (1–23)

D (2–24)

E (1–23)

E (2–24)

F (1–23)

F (2–24)

G (1–23)

G (2–24)

H (1–23)

H (2–24)

2 4 6 8 10 12 14 16 18 20 22 24

Calibration CAL 1 CAL 2 CAL 3 CAL 4 CAL 5 CAL 6
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I (1–23)

I (2–24)

J (1–23)

J (2–24)

K (1–23)

K (2–24)

L (1–23)

L (2–24)

M (1–23)

M (2–24)

N (1–23)

N (2–24)

O (1–23)

O (2–24)

P (1–23)

P (2–24)

2 4 6 8 10 12 14 16 18 20 22 24

Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log

Calibration CAL 1 CAL 2 CAL 3 CAL 4 CAL 5 CAL 6



DRAFT
October 26, 2004 4:05 pm, 4800HWGuide_App F.fm

Appendix E Sample Log Sheets

E-4 4800 MALDI TOF/TOF™ Analyzer Hardware Guide

Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Calibration Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

CAL # Calibrant Matrix

1

2

3

4

5

6

7

8
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Applied Biosystems/MDS SCEIX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix

1 A_1

2 A_2

3 A_3

4 A_4

5 A_5

6 A_6

7 A_7

8 A_8

9 A_9

10 A_10

11 A_11

12 A_12

13 A_13

14 A_14

15 A_15

16 A_16

17 A_17

18 A_18

19 A_19

20 A_20

21 A_21

22 A_22

23 A_23

24 A_24
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25 B_1

26 B_2

27 B_3

28 B_4

29 B_5

30 B_6

31 B_7

32 B_8

33 B_9

34 B_10

35 B_11

36 B_12

37 B_13

38 B_14

39 B_15

40 B_16

41 B_17

42 B_18

43 B_19

44 B_20

45 B_21

46 B_22

47 B_23

48 B_24

Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix
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49 C_1

50 C_2

51 C_3

52 C_4

53 C_5

54 C_6

55 C_7

56 C_8

57 C_9

58 C_10

59 C_11

60 C_12

61 C_13

62 C_14

63 C_15

64 C_16

65 C_17

66 C_18

67 C_19

68 C_20

69 C_21

70 C_22

71 C_23

72 C_24

Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix
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73 D_1

74 D_2

75 D_3

76 D_4

77 D_5

78 D_6

79 D_7

80 D_8

81 D_9

82 D_10

83 D_11

84 D_12

85 D_13

86 D_14

87 D_15

88 D_16

89 D_17

90 D_18

91 D_19

92 D_20

93 D_21

94 D_22

95 D_23

96 D_24

Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix
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97 E_1

98 E_2

99 E_3

100 E_4

101 E_5

102 E_6

103 E_7

104 E_8

105 E_9

106 E_10

107 E_11

108 E_12

109 E_13

110 E_14

111 E_15

112 E_16

113 E_17

114 E_18

115 E_19

116 E_20

117 E_21

118 E_22

119 E_23

120 E_24

Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix
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121 F_1

122 F_2

123 F_3

124 F_4

125 F_5

126 F_6

127 F_7

128 F_8

129 F_9

130 F_10

131 F_11

132 F_12

133 F_13

134 F_14

135 F_15

136 F_16

137 F_17

138 F_18

139 F_19

140 F_20

141 F_21

142 F_22

143 F_23

144 F_24

Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix
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145 G1_1

146 G_2

147 G_3

148 G_4

149 G_5

150 G_6

151 G_7

152 G_8

153 G_9

154 G_10

155 G_11

156 G_12

157 G_13

158 G_14

159 G_15

160 G_16

161 G_17

162 G_18

163 G_19

164 G_20

165 G_21

166 G_22

167 G_23

168 G_24

Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix
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169 H_1

170 H_2

171 H_3

172 H_4

173 H_5

174 H_6

175 H_7

176 H_8

177 H_9

178 H_10

179 H_11

180 H_12

181 H_13

182 H_14

183 H_15

184 H_16

185 H_17

186 H_18

187 H_19

188 H_20

189 H_21

190 H_22

191 H_23

192 H_24

Applied Biosystems/MSD SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix
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193 I_1

194 I_2

195 I_3

196 I_4

197 I_5

198 I_6

199 I_7

200 I_8

201 I_9

202 I_10

203 I_11

204 I_12

205 I_13

206 I_14

207 I_15

208 I_16

209 I_17

210 I_18

211 I_19

212 I_20

213 I_21

214 I_22

215 I_23

216 I_24

Applied Biosystems/MDS SCEIX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix
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217 J_1

218 J_2

219 J_3

220 J_4

221 J_5

222 J_6

223 J_7

224 J_8

225 J_9

226 J_10

227 J_11

228 J_12

229 J_13

230 J_14

231 J_15

232 J_16

233 J_17

234 J_18

235 J_19

236 J_20

237 J_21

238 J_22

239 J_23

240 J_24

Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix
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241 K_1

242 K_2

243 K_3

244 K_4

245 K_5

246 K_6

247 K_7

248 K_8

249 K_9

250 K_10

251 K_11

252 K_12

253 K_13

254 K_14

255 K_15

256 K_16

257 K_17

258 K_18

259 K_19

260 K_20

261 K_21

262 K_22

263 K_23

264 K_24

Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix
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265 L_1

266 L_2

267 L_3

268 L_4

269 L_5

270 L_6

271 L_7

272 L_8

273 L_9

274 L_10

275 L_11

276 L_12

277 L_13

278 L_14

279 L_15

280 L_16

281 L_17

282 L_18

283 L_19

284 L_20

285 L_21

286 L_22

287 L_23

288 L_24

Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix
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289 M_1

290 M_2

291 M_3

292 M_4

293 M_5

294 M_6

295 M_7

296 M_8

297 M_9

298 M_10

299 M_11

300 M_12

301 M_13

302 M_14

303 M_15

304 M_16

305 M_17

306 M_18

307 M_19

308 M_20

309 M_21

310 M_22

311 M_23

312 M_24

Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix



313 N_1

314 N_2

315 N_3

316 N_4

317 N_5

318 N_6

319 N_7

320 N_8

321 N_9

322 N_10

323 N_11

324 N_12

325 N_13

326 N_14

327 N_15

328 N_16

329 N_17

330 N_18

331 N_19

332 N_20

333 N_21

334 N_22

335 N_23

336 N_24

Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix
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337 O_1

338 O_2

339 O_3

340 O_4

341 O_5

342 O_6

343 O_7

344 O_8

345 O_9

346 O_10

347 O_11

348 O_12

349 O_13

350 O_14

351 O_15

352 O_16

353 O_17

354 O_18

355 O_19

356 O_20

357 O_21

358 O_22

359 O_23

360 O_24

Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix
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361 P_1

362 P_2

363 P_3

364 P_4

365 P_5

366 P_6

367 P_7

368 P_8

369 P_9

370 P_10

371 P_11

372 P_12

373 P_13

374 P_14

375 P_15

376 P_16

377 P_17

378 P_18

379 P_19

380 P_20

381 P_21

382 P_22

383 P_23

384 P_24

Applied Biosystems/MDS SCIEX 4800 MALDI TOF/TOF™ Analyzer Sample Log
Date _________ Bar Code _________ Plate Name _______________ Spot Set _________________

Sample # Sample Matrix
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FUsing the Control Pad and 
Handheld Bar Code Scanner F

This appendix contains the following:

Using the Control Pad  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  F-2
Using the Handheld Bar Code Scanner  . . . . . . . . . . . . . . . . . . . .  F-3
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Using the Control Pad

Overview When working in Interactive mode, you can use the control pad 
(Figure F-1) provided with the 4800 MALDI TOF/TOF™ Analyzer 
to:

• Adjust sample position under the laser beam
• Start and stop acquisition
• Adjust laser intensity
• Save a spot (methods, spectrum, and peak list) to the database

Figure F-1 Control pad 

When using the Plate Alignment wizard, Button 1 displays the laser 
position in Video Viewer. Button 4 allows you to use the left joystick 
to center the laser target (crosshairs) within the laser spot. See the 
4000 Series Explorer™ Software Online Help, Aligning the Laser 
Target in the Video Viewer.

Button 1
Start and stop 

acquisition

Button 2
Decrease
laser 
intensity

Button 3
Increase
laser 
intensity

Button 4
Save spot to 
database

Move left joystick 
up, down, left, and 

right to adjust 
sample position 

Button 6 
(on side, not visible)

Clear last accumulated trace

Button 5 
(on side, not visible)

Start trace accumulation
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Using the Handheld Bar Code Scanner

LASER HAZARD. Class 2 (II) lasers can cause 
damage to eyes. Avoid looking into a Class 2 (II) laser beam or 
pointing a Class 2 (II) laser beam into another person’s eyes.

The Opti-TOF™ plates provided with the 4800 MALDI TOF/TOF™ 
Analyzer have a bar code label on the bottom of the insert. When the 
Opti-TOF insert is in the magnetic holder, you can scan the bar code 
through the hole in the bottom of the holder.

You can scan bar codes in two ways:

• Holding the scanner by hand
• With the scanner mounted in the holder 

Scanning by
Hand

To scan by hand:

1. Hold the scanner about 23 cm (9 in.) from the plate.

2. Point the scanner at a slight angle to the bar code.

3. Press the trigger. The laser beam must illuminate the entire 
length of the bar code to correctly read the bar code. A beep 
indicates a successful read.

Scanning in the
Holder

The bar code scanner must be in the AutoSense® scan mode to scan 
when mounted in the holder. To enable the AutoSense® scan mode, 
refer to the QuickScan® 6000/6000plus AutoSense® Stand 
Instructions included with the scanner.

Note: The scanner must be approximately 23 cm (9 in.) from the 
plate to properly read the bar code.

The trigger is automatically depressed when the scanner is mounted 
in the holder. To scan a bar code:

1. Slide the plate onto the base of the scanner. Do not hold the plate 
at an angle.

2. Pass the bar code label below the scanner laser beam. 

Note: When the laser beam illuminates the entire length of the bar 
code, tip the plate very slightly. The scanner is sensitive; you may 
need to move the plate slightly under the beam to get the scanner to 
read the bar code. A beep indicates a successful read.
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GMaintenance Log Sheet 0

This following page is for recording the maintenance performed on 
your 4800 MALDI TOF/TOF™ Analyzer. Copy the log sheet and 
keep the copy by your 4800 MALDI TOF/TOF™ Analyzer.

Instructions for performing maintenance procedures are in Chapter 5.
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HWarranty and Service 
Information H

This appendix contains the following:

Computer Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . H-2
Limited Product Warranty  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . H-2
Damages, Claims, and Returns  . . . . . . . . . . . . . . . . . . . . . . . . . . H-5
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Computer Configuration
Applied Biosystems/MDS SCIEX supplies or recommends certain 
configurations of computer hardware, software, and peripherals for use 
with its instrumentation. Applied Biosystems/MDS SCIEX reserves the 
right to decline support for or impose extra charges for supporting 
nonstandard computer configurations or components that have not been 
supplied or recommended by Applied Biosystems/MDS SCIEX. Applied
 Biosystems/MDS SCIEX also reserves the right to require that computer 
hardware and software be restored to the standard configuration prior to 
providing service or technical support. For systems that have built-in 
computers or processing units, installing unauthorized hardware or 
software may void the Warranty or Service Plan.

Limited Product Warranty

Limited Warranty Applied Biosystems/MDS SCIEX warrants that all standard 
components of its 4800 MALDI TOF/TOF™ Analyzer will be free of 
defects in materials and workmanship for a period of one (1) year from 
the date the warranty period begins. Applied Biosystems/MDS SCIEX 
will repair or replace, at its discretion, all defective components during 
this warranty period. After this warranty period, repairs and replacement 
components may be purchased from Applied Biosystems/MDS SCIEX 
at its published rates. Applied Biosystems/MDS SCIEX also provides 
service agreements for post-warranty coverage. Applied Biosystems/MDS 
SCIEX reserves the right to use new, repaired, or refurbished instruments 
or components for warranty and post-warranty service agreement 
replacements. Repair or replacement of products or components that 
are under warranty does not extend the original warranty period.

Applied Biosystems/MDS SCIEX warrants that all optional accessories 
supplied with its 4800 MALDI TOF/TOF™ Analyzer, such as peripherals, 
printers, and special monitors, will be free of defects in materials and 
workmanship for a period of ninety (90) days from the date the 
warranty begins. Applied Biosystems/MDS SCIEX will repair or replace, 
at its discretion, defective accessories during this warranty period. After 
this warranty period, Applied Biosystems/MDS SCIEX will pass on to the 
buyer, to the extent that it is permitted to do so, the warranty of the 
original manufacturer for such accessories.
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With the exception of consumable and maintenance items, 
replaceable products or components used on or in the instrument are 
themselves warranted to be free of defects in materials and 
workmanship for a period of ninety (90) days.

Applied Biosystems/MDS SCIEX warrants that chemicals and other 
consumable products will be free of defects in materials and 
workmanship when received by the buyer, but not thereafter, unless 
otherwise specified in documentation accompanying the product.

Applied Biosystems/MDS SCIEX warrants that for a period of  
ninety(90) days from the date the warranty period begins, the tapes, 
diskettes, or other media bearing the operating software of the 
product, if any, will be free of defects in materials and workmanship 
under normal use. If there is a defect in the media covered by the 
above warranty and the media is returned to Applied Biosystems/
MDS SCIEX within the ninety (90) day warranty period, Applied 
Biosystems/MDS SCIEX will replace the defective media.

Applied Biosystems/MDS SCIEX does not warrant that the 
operation of the instrument or its operating software will be 
uninterrupted or error free. 

Warranty Period
Effective Date

Any applicable warranty period under these sections begins on the 
earlier of the date of installation or ninety (90) days from the date of 
shipment for hardware and software installed by Applied Biosystems/
MDS SCIEX personnel. For all hardware and software installed by 
the buyer or anyone other than Applied Biosystems/MDS SCIEX, and 
for all other products, the applicable warranty period begins the date 
the product is delivered to the buyer.

Warranty Claims Warranty claims must be made within the applicable warranty period, 
or, for chemicals or other consumable products, within thirty (30) 
days after receipt by the buyer.

Warranty
Exceptions

The above warranties do not apply to defects resulting from misuse, 
neglect, or accident, including without limitation: operation with 
incompatible solvents or samples in the system; operation outside of 
the environmental or use specifications or not in conformance with 
the instructions for the instrument system, software, or accessories; 
improper or inadequate maintenance by the user; installation of 
software or interfacing, or use in combination with software or 
products, not supplied or authorized by Applied Biosystems/MDS 
SCIEX; and modification or repair of the product not authorized by 
Applied Biosystems/MDS SCIEX.
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THE FOREGOING PROVISIONS SET FORTH 
APPLIED BIOSYSTEMS/MDS SCIEX’ SOLE AND 
EXCLUSIVE REPRESENTATIONS, WARRANTIES, AND 
OBLIGATIONS WITH RESPECT TO ITS PRODUCTS, AND 
APPLIED BIOSYSTEMS/MDS SCIEX MAKES NO OTHER 
WARRANTY OF ANY KIND WHATSOEVER, EXPRESSED OR 
IMPLIED, INCLUDING WITHOUT LIMITATION, 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE, WHETHER ARISING FROM A 
STATUTE OR OTHERWISE IN LAW OR FROM A COURSE OF 
DEALING OR USAGE OF TRADE, ALL OF WHICH ARE 
EXPRESSLY DISCLAIMED.

Warranty
Limitations

THE REMEDIES PROVIDED HEREIN ARE THE BUYER'S 
SOLE AND EXCLUSIVE REMEDIES. WITHOUT LIMITING 
THE GENERALITY OF THE FOREGOING, IN NO EVENT 
SHALL APPLIED BIOSYSTEMS/MDS SCIEX BE LIABLE, 
WHETHER IN CONTRACT, TORT, WARRANTY, OR UNDER 
ANY STATUTE (INCLUDING WITHOUT LIMITATION, ANY 
TRADE PRACTICE, UNFAIR COMPETITION, OR OTHER 
STATUTE OF SIMILAR IMPORT) OR ON ANY OTHER 
BASIS, FOR DIRECT, INDIRECT, PUNITIVE, INCIDENTAL, 
MULTIPLE, CONSEQUENTIAL, OR SPECIAL DAMAGES 
SUSTAINED BY THE BUYER OR ANY OTHER PERSON OR 
ENTITY, WHETHER OR NOT FORESEEABLE AND 
WHETHER OR NOT APPLIED BIOSYSTEMS/MDS SCIEX IS 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, 
INCLUDING WITHOUT LIMITATION, DAMAGES ARISING 
FROM OR RELATED TO LOSS OF USE, LOSS OF DATA, 
FAILURE OR INTERRUPTION IN THE OPERATION OF ANY 
EQUIPMENT OR SOFTWARE, DELAY IN REPAIR OR 
REPLACEMENT, OR FOR LOSS OF REVENUE OR 
PROFITS, LOSS OF GOOD WILL, LOSS OF BUSINESS, OR 
OTHER FINANCIAL LOSS OR PERSONAL INJURY OR 
PROPERTY DAMAGE.

NO AGENT, EMPLOYEE, OR REPRESENTATIVE OF 
APPLIED BIOSYSTEMS/MDS SCIEX HAS ANY AUTHORITY 
TO MODIFY THE TERMS OF THIS LIMITED WARRANTY 
STATEMENT OR TO BIND APPLIED BIOSYSTEMS/MDS SCIEX 
TO ANY AFFIRMATION, REPRESENTATION, OR WARRANTY 
CONCERNING THE PRODUCT THAT IS NOT CONTAINED 
IN THIS LIMITED WARRANTY STATEMENT, AND ANY 
SUCH MODIFICATION, AFFIRMATION, 
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REPRESENTATION, OR WARRANTY MADE BY ANY AGENT,
EMPLOYEE, OR REPRESENTATIVE OF APPLIED
BIOSYSTEMS/MDS SCIEX WILL NOT BE BINDING ON APPLIED 
BIOSYSTEMS/MDS SCIEX, UNLESS IN A WRITING SIGNED BY 
AN EXECUTIVE OFFICER OF APPLIED BIOSYSTEMS/MDS SCIEX.

THIS WARRANTY IS LIMITED TO THE BUYER OF THE 
PRODUCT FROM APPLIED BIOSYSTEMS/MDS SCIEX AND 
IS NOT TRANSFERABLE.

Some countries or jurisdictions limit the scope of or preclude 
limitations or exclusion of warranties, of liability, such as liability for 
gross negligence or wilful misconduct, or of remedies or damages, as 
or to the extent set forth above. In such countries and jurisdictions, 
the limitation or exclusion of warranties, liability, remedies or 
damages set forth above shall apply to the fullest extent permitted by 
law, and shall not apply to the extent prohibited by law.

Damages, Claims, and Returns

Damages If shipping damage to the product is discovered, contact the shipping 
carrier and request inspection by a local agent. Secure a written 
report of the findings to support any claim. Do not return damaged 
goods to Applied Biosystems/MDS SCIEX without first securing an 
inspection report and contacting Applied Biosystems/MDS SCIEX 
Technical Support for a Return Authorization (RA) number.

Claims After a damage inspection report is received by Applied Biosystems/
MDS SCIEX, Applied Biosystems/MDS SCIEX will process the 
claim unless other instructions are provided.

Returns Do not return any material without prior notification and 
authorization. 

If for any reason it becomes necessary to return material to Applied 
Biosystems/MDS SCIEX, contact Applied Biosystems/MDS SCIEX
Technical Support or your nearest Applied Biosystems/MDS SCIEX
subsidiary or distributor for a return authorization (RA) number and
forwarding address. Place the RA number in a prominent location on
the outside of the shipping container, and return the material to the
address designated by the Applied Biosystems/MDS SCIEX representative.
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guidelines for 3-38
poor 3-25
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documents x
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D
damage, reporting H-5
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DANGER

description xii
example xiii
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accessing 2-3
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software online Help ix
software overview 1-19
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4800 instrument database tools 5-1
access ix
archived files 5-28
automatic backup 5-22
backing up 5-1, 5-20
backup file naming 5-28
backup guidelines 5-20
backup overview 5-20
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recovering 5-1, 5-26
recovering after catastrophic failure 5-26
searching using DeNovo Explorer™ 

software 1-19
tools, API and SDK ix
troubleshooting 4-7

Database Archive tool
overview 5-15
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4000 Series Explorer™ Database Recover 
Tool 5-26

accessing 2-3
available 1-19
Database Archive tool 5-16
overview 1-19
protecting and accessing stored data 5-1
recovering database 5-26

delayed extraction MALDI-TOF spectrometry 
applications Bibliography-2
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technology 1-8, 1-9
time-delay technology 1-7
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accessing 2-3
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linear 1-15
reflector 1-16
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carbohydrates 3-17
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proteins 3-16
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concentration for synthetic polymers 3-5
crystals 3-16, 3-17, 3-18, 3-43
mass spectrum C-4
molecular weight C-8
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preparing for peptides and proteins 3-16
preparing for polymers 3-5
preparing for small molecules 3-18
sample concentration for neutral 

carbohydrates 3-17
sample concentration for peptides and 

proteins 3-16
sample concentration for small 

molecules 3-18
sample concentration for synthetic 

polymers 3-5
solvents for 3-16, 3-17, 3-18
stability 3-16, 3-17, 3-18
when to use 3-4, 3-5, 3-16

dialysis, sample cleanup 3-28
digestion, in-gel, additional 

information Bibliography-5
digitizer, description 1-18, A-2
dihydroxybenzoic acid mixture. See sDHB 

matrix
dihydroxybenzoic acid. See DHB matrix
diluting sample 3-34
dilution liquid, organic concentration in 3-34
dimensions of instrument A-2
disk drive. See hard disk drive
disk, recovering after crash 5-26
dithranol

chemical structure C-10
concentration 3-5
crystals 3-5
mass spectrum C-5
molecular weight C-10
preparing 3-5
sample concentration 3-5

DNA applications, MALDI-TOF 
spectrometry Bibliography-5

documentation, related viii
dried-droplet spotting

CHCA matrix and acetonitrile ratio 3-11
CHCA matrix preparation for 3-10
defined 3-3
mixing sample and matrix in tube 3-3
mixing sample and matrix on plate 3-3
organic concentration 3-11
overlay spotting technique 3-3
preparing samples 3-33
sample spotting 3-39

drift time
and molecular weight 1-6
equation for 1-6

drive. See hard disk drive.
drop dialysis, sample cleanup 3-28
drying sample plates, time needed 3-40

E
electrical hazard symbol xv
electrical safety xxii
electrical shock hazards xxii
electrical symbols, on instruments xiv
electromagnetic compatibility standards. See 

EMC standards
EMC standards xxvii
energy

kinetic 1-6, 1-7, 1-8
minimizing spread of 1-7
spread of ions, reducing 1-7

enolase, molecular weight D-3
environmental conditions A-3
equations, drift time for ions 1-6
error messages

database connection 4-2
instrument-error 5-3

European EMC standards xxvii
European safety standards xxvii
exhaust hood, connecting to 5-14
exiting, software 2-2
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MALDI, continuous 1-7
MALDI, time-delay 1-8

F
facility, conditions for system operation A-3
fast charge 2-16
flight tubes 1-14
floating membrane, sample cleanup 3-28
foreline TC vacuum gauge 1-18
fragmentation, optimizing 2-16

G
gas weight

default recharge pressure threshold 2-16
examples 2-14
setting fast charge for 2-15
setting recharge pressure threshold 

for 2-15
gas, collision. See collision gas
gases, compressed hazard xxiii
gauges. See vacuum gauges
general hazard symbol xv
genespectrometry, references Bibliography-6
gentisic acid. See DHB matrix
geometry configuration, do not alter 2-14
glu1-fibrinopeptide b

molecular weight D-2
theoretical cleavages for D-6

glycolipids, matrix for 3-5, C-8
glycopeptides, matrix for 3-5
glycosylated proteins, matrix for 3-4
GPS Explorer software function 1-19
guidelines

chemical safety xx
chemical waste disposal xxi
chemical waste safety xxi
waste disposal xxii

H
HABA matrix

chemical structure C-9
mass spectrum C-4
molecular weight C-9

handheld bar code scanner. See bar code scanner
hard disk drive, size 1-18, A-3
hardware

4800 MALDI TOF/TOF™ Analyzer 1-11
configuration 2-9
reconnecting 5-10
reinitializing 5-3

hardware monitor 2-6
hazard symbols xv

electrical xv
general xv
hot surface xv
in documents xiii
laser hazard xv
moving parts xv
on instruments xv

hazards
biological xxiii
chemical waste xxi
compressed gases xxiii
electrical shock xxii
laser hazard xxiv
moving/lifting instrument xvii
physical xxiii
repetitive motion xxvi

heater 1-14
heater status 2-5
heavy gas 2-14
Help

available software online viii
Technical Support website x

high voltages
auto shutdown 2-12, 2-13
button dimmed 4-2
configuring 2-11
status 2-4, 2-5

hood, connecting to 5-14
HPA. See 3-HPA matrix
HPLC-grade water, use of 3-6, 3-20, 3-22
humidity, acceptable range A-3
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hydroxypicolinic acid. See 3-HPA

I
IAA matrix

chemical structure C-11
concentration 3-5
crystals 3-5
mass spectrum C-6
molecular weight C-11
preparing 3-5
sample concentration 3-5

idle time 2-12, 2-13
laser 2-12
light source 2-13

IMPORTANT
description xii
example xiii

indole acrylic acid. See IAA matrix
Information Development department, 

contacting x
in-gel digestion, additional 

information Bibliography-5
installation category xxii
instrument

configuration 2-13
environmental conditions A-3
name, displaying 2-13
status 2-5
type, displaying 2-13

instrument operational safety, instructions 
for xviii

instrument readbacks 2-6
instrument-error 5-3
Insulin b, oxidized, molecular weight D-2
insulin, molecular weight D-3
intensity, laser, See laser intensity
intensity, signal 1-6
interference, minimizing from adducts 3-10
internal standard

concentration 3-34
mass range 3-34
masses of common D-2

ion acceleration, in MALDI-TOF 1-6
ion path length A-2

ion, kinetic energy 1-6, 1-7, 1-8
ionization of sample, enhancing 1-5, 3-34
italic text, when to use vii

K
K adduct ion

from buffer 3-34
from CHCA, minimizing interference 

from 3-10
keyboard

connecting 5-13
description 1-18

kinetic energy, molecular ions 1-6, 1-7, 1-8

L
labels, instrument safety xvi
laboratory name, displaying 2-13
laser

adjusting sample position under F-2
auto shutdown 2-12
configuring 2-11
description 1-11
extending the life of 2-12
not aligned with sample position 4-3
pulse A-2
rate 1-11, A-2
setting preferences 2-7
status 2-5
type 1-11, A-2
wavelength 1-11, A-2

laser attenuator, description 1-11
laser classification xxv
laser control buttons 2-7, F-2
laser hazard

symbol xv
warnings xxv

laser intensity, setting adjustment units 2-7
laser safety

bar code scanner xxv
laser classification xxiv
requirements xxiv, xxv

LC MALDI. See LC/MS
LC/MS, viewing chromatograms 1-19
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leucine enkephalin, molecular weight D-2
light gas 2-14
light source

auto shutdown 2-13
both on 2-12
configuring 2-11
display 3D effect 2-12
display black background 2-12
display white background 2-12
extending lifetime of 2-13
options 2-12
orthogonal 2-12
tangential 2-12
wait time 2-13

linear detector 1-15
lipooligosaccharides, additional 

information Bibliography-6
lipopolysaccharides, matrix for C-9
Load TC vacuum gauge 1-18
log

maintenance 5-4, G-1
sample E-1

loss of sample, minimizing 3-34

M
m/z 1-4, 1-6
maintenance

log 5-4, G-1
MALDI

additional information Bibliography-1, 
Bibliography-2

extraction modes 1-7, 1-8
technology 1-5, 1-7, 1-8

MALDI-TOF, limitation of traditional 1-7
manual backup 5-25
MASCOT, Peaks to MASCOT® tool 1-19
mass accuracy

and reflector mirror 1-15
and velocity focusing 1-8

mass spectrometer
description of parts 1-11
illustration 1-13
overview 1-11
vacuum system 1-17

mass spectrometry
overview 1-4
post-processing data 1-19
references Bibliography-1
technology 1-4

mass, reference lists D-3
mass-to-charge ratio 1-4, 1-6
matrix

3-HPA 3-5, 3-22, C-10
acid sensitive compounds 3-5
and HPLC-grade water 3-6, 3-20, 3-22
applications C-7
carbohydrates 3-5, C-8
CHCA 3-4, C-7
chemical structure C-7
crystallization, examples 3-42
crystallization, troubleshooting 3-25
DHB 3-4, 3-5, 3-16, C-8
dithranol 3-5, C-10
glycolipids 3-5, C-8
glycopeptides 3-5
glycosylated proteins 3-4
HABA C-9
IAA 3-5, C-11
ions C-7
lipopolysaccharides C-9
mass spectra C-3
mixing on sample plate 3-3
molecular weight C-7
nicotinic acid C-11
non-proteomics applications 3-5
oligonucleotides 3-5, C-10
peptides 3-4, C-7, C-8
physical appearance C-7
picolinic acid C-11
premixing with sample 3-3
preparing 3-8
proteins 3-4, C-7, C-8, C-9
proteomics applications 3-4
role of 1-5
salt contamination 3-6, 3-20, 3-22
sDHB 3-4, 3-19, C-9
selecting 3-4, 3-6
sinapinic acid 3-4, 3-14, C-7
small molecules 3-5, C-8
solutions C-7
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matrix continued
stability 3-8, 3-10, 3-13, 3-14, 3-16, 3-17, 

3-18, 3-19, 3-20, 3-22, 3-23
storage conditions 3-8
synthetic polymers 3-5, 3-23, C-8, C-9, 

C-10, C-11
THAP 3-5, 3-20, C-10

matrix, example spectra
3-HPA C-5
CHCA C-3
DHB C-4
dithranol C-5
HABA C-4
IAA C-6
sDHB C-4
sinapinic acid C-3
THAP C-5

maximum operating pressure 2-10
medium gas 2-14
memory, computer 1-18, A-3
menu commands, conventions for 

describing vii
Microsoft Windows XP, version and service 

pack 1-19
mirror 1-15, A-2
mixing sample and matrix 3-40
mixtures of samples 3-4
molecular ions, kinetic energy 1-6, 1-7, 1-8
molecular weight

matrices C-7
relationship to drift time 1-6

monitor
connecting 5-12
description 1-18

mouse
connecting 5-13
description 1-18

moving and lifting instrument, safety xvii
moving parts

hazard symbol xv
MS/MS, software for identifying 

proteins 1-19

MSDSs
consulting xx
description xix
obtaining xx
when to review xviii

MSDSs, obtaining x
myoglobin, molecular weight D-3

N
NA adduct ion

from buffer 3-34
from CHCA, minimizing interference 

from 3-10
name

instrument, displaying 2-13
laboratory, displaying 2-13

network, connecting to 5-13
neurotensin, molecular weight D-2
nicotinic acid C-11
nitrocellulose in matrix 3-13
nonpolar synthetic polymers. See synthetic 

polymers, nonpolar

O
oligonucleotides, matrix for 3-5, C-10
online Help

available software viii, ix
Technical Support website x

operating environmental conditions A-3
operating pressure

BA1 2-10
vacuum system 2-9

operating temperature A-3
organic concentration

in dilution liquid 3-34
in solvents 3-6

orthogonal light source 2-12
overview, 4800 MALDI TOF/TOF™ 

Analyzer 1-2
overvoltage category (rating) xxii
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P
Peak Explorer™ software

accessing 2-3
function of 1-19

peak shape, troubleshooting 3-25
peaks

adduct 3-34
filtering using Peaks to MASCOT® 

tool 1-19
Peaks to MASCOT® tool

accessing 2-3
function 1-19

peptides
matrix for 3-4, C-7, C-8
references Bibliography-4

physical hazards xxiii
picolinic acid C-11
pipette tips, recommended 3-38
polar synthetic polymers. See synthetic 

polymers, polar
polymers. See synthetic polymers
porcine trypsin, molecular weight D-2
potassium adduct ion

CHCA matrix 3-10
from buffer 3-34

potential gradient, velocity focusing 1-14, 
1-15

power, connecting 5-11
preferences

bar code scanner 2-8
laser 2-7

preparing
matrix 3-8
samples 3-2, 3-33

pressure
operating, vacuum system 2-9
Source 2 chamber 2-7
status 2-4, 2-5

pressure reading
collision gas 2-7
foreline vacuum 2-5
Source 1 chamber 2-5
Source 2 chamber 2-5

printer, connecting 5-13

prism, description 1-11
Pro Blast software, function 1-19
proteins

matrix for 3-4, C-7, C-8, C-9
references Bibliography-4

pump
CID 1-17
collision cell 1-17
roughing 1-17
system 1-17
turbo 1-17

purging spot sets 5-16

R
RA number H-5
radioactive waste, handling xxii
recharge pressure threshold 2-7, 2-16
reconnecting hardware 5-10
recovering database 5-26
reference mass lists D-3
reflector chamber

components 1-15
description 1-15
vacuum 1-17

reflector detector 1-16
reflector mirror 1-15, A-2
reinitializing hardware 5-3
Remote Access Client software

function 1-19
minimum requirements 1-19
no Database Tools 5-15

remote computer
software minimum requirements 1-19

repetitive motion hazard xxvi
reporting, damages H-5
restoring spot sets

troubleshooting 4-7
return authorization (RA) number H-5
returning damaged items H-5
returns H-5
roughing pump 1-17
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S
safety

bar code scanner xxv
before operating the instrument xvii
biological hazards
chemical xix
chemical waste xxi
compressed gases xxiii
computer workstation xxvi
conventions xii
electrical xxii
instrument xvii
laser xxiv, xxv
moving and lifting instrument xvii
physical hazard xxiii
standards xxvii
workstation xxvi

safety alert words
CAUTIONS xii
DANGERS xii
description xii
IMPORTANTS xii
WARNINGS xii

safety labels, on instruments xvi
safety standards

Canadian xxvii
European xxvii
U.S. xxvii

safety symbols, on instruments xv
salt concentration in sample 3-20, 3-22, 3-34

and HPLC-grade water 3-6
salt contamination 3-22
sample

buffers, impact of 3-34
contamination, preventing 3-37
diluting, recommended solutions 3-34
guidelines for good crystallization 3-38
high salt, effect of 3-34
internal standard 3-34
ionization 3-34
loading. See sample spotting
log sheets E-1
loss, minimizing 3-34
mixing on sample plate, dried-droplet 

spotting 3-3
mixtures 3-4

sample continued
overlay spotting technique 3-3
position 4-3
premixing with matrix 3-3
preparing for dried-droplet spotting 3-33
preparing for thin-layer spotting 3-34
preparing, overview 3-2, 3-33
spotting volume 3-40
spreading, troubleshooting 3-6, 3-34
when to prepare 3-33

sample cleanup
C18 3-32
cation exchange beads 3-30
drop dialysis 3-28
floating membrane dialysis 3-28
techniques 3-26
washing 3-27
when to do 3-25
ZipTips 3-32

sample concentration
general 3-33
in 3-HPA matrix 3-22
in CHCA matrix, dried-droplet 

spotting 3-11
in CHCA matrix, thin-layer spotting 3-13
in DHB matrix 3-5, 3-16, 3-17, 3-18
in dithranol 3-5
in IAA matrix 3-5
in sDHB matrix 3-19
in sinapinic acid matrix 3-15
in synthetic polymer matrix 3-24
in THAP matrix 3-21

sample loading chamber
description 1-11
vacuum 1-17

Sample Loading chamber pressure, minimum 
operating pressure 2-10

sample plate
crystallization, examining 3-42
crystallization, poor 3-25
drying time 3-40
handling 3-37
log sheets E-1
ordering B-2
orientation 3-44
spotting volume 3-40
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sample position
adjusting F-2
troubleshooting 4-3

sample spotting
dried-droplet spotting 3-3, 3-39
overlaying sample and matrix 3-3
overview 3-37
techniques 3-3
thin-layer spotting 3-4, 3-41

sample stage 1-14
scanner. See bar code scanner
screen savers, do not use 1-18
sDHB matrix

additive concentration 3-19
chemical structure C-9
concentration 3-19
crystals 3-19, 3-43
mass spectrum C-4
molecular weight C-9
preparing 3-19
sample concentration 3-19
solvents for 3-19
stability 3-19
when to use 3-4, 3-19

SDK (software development kit) ix
selecting matrix 3-4, 3-6
serial number, displaying 2-13
setting adjustment units for laser intensity 2-7
signal intensity, definition 1-6
sinapinic acid matrix

chemical structure C-7
concentration 3-14
crystals 3-15, 3-42
mass spectrum C-3
molecular weight C-7
organic concentration 3-15
preparing 3-15
sample concentration 3-15
solvents for 3-14
stability 3-14
when to use 3-4, 3-14

small molecules, matrix for 3-5, C-8
sodium adduct ion

CHCA matrix 3-10
from buffer 3-34

software
accessing supporting 2-3
available online Help viii
avoid screen savers 1-18
Data Explorer® software 1-19
DeNovo Explorer™ software 1-19
exiting 2-2
GPS Explorer software 1-19
included with system 1-19
Peak Explorer™ 1-19
Peaks to MASCOT® tool 1-19
Pro Blast software 1-19
programming tools ix
Remote Access Client 1-19
Remote Access Client software 1-19
starting 2-2
tools, accessing 2-3
tools, API and SDK ix

solvents for
3-HPA matrix 3-22
CHCA matrix 3-10, 3-13
DHB matrix 3-16, 3-17, 3-18
sDHB matrix 3-19
sinapinic acid matrix 3-14
synthetic polymer matrices 3-23
THAP matrix 3-20

solvents, organic concentration in 3-6
source. See Source 1 chamber, Source 2 

chamber
Source 1 chamber

components 1-14
description 1-14
heater 1-14
vacuum 1-17
wait time 2-10

Source 2 chamber
and CID pressure 2-16
components 1-14
description 1-14
pressure 2-7
vacuum 1-17

source chamber pressure, minimum operating 
pressure 2-10

speed, computer 1-18, A-3
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spot set
archiving 1-19
purging 1-19
restoring 1-19
transferring to another system 5-26

spotting samples on plates. See sample spotting
spotting volume 3-40
stability of matrix 3-8, 3-10, 3-13, 3-14, 3-16, 

3-17, 3-18, 3-19, 3-20, 3-22, 3-23
standard, internal

concentration 3-34
mass range 3-34
masses of common D-2

standards
EMC xxvii
safety xxvii

starting, software 2-2
status

4800 MALDI TOF/TOF™ Analyzer 2-5
acquisition 2-5
CID System 2-5, 2-7
heater 2-5
high voltages 2-4, 2-5
instrument 2-5
laser 2-5
pressure 2-4, 2-5
system 2-5
vacuum gauges 2-4, 2-5
voltages 2-6

status bar description 2-5
storing matrix 3-8
substance p-amide, molecular weight D-2
symbols

hazard xv
hot surface xv

symbols on instruments
electrical xiv
safety xv

synthetic polymer matrix
concentration 3-23
crystals 3-24
preparing 3-23
sample concentration 3-24
solvents for 3-23
stability 3-23
when to use 3-23

synthetic polymers
matrix for 3-5
methods for sample spotting 3-24
nonpolar, matrix for 3-5, C-9, C-10, C-11
polar, matrix for 3-5, C-8, C-9

system, status 2-5

T
tandem MS

description 1-7
references Bibliography-3

tangential light source 2-12
TC vacuum gauges 1-18
Technical Support

contacting x
for computers with altered 

configuration H-2
website x

technology
4800 MALDI TOF/TOF Analyzer 1-4
delayed extraction system 1-8, 1-9
MALDI 1-5, 1-7
mass spectrometry 1-4
time-delay extraction 1-7, 1-8
time-of-flight (TOF) 1-6
time-of-flight/time-of-flight 

(TOF/TOF) 1-7
temperature, site A-3
text conventions vii
THAP matrix

additive concentration 3-20
avoid HPLC-grade water 3-20
chemical structure C-10
concentration 3-20
crystals 3-21, 3-43
mass spectrum C-5
molecular weight C-10
preparing 3-20
salt contamination 3-20
sample concentration 3-21
solvents for 3-20
stability 3-20
when to use 3-5, 3-20
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thermocouple vacuum gauges
list of 1-18
pressure readings 2-5

thin-layer sample application
CHCA matrix 3-12
CHCA matrix for 3-12
defined 3-4
preparing samples 3-34
sample spotting 3-41

thioredoxin, molecular weight D-3
threshold, recharge pressure 2-7
throughput A-2
time, wait 2-10
timed ion selector 1-14
time-of-flight technology (TOF) 1-6
tips, pipette. See pipette tips
TIS (timed ion selector) 1-14
TOF/TOF

references Bibliography-8
technology 1-7

training, information on x
transferring data

back up 5-20
restoring archive 5-19

trihydroxy acetophenone. See THAP matrix
troubleshooting

bar code scanner 4-6
contacting Applied Biosystems Technical 

Support x
control pad 4-3
database issues 4-7
documents and online Help available viii
high voltages button dimmed 4-2
laser not aligned with sample position 4-3
matrix crystallization 3-25
peak shape 3-25
poor crystallization on sample plate 3-25
poor sensitivity 3-25
sample position 4-3
sample spreading 3-6, 3-34
tail on spectrum 3-25
video camera not aligned with sample 

position 4-3
trypsinogen, molecular weight D-3
turbo pump 1-17

U
U.S. safety standards xxvii
user attention words, described viii

V
vacuum gauges

CID BA 1-18
foreline TC 1-18
load TC 1-18
status 2-4, 2-5
system BA 1-18

vacuum system
chambers 1-17
configuration 2-9
gauges 1-18
overview 1-17
pumps, valves, and baffles 1-17
specifications A-2

variable voltage 1-14
velocity focusing

defined 1-8
figure 1-9
potential gradient 1-15

video camera
description 1-11
not aligned with sample position 4-3

video viewer
3D effect 2-12
black background 2-12
white background 2-12

viewer, CID System 2-6
volume, spotting 3-40

W
wait time, BA1 2-10
warning, bar code scanner F-3
WARNINGs, description xii
warnings, safety

bar code scanner 1-20, 4-6
bar code scanner laser hazard 1-20
CHCA matrix 3-10
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warranty
claim period H-3
damages, claims, returns H-5
exceptions H-3
for computers with altered 

configuration H-2
limitations H-4
period H-2, H-3
standard components H-2

warranty period H-2, H-3
washing, sample cleanup 3-26
waste disposal, guidelines xxii
wavelength of laser 1-11, A-2
weight of instrument A-2
Windows XP version 1-19
work flow, 4800 MALDI TOF/TOF™ 

Analyzer 1-10
workstation safety xxvi

Z
ZipTips, sample cleanup 3-32
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Applied Biosystems vast distribution and 
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reaches 150 countries on six continents. 
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our headquarters or see our Web site at 
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